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What’s New in 2006
This version of TurningPoint includes a healthy number 
of improvements and additions that you may enjoy. The 
new features provide more control over how results 
should be displayed, what information should be stored 
as results, and interesting new ways to engage your 
audience.

Internationalization TurningPoint now supports users who speak non-English 
languages including Canadian French, Portuguese, 
Spanish, Japanese, Korean, and Chinese.

Enhanced reporting provides
more support for teachers

With the new reporting features, you can:

• View a sample report before you generate one. 

• See the answer selected by the participant along with 
the correct answer in the Answer Detail Report.

• Track class attendance using the Attendance Report.

• Grade fill-in-the-blank questions using pre-defined 
keywords.

• View essay responses along with multiple choice 
answers in the same report.

Global settings alter the
presentation of results and

charts

With the new slide features, you can:

• Change the default multiple choice values from 1–10 
to 0–9.

• Determine whether charts should auto-scale results or 
provide a results according to actual percentages.

• Increase countdown time limits to a maximum of 999 
seconds.

• Set up a real-time backup folder.

Additional slides that impress
the audience

With the new slides, you can:
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• View comparisons of demographic information.

• Allow participants to weight responses by answering 
one question multiple times.

• Use Microsoft Graph controls to apply new formatting 
to existing charts.

• Include RF Channel slides to communicate changes 
to default ResponseCard settings.

Behavior modifications
provide more flexibility and

customizable options

With the new behavior modifications, TurningPoint will:

• Save the device ID when exporting session data.

• Prompt to save session data at all times, especially 
when exporting.

• Store attendance information in Session Files.

The following chapters in this guide demonstrate how to 
implement these new features to make the most of your 
presentation.



TurningPoint User Guide v

Contents
What’s New in 2006. . . . . . . . . . . . . . . . . . . . . iii

1 About TurningPoint  . . . . . . . . . . . . . . . . . . . . . 1
Product Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2
System Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

Requirements for Hardware . . . . . . . . . . . . . . . . . . . . . . . . . .3
Requirements for Software . . . . . . . . . . . . . . . . . . . . . . . . . . .4
How to Install TurningPoint. . . . . . . . . . . . . . . . . . . . . . . . . . .4
How to Open TurningPoint with PowerPoint. . . . . . . . . . . . . .7
How to Activate Your TurningPoint License . . . . . . . . . . . . . .8

Tour of the TurningPoint Toolbar  . . . . . . . . . . . . . . . . . . . . . . .10
Customer Support Resources. . . . . . . . . . . . . . . . . . . . . . . . . .12

Online Assistance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
Customer Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14

Where Do I Go From Here? . . . . . . . . . . . . . . . . . . . . . . . . . . .14

2 Getting Started with TurningPoint . . . . . . . . 17
Five Steps to Presentation Success . . . . . . . . . . . . . . . . . . . . .19
Step One: Create Presentation Slides  . . . . . . . . . . . . . . . . . . .21
Step Two: Set Up the Response Devices. . . . . . . . . . . . . . . . .23
Step Three: Create a Participant List  . . . . . . . . . . . . . . . . . . . .28
Step Four: Run a Presentation Session . . . . . . . . . . . . . . . . . .33
Step Five: Save Session Results . . . . . . . . . . . . . . . . . . . . . . .35
Where Do I Go From Here? . . . . . . . . . . . . . . . . . . . . . . . . . . .37

3 How to Create Slides . . . . . . . . . . . . . . . . . . . 39
Types of Slides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43

Chart Slides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .44
Summary Slides for Competitions  . . . . . . . . . . . . . . . . . . . .45
Template Slides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .46
Special Slides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48



vi Turning Technologies

Contents

Insert a Slide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Insert a Priority Ranking Slide . . . . . . . . . . . . . . . . . . . . . . . . . 53
Insert a Demographic Comparison Slide. . . . . . . . . . . . . . . . . 54
Modify Slides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Types of Charts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Change Chart Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Make a PowerPoint Slide Interactive 
by Inserting a Chart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Change Chart Colors  . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Picture Slides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Convert to a Picture Slide . . . . . . . . . . . . . . . . . . . . . . . . 64

Correct Answers and Points . . . . . . . . . . . . . . . . . . . . . . . . 66
Identify a Correct Answer . . . . . . . . . . . . . . . . . . . . . . . . 67
Set Point Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Clear Answer Values  . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Use Speed Scoring. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Use Keywords for Fill in the Blank Slides . . . . . . . . . . . . 72

Add Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Add an Answer Now Indicator. . . . . . . . . . . . . . . . . . . . . . . 75
Add a Countdown Indicator. . . . . . . . . . . . . . . . . . . . . . . . . 77
Add a Response Counter . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Add a Response Table . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Add a Correct Answer Indicator  . . . . . . . . . . . . . . . . . . . . . 84
Add Text Messaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
Add Statistics Indicators . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Import Third-Party Slides. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Import Slides with the TurningPoint Parser. . . . . . . . . . . . . 89
Import Slides from ExamView . . . . . . . . . . . . . . . . . . . . . . . 90

Ranking Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Create Slides with the Ranking Wizard. . . . . . . . . . . . . . . . 93

TurningPoint Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Save the Presentation Slides  . . . . . . . . . . . . . . . . . . . . . . . . 101
Where Do I Go From Here?  . . . . . . . . . . . . . . . . . . . . . . . . . 102

4 How to Set Up Response Devices. . . . . . . . . 103
Install Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106



TurningPoint User Guide vii

Contents

Install Response Device Receiver(s) . . . . . . . . . . . . . . . . .106
Install the vPad Response Software. . . . . . . . . . . . . . . . . .108

Run the Response Device Wizard  . . . . . . . . . . . . . . . . . . . . .111
Set Up and Test the Device Connection. . . . . . . . . . . . . . .112
Update the Number of Devices Used . . . . . . . . . . . . . . . . .118
Check Device Communication . . . . . . . . . . . . . . . . . . . . . .119
Add New Device Types  . . . . . . . . . . . . . . . . . . . . . . . . . . .121

Where Do I Go From Here? . . . . . . . . . . . . . . . . . . . . . . . . . .122

5 How to Track Participants and Teams  . . . . 123
Run the Participant List Wizard. . . . . . . . . . . . . . . . . . . . . . . .125

Create a Participant List . . . . . . . . . . . . . . . . . . . . . . . . . . .125
Set Up Team Competitions. . . . . . . . . . . . . . . . . . . . . . . . . . .133

Add Teams to a Participant List . . . . . . . . . . . . . . . . . . . . .134
Edit the Participant Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . .136

Modify a Participant List . . . . . . . . . . . . . . . . . . . . . . . . . . .136
Delete a Participant List . . . . . . . . . . . . . . . . . . . . . . . . . . .138

Import and Export Participant Data. . . . . . . . . . . . . . . . . . . . .139
Import a Participant List from Enterprise Manager . . . . . . .140
Import a Participant List from a 
Course Management System . . . . . . . . . . . . . . . . . . . . . . .143
Export Results Data to a 
WebCT Server (Campus Edition 4.1) . . . . . . . . . . . . . . . . .148
Export Results Data to a 
WebCT Server (Campus Edition 6.0 or Vista 3, 4) . . . . . . .151

Where Do I Go From Here? . . . . . . . . . . . . . . . . . . . . . . . . . .155

6 How to Run a Presentation Session  . . . . . . 157
Run a Session. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .161

Establish the Presentation Settings  . . . . . . . . . . . . . . . . . .161
Run the Slide Show  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .165
View Polling Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .169
Use the Participant Monitor  . . . . . . . . . . . . . . . . . . . . . . . .172
Add Slides During a Presentation Session . . . . . . . . . . . . .174
View Results by Question (Data Slicing)  . . . . . . . . . . . . . .176

Manage a Session  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .179



viii Turning Technologies

Contents

Save Results from a Session  . . . . . . . . . . . . . . . . . . . . . . 179
Continue a Previously Saved Session  . . . . . . . . . . . . . . . 180
Delete Results from a Session . . . . . . . . . . . . . . . . . . . . . 181

Where Do I Go From Here?  . . . . . . . . . . . . . . . . . . . . . . . . . 182

7 How to Use Tools. . . . . . . . . . . . . . . . . . . . . . 183
Types of Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186

Results by Question Reports  . . . . . . . . . . . . . . . . . . . . 188
Demographic Reports . . . . . . . . . . . . . . . . . . . . . . . . . . 188
Participant Results Reports  . . . . . . . . . . . . . . . . . . . . . 189
Results by Participant Reports . . . . . . . . . . . . . . . . . . . 190
Participant List Reports. . . . . . . . . . . . . . . . . . . . . . . . . 190
Standards Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
Attendance Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . 192
Individual Scoring Reports  . . . . . . . . . . . . . . . . . . . . . . 192
Ranking and Moment to Moment Reports  . . . . . . . . . . 193
Outline Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193
Participant Questions and Comments Report. . . . . . . . 193
Response Data Export Report  . . . . . . . . . . . . . . . . . . . 194
Results by Group Report  . . . . . . . . . . . . . . . . . . . . . . . 194

View a Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
Session Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199

Export Session Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
Merge Session Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Extract Participant List  . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
Extract PowerPoint Presentation  . . . . . . . . . . . . . . . . . . . 213
Extract Session Data as XML . . . . . . . . . . . . . . . . . . . . . . 215
Email Session using Outlook  . . . . . . . . . . . . . . . . . . . . . . 216
Edit Session Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219

Standards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 221
Create a Standards List  . . . . . . . . . . . . . . . . . . . . . . . . . . 222
Assign Standards to Slides . . . . . . . . . . . . . . . . . . . . . . . . 224

Comparative Links. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226
Set Up Comparative Links  . . . . . . . . . . . . . . . . . . . . . . . . 227

Conditional Branching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229
Set Up Conditional Branching . . . . . . . . . . . . . . . . . . . . . . 229



TurningPoint User Guide ix

Contents

A Frequently Asked Questions  . . . . . . . . . . . . 239

B TurningPoint Parser Documents . . . . . . . . . 245
XML Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .246
Word Documents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .249

Glossary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263





TurningPoint User Guide 1

About 
TurningPoint

Welcome to TurningPoint, the easiest, most powerful, 
fully interactive group response system available. 
Designed to use with PowerPoint, TurningPoint enables 
two-way communication between a speaker and a large 
group by allowing audience feedback. TurningPoint 
offers the ability to collect, evaluate, and record 
responses from everyone in the audience, transforming a 
lecture, workshop, or meeting into a more effective 
learning environment for everyone in the room. By 
engaging each participant, TurningPoint creates a unique 
session every time, recording response data that can be 
used immediately or later for grading, polling, attendance 
tracking, and demographic research.
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Whether you want to gauge an audience’s opinion or 
quickly assess your students’ understanding on 
important points in a lecture, TurningPoint enables you to 
ask and receive a response at the very moment you want 
to ask most. The audience uses response devices to 
submit answers to questions you have created. Then, 
TurningPoint gathers responses from each participant 
and quickly translates them into measurable results in 
the form of test scores, charts, and graphs. 

After a presentation, TurningPoint helps you store the 
data for later access or for use in reporting or grading.

This chapter provides an overview of the product and its 
capabilities and includes the system requirements, the 
steps for installing TurningPoint on your computer, and 
some resources available to you for customer support.

Product Introduction
TurningPoint smoothly integrates with PowerPoint to 
create a more interactive and memorable presentation. 
To use TurningPoint, you need a computer running 
Microsoft Windows 2000 or newer with Microsoft 
PowerPoint 2000 or newer installed. (Find additional 
information in System Requirements on page 3.) All 
TurningPoint options are accessed through the 
TurningPoint toolbar.

The TurningPoint toolbar can be found in PowerPoint 
beneath the standard PowerPoint toolbar after 
TurningPoint is installed. This toolbar offers you all the 
options you need to create interactive slides, set up and 
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run a presentation, and generate reports. Easy-to-use 
features such as the Response Device Wizard and 
Participant List Wizard help you quickly get started. 

Other TurningPoint features include participant 
monitoring and reporting tools. TurningPoint also 
provides the ability to connect to an educational 
institution’s WebCT or Blackboard server or to use 
Turning Technologies’ Enterprise Manager to streamline 
the creating of Participant Lists and reporting of 
classroom results and grades.

Additionally, TurningPoint is now available in a range of 
non-English languages. Customers may choose a 
language when they install TurningPoint.

System Requirements
TurningPoint is designed for use on computers with 
typical abilities. You do not need the very latest 
technology or a large amount of hard disk space to use 
TurningPoint. There are, however, a few requirements 
that you should check for before installation. The 
requirements for hardware and software are detailed in 
the following sections.

Requirements for Hardware
The following hardware specifications are required 
before installing TurningPoint on a computer:
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• Intel or AMD 600 Mhz class processor (1 GHz or 
higher recommended)

• 256 MB RAM 

• 60 MB hard disk space (an additional 32 MB is 
required if you do not have Microsoft .NET Framework 
2.0 installed)

• 800x600 resolution at 24-bit color (1024x768 
resolution at 32-bit color or higher recommended)

• Standard USB 1.1/2.0 port (for USB-based hardware 
devices or USB-serial Adapters)

• 9-pin serial port (for use with serial-based hardware)

• Ethernet or 802.11 compatible wireless network card 
(for vPad and vPad Presenter use)

Requirements for Software
The following software applications are required to take 
full advantage of TurningPoint capabilities:

• Microsoft Windows 2000 SP4 or Windows XP

• Microsoft Office 2000, XP, or 2003

How to Install TurningPoint

In a few simple steps, TurningPoint can be installed on 
your computer. The installation process takes just a few 
minutes, and then you will be ready to create a 
TurningPoint presentation.

Before You Begin Check the hardware and software specifications outlined 
in System Requirements on page 3. A computer must 
meet these systems requirements before installation.
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Step by Step Instructions To install TurningPoint software on a computer…

1 Install TurningPoint in one of 
two ways:
• Download the latest 

edition of TurningPoint 
from the Turning 
Technologies web site. 

The Turning Technologies web site is located at 
http://www.turningtechnologies.com. Use your web 
browser to download the file to your computer. 
When the download is complete, double-click the 
setup icon to launch the InstallShield Wizard.

• To install from a CD, insert 
the CD on the computer.

After you insert the CD, the InstallShield Wizard 
launches automatically.

2 If an older version of 
TurningPoint is installed, the 
InstallShield Wizard window 
displays a message 
requesting to run 
TurningPoint Update Utility 
prior to installation. 

TurningPoint Update Utility allows you to import the 
settings from TurningPoint 2003.

If this is the first time you are installing TurningPoint, 
or if you have a previous release of TurningPoint 
2006, the InstallShield Wizard skips the TurningPoint 
Update Utility. (Settings from a previous installation of 
TurningPoint 2006 are automatically used for the 
upgrade.) Continue with step 3.

a Select OK to run the 
TurningPoint Update 
Utility.

The Update utility asks whether you would like to 
import the settings from the previous version of 
TurningPoint.

b Select the Yes button to 
import the old settings. Or, 
select the No button.

TurningPoint Update Utility runs and then displays 
a window to notify the process is complete.

c Select the OK button to 
close the TurningPoint 
Update Utility.

You are returned to the InstallShield Wizard to 
continue the installation.

3 Select the Next button to 
continue the installation with 
the InstallShield Wizard.

The next page displays the license agreement. Use 
the scrollbar to read the license agreement on the 
screen or select the Print button to send the text to a 
printer. 
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4 Select the button labeled “I 
accept the terms in the 
license agreement” if you 
accept these terms. 

Accepting the terms of the license agreement permits 
you to continue with the process of installing 
TurningPoint. 

5 Select the Next button. The next page displays personal information entry 
fields. 

6 Type your name and 
company in the fields.

7 Select the Next button. The next page allows you to select a language.

8 Select a language to install. You may choose English, Dutch, French, Japanese, 
Korean, Portuguese, or Spanish.

9 Select the Next button. The next page confirms that the computer is ready to 
install TurningPoint.

10 Select the Install button. The computer installs TurningPoint to the location you 
specified and displays the Finish button on the page 
when it completes the process. 

11 Select the Finish button. The final page displays a message that the installation 
is complete. Select the Launch TurningPoint 
checkbox if you would like to immediately open the 
program.

The TurningPoint shortcut icon displays on your 
desktop and points to the location where you installed 
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TurningPoint on the computer. Double-click the icon to 
open the program.

TurningPoint Shortcut Icon

How to Open TurningPoint with PowerPoint

After you install TurningPoint onto your computer, you 
may want it to open automatically when you open 
PowerPoint. Or, you may want the programs to always 
open separately. You can change an item in the Settings 
menu to accomplish either of these tasks.

Step by Step Instructions To automatically load TurningPoint with PowerPoint...

1 Double-click on the 
TurningPoint icon.

2 Select the Display Settings 
menu (Hint: it’s the one that 
looks like a pair of 
eyeglasses) in the 
TurningPoint toolbar beside 
the Tools menu.

See the toolbar in Tour of the TurningPoint Toolbar 
on page 10. 

The Settings menu opens.

Note You can set TurningPoint to load every time 
you open PowerPoint. To do this, follow the 
instructions in the next section, How to Open 
TurningPoint with PowerPoint...
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3 Select the Presentation icon 
in the top row of the Settings 
menu.

A specific list of settings options displays in the menu. 

4 Scroll down the menu until 
you see the Misc settings.

5 Select the Add-In always 
loaded setting.

6 Select the drop-down menu 
next to the Add-In always 
loaded setting and choose 
either True or False.

Choosing True means that TurningPoint automatically 
loads when PowerPoint is opened.

Choosing False means that TurningPoint does NOT 
automatically load when PowerPoint is opened; you 
have to open each program separately.

7 Select the Done button. The Settings menu disappears and, depending on 
your selection, TurningPoint either does or does not 
load when you open PowerPoint.

How to Activate Your TurningPoint License

Once you’ve installed TurningPoint, you can then 
activate your license either over the Web or by phone 
using the 16 character license code that came with your 
TurningPoint purchase. If you are activating your license 
by phone, you can connect to the Web by proxy server. 

Step by Step Instructions To activate your TurningPoint license…

1 Open TurningPoint and 
select the TurningPoint icon 
in the TurningPoint toolbar.

The TurningPoint icon is the first icon on the left side 
of the toolbar. 

The TurningPoint - Activate License menu opens.

2 Select an activation method 
by clicking in one of the 
circles. 

You may select either Activate License over the Web 
or Activate License by Phone.

If you would like to activate over the Web and use a 
proxy server to connect, continue with step 3. If you 
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would like to activate over the Web without a proxy 
server or activate by phone, continue with step 4.

3 Select the checkbox beside ‘I 
connect to the internet 
through a proxy server.’

A Settings button appears.

a Select the Settings button 
to configure your proxy 
settings.

The Proxy Server Settings menu opens.

b Select either 
‘Automatically detect 
proxy settings’ or 
‘Manually configure proxy 
settings.’

c Type in the server Address 
and Port if you are 
manually configuring the 
proxy settings.

If your proxy settings require authentication, you 
may also enter the correct username, password, 
and domain in the Proxy Server Settings menu.

d Select the Test button to 
ensure that the server 
settings have been 
successfully configured to 
connect to the internet.

e Select Done. You have now set up a connection to your proxy 
server and can complete the activation process.

4 In the Activate License menu, 
select the Next button.

You are prompted to choose from three options: I 
have purchased a license of TurningPoint, I want to 
evaluate TurningPoint, or I only want to author content 
or generate reports from this computer. 

5 Select the Next button after 
choosing one of the options.

The next page prompts you to enter the 16 character 
license code. 

6 Enter your 16 character 
license code.

You can find your license code in the registration 
materials that came with your TurningPoint software.
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7 Enter any other requested 
information, including your 
name, phone, email, 
organization, etc.

8 Select the Next button. An Activate License over the Web message appears 
in the Activate License menu.

9 Select the Finish button to 
activate TurningPoint.

A dialog box appears with a Thank you message.

You have now successfully activated your license for 
TurningPoint.

Tour of the TurningPoint Toolbar
When you open TurningPoint, PowerPoint opens and the 
TurningPoint toolbar is displayed beneath the 
PowerPoint standard and formatting toolbars in the upper 
region of the window, as the following image depicts. 

TurningPoint Toolbar

The following descriptions define the buttons that make 
up the tools in the TurningPoint toolbar. The numbered 
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Tour of the TurningPoint Toolbar

labels in the previous image show you the location of 
each tool.

Activate/Upgrade Allows you to submit the license information for 
TurningPoint software and upgrades. Find information 
about installation and customer support in Chapter 1: 
About TurningPoint.

Reset Returns the response tallies from the audience to zero 
for all slides in the session or only the current slide. 
Find information about polling the audience in Chapter 
6: How to Run a Presentation Session.

Continue Prior Session Opens a previously saved session. A session is a run-
through of a presentation where an audience has 
submitted responses to some or all of the questions. 
Find information about continuing a prior session in 
Chapter 6: How to Run a Presentation Session. 

Save Session Stores the current session for retrieval later. Find 
information about saving sessions in Chapter 6: How 
to Run a Presentation Session.

Insert Slide Displays a menu of TurningPoint slides that you select 
to create a presentation. Find information about 
TurningPoint slides in Chapter 3: How to Create 
Slides.

Convert to Picture Slide Use to assign and order pictures as answers instead 
of text. Find information about picture slides in 
Chapter 3: How to Create Slides.

Insert Object Displays a menu of items that you select to enhance a 
slide. Find information about slide options in Chapter 
3: How to Create Slides.

Display Settings Allows you to create and edit the default settings for 
the presentation or a specific slide. Find information 
about applicable settings throughout this guide, and 
information about modifying settings in Chapter 3: 
How to Create Slides.

Tools Provides advanced options to set up, create a 
presentation, and report data. Find information about 
advanced options in Chapter 7: How to Use Tools.
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Customer Support Resources
This guide defines and demonstrates many of the tools 
and functions that TurningPoint gives you. If you have 
questions and concerns, additional resources are 
available to you online or by calling a Turning 
Representative. 

Display Response 
Device Wizard

Allows you to identify and test communication with the 
response devices. Find information about response 
devices in Chapter 4: How to Set Up Response 
Devices.

Select Input Source Selects the type of response devices to be used with 
the presentation. Find information about response 
devices in Chapter 4: How to Set Up Response 
Devices.

Participants Provides options to be used with Participant Lists. 
Find information about these options in Chapter 5: 
How to Track Participants and Teams.

Select a Participant List Assigns a Participant List to a session. Find 
information about participant lists in Chapter 5: How 
to Track Participants and Teams.

Display TurningPoint 
Help

Opens the online help file. 

Toolbar Options Customizes the PowerPoint and TurningPoint 
toolbars.
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Online Assistance
Turning Technologies offers assistance to customers 
online through the Turning Technologies Web Site. To 
access the web site, go to 
http://www.turningtechnologies.com.

Go to the Downloads section of the Turning Technologies 
Web Site to find valuable information about using 
TurningPoint. The Downloads section provides a link to 
the Quick Start TurningPoint Users Guide. Select the link 
to download the users guide for viewing or printing. In the 
Downloads section, you also find a link to access Web-
Based Training. 

Web-Based Training is a series of a online videos that 
demonstrate many aspects of TurningPoint. Select the 
link to access Web-Based Training. You may need to 
enter a user name and password. To register a user 
name and password, select the Register Now link, and 
complete the form. Registration is free.

The videos in the Web-Based Training series cover the 
following topics:

• Installation (Software and Hardware)

• Quick Start

• Creating an Interactive Presentation

• Running an Interactive Presentation

• Response Reminders Modifying and Formatting

• Options and Settings

• Post Presentation

Turning Technologies also offers live web-based or on-
site training. Find more information on the web site.
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Customer Support
To speak with a Turning Representative call our toll-free 
phone number: 1-866-746-3015. By E-mail, send your 
inquiry to support@turningtechnologies.com.

Office Hours:

Monday through Friday, 7:00 AM to 9:00 PM (EST)

Mailing Address:

Turning Technologies, LLC
241 Federal Plaza West
Youngstown, OH 44503

Turning Technologies, LLC offers complete TurningPoint 
training. Our trainers are ready to hit the road to fulfill 
your training needs at your location. Or if you desire, 
send your team to our state-of-the-art training facility in 
Ohio. 

Typical training sessions last from two to six hours 
depending on your intended use of TurningPoint and skill 
level with Microsoft Office products. For Training 
Services, call 1-866-746-3015 for details.

Where Do I Go From Here?
If you are new to TurningPoint, this manual will help you 
on your way. Read through Chapter 2: Getting Started 
with TurningPoint to receive a general overview of 
working with this product. 
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Where Do I Go From Here?

Are you a returning user? Details of the new 
TurningPoint features can be found throughout this 
document. What’s New in 2006 on page iii outlines these 
new features, while the Table of Contents or Index should 
help you find them quickly.
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Getting Started 
with 
TurningPoint

The process to create interactive presentations with 
TurningPoint is very simple. You can successfully build, 
deliver, and save the results of an interactive 
presentation in five easy steps.

From there, with a little more effort, you can customize 
the slides and include animation, feedback mechanisms, 
and excitement in your presentation. You can also create 
reports to view the results of your presentation session.

This chapter provides the basics, a tutorial of sorts, for 
using TurningPoint. Following the five steps to success 
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allows you to create very simple interactive presentation 
slides, set up the devices, create a Participant List, and 
use TurningPoint to present those slides. 

The advanced features of TurningPoint are detailed in 
the chapters that follow. You can find information about 
the contents of those chapters in Where Do I Go From 
Here? on page 37.
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Five Steps to Presentation Success

Five Steps to Presentation Success
Creating an interactive presentation with TurningPoint 
can be accomplished in five easy steps. 

Five Steps to Success
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As the previous diagram depicts, you start by creating 
the presentation slides. These slides can be as simple or 
complex as you desire. You can use PowerPoint’s 
features to apply a background, insert graphics, etc. to 
meet your needs. You will repeat this step many times as 
you create additional TurningPoint interactive slide 
presentations.

Next, set up the devices to be used to gather responses 
from the audience. TurningPoint provides a Response 
Device Wizard to take care of the hard work. Perform this 
step when you first set up TurningPoint and then again 
when you add new response devices.

Then, identify your audience. Create a Participant List 
using the Participant List Wizard. You can choose from 
using standard list templates or creating one of your own 
to store as much information about your audience as is 
required. (You can also run a presentation without a 
Participant List if you wish.) Create a Participant List for 
each audience.

When that’s done, you are ready to run the presentation. 
You’ll use PowerPoint’s Slide Show functionality for this 
purpose. Behind the scenes, TurningPoint is gathering, 
tallying, and storing the responses provided by your 
audience.

Finally, save the results of your session in a file to be 
used with TurningPoint’s reports to evaluate the 
audience’s responses. Perform this step for each 
presentation session.

Instructions to perform these five steps to success are 
detailed in the following sections. Instructions to use the 
advanced features of TurningPoint are found in the 
chapters that follow.
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Step One: Create Presentation Slides

Using TurningPoint to create an interactive presentation 
requires some basic PowerPoint knowledge and your 
imagination. Your slides can simply contain question and 
answer text. Or, you can add TurningPoint objects to 
each slide to allow your participants to interact effectively 
with your presentation. TurningPoint’s objects include 
answer reminders, timers, and response indicators, to 
name a few.

Before You Begin Install TurningPoint on the machine to be used to run the 
presentation. You can install a copy of TurningPoint in 
evaluation mode on a machine to be used to develop the 
interactive slides. The evaluation mode copies can be 
installed on as many machines as needed to be used to 
author the interactive slides. Find installation instructions 
in How to Install TurningPoint on page 4.

You should be familiar with the basics of creating slides 
using PowerPoint. This manual discusses how to use 
TurningPoint to create interactive presentation slides.

Step by Step Instructions To create a simple slide…

1 From the TurningPoint 
toolbar, select the Insert Slide 
menu to display the list of 
pre-defined slides. 

TurningPoint provides a variety of pre-defined slides 
for your use. Each slide can be used as-is or 
customized to behave as you desire.

As you move your cursor over the entries in the Insert 
Slide menu, the slide name is highlighted.
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2 Highlight and select the 
Vertical Slide option.

TurningPoint inserts a Vertical Slide. The slide 
contains a question region, an answer region, and a 
vertical bar chart.

Insert Vertical Slide

3 Select the region labeled 
“Enter question text…” and 
type in a question.

When you select the region, the text is highlighted. 
The highlighted text is replaced with the question text 
that you enter.

The question region. 

The answer region.

The chart region. This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.



TurningPoint User Guide 23

Step Two: Set Up the Response Devices

4 Select the region labeled 
“Enter answer text…” and 
type in the answers.

This region has the same behavior as the “Enter 
question text…” region. You can enter a maximum of 
ten answers per slide.

5 Repeat step 1–step 4 to 
insert additional slides.

6 Save your file before exiting 
TurningPoint.

Step Two: Set Up the Response Devices

Each audience participant uses a device to respond to 
the questions asked during the presentation.

TurningPoint supports a variety of response devices 
including infrared and radio frequency keypads as well 
as networked PDAs, vPad, laptops, desktops, and 
Windows cell phones.

TurningPoint needs to know what types of response 
devices will be used before you run the presentation. Use 
the Response Device Wizard to find and test the 
response devices.

Before You Begin You must have TurningPoint installed on the computer to 
be used for the presentations and must have the 
hardware device receivers and devices available for 
testing. Run the Response Device Wizard on the 
presentation machine.

Note Slides can be customized by adding a variety 
of animated feedback mechanisms. Find 
information about these different presentation 
objects in Chapter 3: How to Create Slides.
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Step by Step Instructions To set up the response devices…

1 Connect the device receiver 
to the presentation computer.

Connect the serial or USB cable or Keyspan USB 
adapter to the appropriate port on your computer.

If you install a serial receiver using the Keyspan USB 
adapter, Windows will prompt you to install the new 
hardware device. 

2 If required, install the drivers 
for the Keyspan adapter. 
Otherwise, go to step 3.

Insert the hardware installation CD into your CD-ROM 
drive and follow the instructions in the installation 
setup. If you need assistance, refer to Chapter 4: How 
to Set Up Response Devices.

3 From the TurningPoint 
toolbar, select the Display 
Response Device Wizard 
button. (Hint: it’s the one that 
looks like a lightning bolt.)

The TurningPoint Response Device Wizard window 
opens. All devices that you are able to use with 
TurningPoint are shown.

Response Device Wizard: Select Devices

4 Select the box next to the 
device to select one or more 
device types to be set up.

You can choose to view the device list by name or by 
picture.
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• To view the devices by device name, select the 
Small Icons option at the bottom right of the entry 
list.

• To view the devices by picture, select the Large 
Icons option.

5 Select the Next button. If you are using hardware that requires a serial 
connection, TurningPoint searches your computer to 
locate the ports where it finds connections for the 
device receivers and displays the list of ports.

Note A vPad is a software version of a response 
device. The vPad must be identified for use 
during device setup as well. Find more 
information on device setup in Chapter 4: How 
to Set Up Response Devices.
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6 Select the checkbox next to 
the ports where the response 
devices are connected.

7 Select the Next button one 
more time.

TurningPoint searches for the response devices. 

Response Device Wizard: Search for Devices

8 Press a key on one response 
device of each type to be 
used to enable TurningPoint 
to see the device.

If TurningPoint doesn’t find the response device on 
the first attempt, select the Not Found button and try 
again.

TurningPoint displays a Done searching… message 
when the devices have been found successfully.

9 Select the Next button. TurningPoint identifies the number of response 
devices licensed for use with the software. 

10 Enter the number of devices 
to be used.

Enter a range of numbers in the Starting Keypad 
Number and Ending Keypad Number regions. The 

Note This step is not necessary for USB or vPad 
response devices.
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Step Two: Set Up the Response Devices

difference between the Starting and Ending Keypad 
numbers cannot exceed the number of licensed 
devices.

11 Select the Next button again. TurningPoint displays the Polling screen. Use this 
screen to verify the devices are set up correctly and 
that TurningPoint can receive responses from the 
devices.

Response Device Wizard: Polling Test

12 Select the Start Test button. TurningPoint is now ready to accept responses from 
the response devices.

13 Press a key on each 
response device to be used.

TurningPoint displays an entry for each response 
device, in the order in which they were tested, and the 
key number pressed on each response device.

14 Select the End Test button. This action ends the Polling test.
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15 Select the Finish button. The response device setup is now complete. 

Step Three: Create a Participant List

Participant Lists identify the members of your audience—
your students, your trainees, your survey respondents—
who will use a response device during your presentation. 
The participant name and required information is stored 
along with information about their assigned device, which 
is identified by number (for example, 1, 2, 3, and so on) 
and by device ID.

You may create multiple Participant Lists to be used with 
one interactive presentation. Doing so allows you to use 
the presentation with multiple audiences and track the 
session results per audience.

Before You Begin Your Participant List must not exceed the number of 
devices licensed for use. If you are not sure of the 
number, perform the following steps on the computer to 
be used for presentations after you have run the 
Response Device Wizard.

Alternatively, you can use TurningPoint to create a 
Participant List on a machine that is licensed for slide 
development only. Find instructions to do this in Chapter 
5: How to Track Participants and Teams.

Note Run the Response Device Wizard again when 
you need to make changes to the number or 
type of devices being used with your 
presentations.
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Step by Step Instructions To create a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Participant List Wizard.

The TurningPoint Participant List Wizard window 
opens.

Participant List Wizard

2 Type the name of your 
Participant List.

TurningPoint provides a name using the current 
system date and time. You can type a more 
meaningful name or use the default.
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3 Select the device to be used 
to create the Participant List.
• Select the Use the current 

device configuration 
option to use the identified 
device.

• Select the Manually 
specify locations and 
Participant ranges option 
to alter the participant 
ranges.

4 Select the Next button. TurningPoint displays the Participant List templates.

5 Select a template to be used 
to create your own 
Participant List.

Participant List template choices include:

• Education—contains standard student information 
used for K–12 and higher education presentations, 
such as name and student ID.

• Corporate—contains entries for the information 
most often used in corporate feedback meetings 
including name, company name, telephone 
numbers, etc.

• Available Fields—contains all information entries 
defined for use with TurningPoint.

• Custom—allows you to choose what information 
should be included with your Participant List and to 
name the template.

6 Select the Next button to 
continue.

TurningPoint displays the Participant List information 
entries (called fields). Use this screen to customize a 
pre-defined template or to select the fields to be 
included in your Custom template.



TurningPoint User Guide 31

Step Three: Create a Participant List

Participant List: Add or Remove Fields

7 Optionally, select the Edit 
button to activate the fields 
list.

The Edit button is replaced by right (>) and left (<) 
arrow buttons. Use these buttons to add or delete 
selected fields from the template.

8 Select the Next button to 
continue.

TurningPoint displays the Groups entry box. Use this 
screen to add Groups to your Participant List. Groups 
provide categorization for greater reporting 
opportunities.

Note Find instructions to customize Participant List 
templates in Chapter 5: How to Track 
Participants and Teams.
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Participant List Wizard: Add Groups

9 Optionally, type in a Group 
name and select the Add 
button.

TurningPoint displays all Groups in the Included 
Groups list. Repeat this step to add additional groups.

10 Select the Next button. TurningPoint displays the Participant List summary 
screen. 

11 Optionally, edit the 
Participant File composition.

The settings you can change include the Participant 
List file name, number of participants, number of 
fields, and number of groups. Select the link next to 
the setting to be returned to the screen and make your 
edits.

12 Select the Finish button to 
create the Participant List 
and save it to a file. Note Find more information about Participant Lists in 

Chapter 5: How to Track Participants and 
Teams.
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Step Four: Run a Presentation Session

TurningPoint uses PowerPoint’s Slide Show capabilities 
to present the interactive slides you have created. You 
test your slides during development and run the 
presentation for your audience by executing the following 
steps.

Before You Begin You must have run the Response Device Setup Wizard 
successfully before attempting to run the presentation. It 
is recommended that you use a participant list, but you 
can still run a presentation session by selecting None or 
Auto for the participant list.

Step by Step Instructions To run a presentation session…

1 From the PowerPoint menu, 
select File > Open and select 
the TurningPoint 
presentation to be used.

2 From the TurningPoint 
toolbar, select the Response 
Device menu and select the 
device to be used.

TurningPoint allows you to select how responses will 
be provided during the presentation. Your choices are:

• Response Devices—a response device will be 
used during the presentation. The response 
devices must have been set up using the Response 
Device Wizard.

• Keyboard Keys 0–9—you will provide input to the 
presentation using the keyboard keypad or number 
keys.

• Simulated Data—TurningPoint provides random 
responses to the presentation.

3 From the TurningPoint 
toolbar, select Reset > 
Session.

This command clears any active sessions from 
memory and allows polling to take place.
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4 From the TurningPoint 
toolbar, select the drop-down 
to the right of the Participants 
drop-down and select the 
Participant List to be used.

The default Participant List is shown as (None). 
TurningPoint shows all Participant Lists available in 
the Participants folder. Participant lists located on the 
desktop or in other folders are not displayed.

5 From the PowerPoint menu, 
select Slide Show > View 
Show.

The first slide of the presentation is shown.

6 Use the left mouse button to 
control the progress of the 
slide show. For each slide:
a Advance the presentation 

to a TurningPoint slide to 
open polling.

Polling opens automatically when a TurningPoint 
slide appears in the slide show. TurningPoint 
receives responses when polling is open.

Polling is the mechanism by which TurningPoint 
accepts and tallies responses provided by the 
audience using the Response Devices. 

b  Click the slide once to 
close polling and display 
the results.

No responses are accepted when polling is closed.

c Click again to advance to 
the next slide.

7 Click at the end of the slides 
to exit from the Slide Show.

Note Your presentation may have additional 
features, such as animation, that cause it to 
behave differently at runtime from the default 
behavior. Find more information in Chapter 6: 
How to Run a Presentation Session.
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Step Five: Save Session Results

TurningPoint stores the results from your session. These 
results can be reviewed at a later date and used with 
TurningPoint’s reporting feature in a variety of ways.

When you save a session, a default TurningPoint setting 
automatically includes the PowerPoint presentation with 
your TurningPoint file. You have the option to exclude the 
PowerPoint presentation from the TurningPoint session 
file. This function allows you to save only the 
TurningPoint results data without the presentation slides. 
If you do NOT wish to include the PowerPoint 
presentation in your TurningPoint session file, navigate 
to the Settings menu and, under the Misc heading, 
change ‘Include Presentation’ from True to False. 

The session results are stored temporarily during a 
session. You can save the session results to a file to 
access them later. This section provides instructions to 
do just that.

Step by Step Instructions To save the session results…

1 From the TurningPoint 
toolbar, select the Save 
Session button. (Hint: it looks 
like a disk.)

TurningPoint opens the Save Session dialog box.

2 Type a file name to be used 
to store the session results.

TurningPoint names session files using the current 
system date and time. Providing your own name for 
the file allows you to retrieve the file more easily.

3 Select the Save button.

4 From the TurningPoint 
toolbar, select the Reset > 
Session command.

This command clears TurningPoint of the existing 
session results and allows you to run the presentation 
again to capture new results. 
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TurningPoint will prompt you to save the session data. 

5 Because you have saved the 
Session results, select No at 
the Save Session prompt.

Next Steps You are able to run reports to review the responses 
provided by each participant for your presentation. The 
TurningPoint reports use the saved session file. Find 
information on Turning Reports in Chapter 7: How to 
Use Tools.

Note TurningPoint prompts you to save existing 
session results every time you reset the 
session and when you exit from TurningPoint. 
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Where Do I Go From Here?
The answer to that question depends upon what you 
want to do. Following is a listing of the remaining 
chapters in this book along with information about what 
to find in each chapter.

Chapter Name Description

How to Create Slides This comprehensive, instructional chapter provides 
details of not only how to create a slide, but also how to 
add TurningPoint’s custom features to the slide to meet 
your needs. 
Read this chapter to understand how to add objects such 
as response timers and indicators, how to set slide 
defaults, how to convert existing slides into interactive 
TurningPoint slides, and more.

How to Set Up Response Devices Device setup is easy. However, if you need more help 
than what is included in this Getting Started chapter, 
you’ll find it here.

How to Track Participants and 
Teams

Participant Lists can use the default templates or can be 
customized to include information according to your 
needs or requirements.
Read this chapter to understand how to create custom 
Participant Lists, how to create Groups, how to modify or 
delete a Participant List, and how to download participant 
information from other sources.

How to Run a Presentation 
Session

Would you like to establish presentation session default 
behaviors? Have you included animation in your slides? 
Would you like to add slides during your presentation? 
This chapter focuses on the behavior of your slides 
during a Slide Show presentation and identifies how you, 
the presenter, interact with TurningPoint during a “live” 
session.
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How to Use Tools The tools discussed in this chapter include how to 
generate reports, how to set up standards for your slides, 
and how to set up advanced features such as 
Comparative Links and Conditional Branching.

Appendices The appendices include a guide to Frequently Asked 
Questions and a detailed demonstration of 
TurningPoint Parser Documents. 

Chapter Name Description
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How to Create 
Slides

In Chapter 2: Getting Started with TurningPoint, you 
learned the basic steps for creating TurningPoint 
presentations. This chapter and the remaining chapters 
of this user guide demonstrate the steps in greater detail, 
allowing you to use all the powerful features TurningPoint 
offers.
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Recall the five steps to presentation success:

Five Steps to Success

As the previous diagram depicts, the first step is to create 
the presentation slides. This chapter demonstrates how 

*



TurningPoint User Guide 41

to use TurningPoint to create the slides you will use later 
in a presentation.

TurningPoint slides are slides in a PowerPoint 
presentation with the ability to dynamically display 
information based on the responses of an audience. 
Most TurningPoint slides ask the audience to answer a 
question, and then tabulate and display the responses. 
These slides have a question region, an answer region, 
and a chart. There are also several special types of 
slides that have other features. (Find more information in 
Types of Slides on page 43.) TurningPoint slides can be 
mixed with ordinary PowerPoint slides in a presentation.

The question region contains the text of the question you 
are asking the audience. The answer region contains an 
enumerated list of answers that the audience can choose 
from. (You can even use pictures as the answers. Find 
more information in Picture Slides on page 64.) By 
default, answers are numbered 1-10, but you can change 
the settings to enable answers to be numbered 0-9 for 
zero-based polling. To enable zero-based polling, 
navigate to the Settings menu by selecting the 
eyeglasses icon and select Presentation (this selection 
affects the entire presentation) or Slides (this selection 
affects the currently-selected slide) in the top row of the 
menu. Then, under the Misc heading, set Zero-Based 
Polling to True.

The chart shows the results of the audience’s choices, 
with a bar, slice, or other indicator for each answer 
(depending on the type of chart). There are six types of 
charts available. Find more information in Types of 
Charts on page 57.

You can start by creating some TurningPoint slides. You 
have several options:
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• Insert a TurningPoint template slide using the Insert 
Slide menu in the TurningPoint toolbar. 

Find instructions for inserting a slide in Insert a Slide 
on page 51.

• Convert an existing PowerPoint slide into a 
TurningPoint slide by inserting a TurningPoint chart 
using the Insert Object menu in the TurningPoint 
toolbar.

Find instructions for converting a PowerPoint slide in 
Make a PowerPoint Slide Interactive by Inserting a 
Chart on page 59.

• Convert a Word or XML document into TurningPoint 
slides using the TurningPoint Parser.

Find instructions for using the TurningPoint Parser in 
Import Third-Party Slides on page 88.

• Use the Ranking Wizard to create a series of slides for 
eliciting a ranking of items by asking an audience to 
compare the items on specific criteria.

Find instructions for using the Ranking Wizard in 
Ranking Wizard on page 91.

Once you create the slides, you can modify them in a 
number of ways. You can add pictures, change colors, 
and do all the other things you can do with ordinary 
PowerPoint slides. You can also change the chart, mark 
correct answers, and perform other operations specific to 
TurningPoint. Find more information in Modify Slides on 
page 56.

Additionally, TurningPoint allows you to add a number of 
TurningPoint objects to your slides. These include 
response indicators, countdowns, and even statistics like 
the average and variance of the responses. Find 
information on adding objects in Add Objects on 
page 73.
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Your TurningPoint slides are saved as part of your 
PowerPoint presentation in your .ppt file. Find 
information on saving your presentation in Save the 
Presentation Slides on page 101.

Types of Slides
The Insert Slide menu on the TurningPoint toolbar lists 
several kinds of slides you can insert into a presentation.

Insert Slide menu
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The first set of six slides (above the first divider in the 
menu) insert a template slide with a chart of the specified 
type: vertical, horizontal, 3D pie, distributed pie, offset, or 
doughnut. Find more information about these slides in 
Chart Slides on page 44.

The second set of four slides are the setup and summary 
slides for competitions. Find more information about 
these slides in Summary Slides for Competitions on 
page 45.

The third set of slides are templates for commonly used 
kinds of questions, such as yes/no, true/false, and Likert 
scale slides. Find more information about these slides in 
Template Slides on page 46.

The final set of slides in the Insert Slides menu are 
special-purpose slides. Find more information about 
these slides in Special Slides on page 48.

Chart Slides
The six chart slides in the Insert Slide menu each contain 
the following:

• A question area with the text “Enter question text…”

• An answer area with the text “Enter answer text…”

• A chart of the specified type: vertical, horizontal, 3D 
pie, distributed pie, offset, or doughnut.

Find more information on the types of charts in Types 
of Charts on page 57.
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Summary Slides for Competitions
The summary slides are used in competitions for 
assigning teams and keeping track of the participants or 
teams with the most points and fastest responses.

The summary slides include the following:

• The Team Assignment slide, which allows teams to be 
assigned by asking the audience members to choose 
a team.

• The Participant Leader Board, which displays the top 
individual participants ranked by their point totals.

• The Team Leader Board, which displays the top 
teams ranked by their point totals. (The team’s points 
are the average of the team’s participant’s points.)

• The Fastest Responders, which displays the 
individual participants who responded most quickly to 
the most recent question. This feature requires a 
correct response or point value.

The Team Assignment slide allows teams to be assigned 
by asking the audience members to choose a team. 
Simply include names for the teams in the answer list 
and the participants will automatically be placed on the 
teams according to their answers.

Note Using the Team Assignment slide is an 
alternative to assigning participants to groups 
in a Participant List. The Team Assignment 
slide allows teams to be assigned dynamically, 
while assigning groups in the Participant List 
ensures that the same participants are always 
on the same teams. Find more information on 
setting up a competition in Set Up Team 
Competitions on page 133.
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The Participant Leader Board, Team Leader Board, and 
Fastest Responders slides are updated dynamically after 
each question. Find information on identifying correct 
answers and assigning point values in Correct Answers 
and Points on page 66.

You can specify the number of participants or teams to 
show on the Leader Boards or Fastest Responders 
slides using the TurningPoint settings. You can also 
specify whether the point totals for Leader Boards should 
be cumulative, or for the most recent question only. 

Use the Participants In Leaderboard, Teams In 
Leaderboard, and Max Responders settings on the 
presentation level or on the slide level to set the number 
of participants or teams to display in the Leader Boards 
or Fastest Responders slides. Use the Accumulate 
Points setting on the slide level to determine whether to 
display cumulative totals or only the points for the most 
recent question in the Leader Boards. Find more 
information on modifying settings in TurningPoint 
Settings on page 98.

Template Slides
The Insert Slide menu has several template slides for 
commonly used kinds of questions:

Tip Since the Leader Boards and Fastest 
Responders slides are updated after each 
question, you only need to include one of each 
in your presentation. Simply place it at the end 
of the presentation and jump to that slide when 
you want to know which participants or teams 
are in the lead.
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• Yes/No, for a question with a yes or no response.

• True/False, for a statement with a true or false 
response.

• Yes/No/Abstain, for a question with a yes or no 
response and the option to abstain.

• Likert scale slides, for statements with responses of 
varying levels of agreement or disagreement. There 
are 4-, 5-, and 7-level Likert scale slides.

• Generic 2- to 10-answer slides.

• Icebreaker slides with analogy and word scramble 
questions to get your audience involved in your 
TurningPoint presentation. Analogies are 
automatically generated, but you must supply a word 
for the word scramble.

When you insert any of the template slides, a chart of the 
default type (specified in the Settings) is inserted onto 
the slide. You can change the chart type on your slide. 
Find information for changing chart types in Change 
Chart Types on page 59.

For Yes/No, True/False, Yes/No/Abstain, and Likert scale 
slides, the template slide includes the appropriate 
answers and a generically worded question. You may 
wish to edit the question to be more specific.

The generic 2- to 10-answer template slides include a 
generic question and answers. You will want to edit the 
question and answers to be more specific.

Note You can change the default chart type to any 
of the six chart types using the Standard 
Chart Type setting, a presentation-level 
setting. Find more information on modifying 
settings in TurningPoint Settings on 
page 98.
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The Analogy icebreaker slide creates a slide with an 
analogy question with one missing word. (For example, 
apple:core:peach:?) It includes four choices, one of 
which is marked as the correct choice. (If you include a 
Correct Answer indicator, the correct choice will be 
revealed after polling. Find more information on adding a 
Correct Answer indicator in Add a Correct Answer 
Indicator on page 84.)

The Word Scramble icebreaker slide asks you to input a 
word. Every other letter from the word is removed. (For 
example, TELEPHONE becomes T_L_P_O_E.) The 
removed letters are scrambled and appear as one of four 
choices. The correct choice is automatically marked. (If 
you include a Correct Answer indicator, the correct 
choice will be revealed after polling. Find more 
information on adding a Correct Answer indicator in Add 
a Correct Answer Indicator on page 84.)

Special Slides
There are several special-purpose TurningPoint slides:

• The ResponseCard RF Channel Slide, which displays 
channel setting instructions for the ResponseCard 
Radio Frequency devices used by participants. 

• The vPad Log-In slide, which displays setup 
information for participants using vPad to send their 
responses.

• A Fill in the Blank slide for fill in the blank questions.

• An Essay slide for essay questions (for vPad 
participants only).

• A Priority Ranking slide that can weight participants’ 
choices and then rank them accordingly.
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• A Demographic Comparison slide that shows results 
based on certain demographic information.

• A Moment to Moment scoring slide for participants to 
rate something over time.

The ResponseCard RF Channel Slide displays 
instructions that show participants how to set the channel 
code on their response devices. If simultaneous 
presentations are occurring in adjacent rooms, channel 
setting prevents frequency disruption between response 
devices and receivers. 

Before you change channel settings on the 
ResponseCard devices, you will need to change the 
channel on the receiver. There are 82 possible channels, 
and the default channel is 41. Find information on 
changing the channel code in...

Once the channel is set correctly on the receiver, display 
the ResponseCard RF Channel Slide early in your 
presentation so that participants can update the channel 
code on their devices.

The vPad Log-In slide displays the computer’s friendly 
name, IP address, and port number, which are required 
for participants submitting responses using vPad. If some 
of the participants in your audience will be using vPad, 
you should include this slide early in your presentation so 
that they can successfully connect. Find more 
information on using vPad in Chapter 4: How to Set Up 
Response Devices.

Fill in the Blank and Essay slides contain a question 
region for you to pose a question. They do not contain an 
answer region or a chart, since the responses are in the 
form of text. ResponseCard users are limited to 
numerical responses, but vPad users may type in 
alphanumeric responses of varying lengths.
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For Fill in the Blank slides, you can specify one or more 
keywords in the TurningPoint settings that the answer 
should contain to be considered correct (for reporting 
and grading purposes). Find more information on 
specifying correct answers in Correct Answers and 
Points on page 66.

Priority Ranking slides allow participants to respond to a 
question or poll multiple times. You select the number of 
responses (maximum of 10) allowed per participant. The 
participants’ responses are then weighted, with points 
assigned to each response. First choices are weighted 
with more points than second choices, second more than 
third, etc. By allowing participants to choose more than 
one option, you can see a more diverse range of their 
preferences. The Priority Ranking slide displays the 
weighted scores assigned to the answers based on 
participant responses. Find more information on how to 
insert a Priority Ranking slide on page 53.

The Demographic Comparison slide can be used to 
visually display the results of a question slide in terms of 
certain demographic information gathered from the 
audience. 

For example, you could use this slide to show how 
participants’ communities influence their preference for 
football. To do this, you first create a question slide 
asking participants if they live in the city, suburbs, or a 
rural area, etc. and then designate that slide as 
‘Demographic.’ Next, you poll participants by asking ‘Do 
you like football?’ Finally, you insert a Demographic 
Comparison slide that provides percentages for how 
participants feel about football per their location.

It’s important to remember that you must designate a 
slide as ‘Demographic’ in the Settings menu to be able to 
insert a Demographic Comparison slide. You can do this 
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by selecting the slide with demographic information and 
then opening the Settings menu and selecting the Slides 
icon. Under Misc, select Demographic and True. Find 
step by step instructions for inserting a Demographic 
Comparison slide on page 54.

The Moment to Moment scoring slide can be used to 
have participants rate something on a scale of -2 to +2 at 
regular intervals over a period of time. The Moment to 
Moment slide contains a question region for the question 
and a chart that shows the average response at each 
polling interval and a curve connecting the values. 
Polling continues until you stop it by clicking on the slide.

You can set the polling interval in seconds for a Moment 
to Moment slide in the TurningPoint settings using the 
Polling Cycle setting, a slide-level setting. Find more 
information about modifying settings in TurningPoint 
Settings on page 98.

Insert a Slide

You can insert a TurningPoint slide using the Insert Slide 
menu.

Step by Step Instructions To insert a slide into a presentation…

1 In PowerPoint, open a 
presentation or create a new 
presentation.

2 Navigate to the slide you 
would like your new 
TurningPoint slide to be 
inserted after.

When you insert a TurningPoint slide, it will be added 
to the presentation after the currently visible slide.

3 Select Insert Slide from the 
TurningPoint toolbar.

The Insert Slide menu opens. Find a picture of the 
Insert Slide menu on page 43.
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4 Select the type of slide you 
would like to insert from the 
Insert Slide menu.

TurningPoint inserts the new slide into your 
presentation.

Find information about the different slide types in 
Types of Slides on page 43.

Depending on what type of slide you selected, the new 
slide may contain question and answer regions and a 
chart.

Additionally, depending on your TurningPoint settings, 
the slide may contain answer and response indicators 
and other objects. Find more information on adding or 
changing these objects in Add Objects on page 73.

5 Edit the text in the question 
region to reflect the question 
you would like to ask the 
audience.

6 Edit the text in the answer 
region to reflect the choices 
the audience will have when 
responding to the question.

You may enter up to ten answers in the answer region.

Optionally, you can enable zero-based polling to 
change the answer numbering from 1-10 to 0-9.

7 To enable Zero-Based 
Polling...
a In the TurningPoint 

toolbar, select the 
Eyeglasses icon to open 
the Settings menu. 

b Select Presentation or 
Slides in the top row.

Selecting Presentation affects all of the slides in the 
presentation. Selecting Slides affects the currently 
selected slide.

c Under the Misc heading, 
select Zero-Based Polling.

A drop-down menu appears to the right.

d Use the drop-down menu 
to select True.

Your answers are now numbered 0 to 9.
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Next Steps You now have a functioning TurningPoint slide. Find 
more information on modifying the slide in Modify Slides 
on page 56.

Insert a Priority Ranking Slide

You can insert a Priority Ranking slide to allow 
participants multiple responses to a question. The 
responses are then weighted and ranked accordingly.

For example, you could use a Priority Ranking slide to 
find out participants’ favorite colors. You insert a Priority 
Ranking slide, select the number of responses you want 
to allow per participant, and then ask participants to 
choose their top colors. You ask participants to enter 
their first choice as their first response, their second 
choice second, etc. Choices entered first are weighted 
more heavily.

Step by Step Instructions To insert a Priority Ranking slide…

1 Navigate to the slide you 
would like the Priority 
Ranking slide to be inserted 
after.

2 Select Insert Slide from the 
TurningPoint toolbar.

The Insert Slide menu opens. Find a picture of the 
Insert Slide menu on page 43.
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3 Scroll down the list and select 
Priority Ranking.

A dialog box appears asking how many responses you 
want to allow per participant.

Priority Ranking Dialog Box

4 Type the number of 
responses you wish to allow 
per participant.

The number of responses cannot be higher than 10.

5 Select OK. A new slide appears prompting you to enter question 
and answer text.

6 Enter the desired question 
and responses.

You can now poll participants and ask them to 
respond the selected number of times. Their 
responses are weighted and ranked: first responses 
weighted more than second, second more than third, 
etc.

Insert a Demographic Comparison Slide

The Demographic Comparison slide visually displays the 
results of a question based on certain demographic 
information obtained from the audience. For instance, 
you can insert a comparison slide that calculates how 
participants’ ages relate to the amount of television that 
they watch.

Before You Begin Remember to first designate a slide as ‘Demographic’ in 
the Settings menu, and be sure to create a question 
slide.
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Step by Step Instructions To insert a Demographic Comparison slide…

1 Navigate to the slide you 
would like the Demographic 
Comparison slide to be 
inserted after.

2 Select Insert Slide from the 
TurningPoint toolbar.

The Insert Slide menu opens. Find a picture of the 
Insert Slide menu on page 43.

3 Scroll down the list and select 
Demographic Comparison.

The Demographic Comparison dialog box opens.

Demographic Comparison Dialog Box

4 Select a demographic slide 
from the first drop-down 
menu.

Any slides you have designated as ‘Demographic’ are 
included in the menu.

5 Select a question slide to link 
with the demographic slide 
from the second drop-down 
menu.

You must choose both a demographic slide and a 
question slide.

6 Select OK. The Demographic Comparison slide is inserted 
displaying the demographic results in a chart. This 
slide creates its title based on the question slide.
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Modify Slides
TurningPoint slides are simply ordinary PowerPoint 
slides with extra features, so you can use and customize 
them as you would an ordinary PowerPoint slide. You 
can reorder slides, move objects, add text and pictures, 
apply fonts and color schemes, and use animation. Find 
more information in your PowerPoint documentation.

You can also modify the features TurningPoint adds to 
your slides. You can change chart types and colors (find 
more information in Types of Charts on page 57). You 
can use pictures for answers (find more information in 
Picture Slides on page 64). And you can specify which 
answers are correct and add point values (find more 
information in Correct Answers and Points on page 66).
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Types of Charts
There are six types of charts you can include in a 
TurningPoint slide for showing the distribution of 
responses:

Types of Charts

*

 Vertical The vertical chart is a bar chart 
with vertical bars for each answer.

 Horizontal The horizontal chart is a bar chart 
with horizontal bars for each 
answer. Each bar displays behind 
the corresponding answer in the 
answer region.
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Charts are objects on the TurningPoint slide that can be 
moved and resized just like ordinary objects. You can 
change the type of chart on a TurningPoint slide by 
following the instructions in Change Chart Types on 
page 59.

You can also convert any existing PowerPoint slide with 
a question and list of answers to an interactive 
TurningPoint slide by inserting a chart. Follow the 
instructions in Make a PowerPoint Slide Interactive by 
Inserting a Chart on page 59.

Additionally, you can make vertical charts appear more 
realistic by scaling them according to their percentages. 
Find instructions in Make a PowerPoint Slide Interactive 
by Inserting a Chart on page 59.

 3D Pie The 3D pie chart is a three-
dimensional pie chart with a slice 
for each answer and a key 
indicating the color representing 
each answer.

 Distributed Pie The distributed pie chart is similar 
to the 3D pie chart except the 
slices are shown separated from 
each other.

 Offset The offset chart is a bar chart with 
horizontal bars for each answer. 
Each bar is shown directly below 
the corresponding answer in the 
answer region.

 Doughnut The doughnut chart is a pie chart 
with a hollow center with a slice 
for each answer and a key 
indicating the color representing 
each answer.
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By default, the charts take on the colors defined in your 
PowerPoint presentation’s color scheme. You can 
change the colors used in a chart by following the 
instructions in Change Chart Colors on page 61.

Change Chart Types

You can change the type of chart on a TurningPoint slide 
using the Insert Object menu.

Step by Step Instructions To change a chart’s type…

1 Navigate to the TurningPoint 
slide in your presentation on 
which you would like to 
change the chart.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Charts to display the 
Charts submenu.

4 Select the type of chart you 
would like to appear on the 
slide.

When you select the chart type, TurningPoint changes 
the chart on your slide to match the type.

Make a PowerPoint Slide Interactive by Inserting a Chart

You can make an ordinary PowerPoint slide interactive 
by adding a chart to a slide that already has a question 
and a list of answers.

Note Chart settings will retain any modifications 
you make, even after you add or remove 
answers on the modified chart slides.
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Before You Begin Create one or more slides in PowerPoint with a title and 
a bulleted or numbered list.

When you convert the slide to a TurningPoint slide using 
the following instructions, the title will become the 
question and the bulleted or numbered list will become 
the list of answers. You can include up to ten answers.

Step by Step Instructions To convert a PowerPoint slide to an interactive slide…

1 Navigate to the PowerPoint 
slide in your presentation that 
you would like to convert to a 
TurningPoint slide.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Charts to display the 
Charts submenu.

4 Select a chart to add to the 
slide.

Find more information on chart types in Types of 
Charts on page 57.

When you select the chart to be added, TurningPoint 
converts the title of your slide to the question, the 
bulleted or numbered list to the answers, and adds the 
chart to the slide. 

Note The bulleted or numbered answer list is re-
numbered according to your TurningPoint 
settings. 
You can modify the numbering scheme for 
answers in the Answer Bullet Type setting, a 
presentation-level setting. Find more 
information about modifying settings in 
TurningPoint Settings on page 98.
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You can also make vertical charts appear more 
realistic by turning off the Auto Scale Charts setting.

5 To insert a chart without Auto 
Scaling...
a In the TurningPoint 

toolbar, select the 
Eyeglasses icon to open 
the Settings menu.

b Select the Presentation 
icon in the top row of the 
menu.

c Under the Chart Settings 
heading, select Auto Scale 
Charts.

A drop-down menu appears to the right.

d Select False from the 
drop-down menu.

Selecting False means that your charts are not 
Auto-Scaled and instead are scaled according to 
their specific percentages.

Next Steps You now have a functioning TurningPoint slide. Find 
more information on modifying the slide in Modify Slides 
on page 56.

Change Chart Colors

The colors used by charts are defined in the TurningPoint 
settings. By default, the color scheme for your 
PowerPoint presentation is used. You can change these 
colors by changing the settings.

Note Chart settings will retain any modifications 
you make, even after you add or remove 
answers on the modified chart slides.
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Step by Step Instructions To change chart colors…

1 Open the Settings window by 
selecting the Settings button 
in the TurningPoint toolbar. 
(Hint: It’s the one that looks 
like a pair of eyeglasses.)

The Settings window opens. (Find a picture and more 
information on using the Settings window in 
TurningPoint Settings on page 98.)

2 Select the Presentation, 
Slides, or Global Changes 
icon at the top of the settings 
window to specify whether 
you’d like to make changes to 
chart colors on the 
presentation level, the slide 
level, or global changes.

The level at which you change the settings controls 
which slides are affected:

• Making changes at the presentation level affects all 
slides you create in the future.

• Making changes on the slide level affects only the 
slide you select.

• Making global changes affects all slides you create 
in the future and modifies all slides in the current 
presentation.

If you make changes on the slide level, you must 
select the slide you wish to be affected from the 
Selected Slide drop-down menu.

3 Locate the Chart Colors 
setting in the Chart Settings 
group and select it.

A downward arrow will appear next to the value for the 
Chart Colors setting, indicating that you can select a 
value for the setting from a drop-down menu.

4 Select a value for the Chart 
Colors setting.

There are three options:

• ColorScheme, which uses the color scheme of your 
PowerPoint presentation.

• UserDefined, which uses ten user-defined colors.

• CorrectIncorrect, which uses two user-defined 
colors, one for correct answers and one for 
incorrect. (The default colors for correct and 
incorrect are green and red.) 

Find more information on setting correct answers in 
Correct Answers and Points on page 66.
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5 If you chose to use 
UserDefined or 
CorrectIncorrect, specify the 
colors to use by completing 
the following steps:
a Select the Palette button in 

the Settings window 
toolbar.

The Select Chart colors pop-up window opens:

Select Chart Colors pop-up window

b Select one of the colors 
labeled 1–10 or Correct 
and Incorrect.

A grid of 40 color swatches you can choose from is 
displayed.

c Select a color from the 
swatches.

The grid of swatches closes and the color is 
assigned.

To change a color back, select the Undo button. To 
change all colors back to their defaults, select the 
Defaults button.

d Repeat steps b–c for all 
colors you would like to 
change.

e Select the Done button to 
save the changes to the 
colors.

6 Select the Done button in the 
Settings window to save your 
changes.

If you made changes to the presentation-level setting, 
the new colors will be used in any new slides you 
create or new charts you insert.
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If you made changes to the slide-level setting, the 
slide you selected will reflect the new colors.

If you made global changes, all slides in your 
presentation will reflect the new colors, as will any new 
slides you create.

Picture Slides
Instead of using textual answers in the answer region, 
you can use pictures. This is useful if you pose a 
question with visual responses or where a visual aid will 
help the audience choose.

Convert to a Picture Slide

Picture slides are created from existing TurningPoint 
slides by replacing the answer region with pictures.

Step by Step Instructions To create a picture slide…

1 Create a TurningPoint slide. It is recommended that you use descriptive words or 
phrases for the answer text in the answer region 
because this text will still be used for the chart labels, 
even though the text in the answer region will be 
replaced by pictures.

Find more information on creating a slide in Insert a 
Slide on page 51.

Note Since you’ll be using pictures as answers, 
the horizontal and offset charts will not align 
correctly with the answers. Use a vertical, 3D 
pie, distributed pie, or doughnut chart. Find 
more information in Types of Slides on 
page 43.
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2 Insert pictures to use as 
answers using the options in 
PowerPoint’s Insert > Picture 
menu.

Insert one picture for each answer.

Find more information on inserting pictures in 
PowerPoint’s online help.

3 Resize and arrange the 
pictures the way you want 
them to appear on the slide.

Select and drag the picture to reposition it. Select one 
of the side or corner handles and drag to resize the 
picture. Find more information in PowerPoint’s online 
help.

4 To order the pictures 
correctly with the answers, 
follow these steps:
a First, ensure that no 

objects on the slide are 
selected by clicking 
outside the slide.

b Select the picture that 
corresponds to the first 
answer by clicking on it.

You can tell that the picture is selected when the 
resize handles are shown on its sides and corners.

c Select the picture that 
corresponds to the second 
answer by holding the 
Control key on your 
keyboard and clicking on 
the picture.

Now both the first and second picture are selected.

d Repeat step c for each 
additional picture until you 
have selected one for each 
answer.

Note You may include pictures on your slide that 
are not associated with one of the answers 
(for decoration or illustration). Do not select 
these pictures.
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5 Select the Convert to Picture 
Slide button from the 
TurningPoint toolbar. (Hint: 
It’s the one that looks like an 
artist’s palette.)

When you select the Convert to Picture Slide button, 
the answer region is hidden and the pictures are 
enumerated with a label, according to the answers 
you assigned them.

After you convert the answers to pictures, you can still 
resize and arrange the pictures if you need to adjust 
them.

Correct Answers and Points
You can specify whether answers in your TurningPoint 
slides should be considered correct or incorrect, or 
assign specific point values to them. By setting answer 
values, you can show the correct answer after polling 
with a Correct Answer indicator (find more information in 
Add a Correct Answer Indicator on page 84) or by 
coloring the chart to indicate correct and incorrect 
answers (find more information in Change Chart Colors 
on page 61).

The answer values are also used to compute the scores 
in the summary slides for competitions (find more 
information in Summary Slides for Competitions on 
page 45). Additionally, they are available in TurningPoint 
reports (find more information in Types of Reports on 
page 186).

You can set various values for an answer: Correct, 
Incorrect, and a numerical point value in the range of 
1-10,000. A correct answer is any answer set as Correct 
with a default point value of 100. An incorrect answer is 
any answer set as Incorrect with a default value of 0. 

You can change the default point value settings for both 
correct and incorrect answers at the Presentation and 
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Slide levels. For instance, you could enable participants 
to receive points even if they answer incorrectly. To do 
this, first use the Settings window to set the Incorrect 
Point Value at 10. (Find more information about Settings 
in TurningPoint Settings on page 98.) Then set the 
appropriate answers as Incorrect directly on the 
TurningPoint slides. You can identify a correct or 
incorrect answer by following the instructions in Identify 
a Correct Answer on page 67. 

You can also set point values individually per answer by 
following the instructions in Set Point Values on 
page 68. You can clear all answer values for a slide by 
following the instructions in Clear Answer Values on 
page 70.

You can use speed scoring in competitions to award 
more points to faster responders. Find more information 
in Use Speed Scoring on page 71.

You can set keywords for fill in the blank questions. If a 
response contains the keyword, it will be considered 
correct. Find more information in Use Keywords for Fill 
in the Blank Slides on page 72.

Identify a Correct Answer

You can identify a correct answer to a question on a 
TurningPoint slide. By default, answers marked Correct 
have a value of 100 points, and answers marked 
Incorrect have a value of 0 points for the purposes of 
scoring and competition. (Find information about 
assigning specific point values to answers in Set Point 
Values on page 68.)
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Step by Step Instructions To mark an answer correct…

1 Right-click on the number of 
the answer.

The answer is highlighted and a contextual menu 
opens. At the bottom of this menu, note the group of 
items including Set as Correct and Set as Incorrect.

2 Select Set as Correct from 
the contextual menu.

TurningPoint sets the selected answer as Correct and 
automatically sets other answers as Incorrect.

Next Steps You can have more than one correct answer on a slide by 
repeating these steps on another answer.

You can change an answer you marked as Correct to 
Incorrect by repeating these steps and selecting 
Incorrect from the contextual menu instead.

You may now wish to add a Correct Answer indicator 
(find more information in Add a Correct Answer 
Indicator on page 84) or set the chart colors to reflect 
the correct and incorrect answers (find more information 
in Change Chart Colors on page 61).

You can clear the answer value for a particular answer or 
for all answers on the slide by following the instructions 
in Clear Answer Values on page 70.

Set Point Values

You can identify specific point values for answers in the 
range 1–10,000. You can assign different point values to 
different answers (if one answer should be awarded 
more than another, for example).

Note You can also set the Correct or Incorrect 
value in the Answer Value setting, a slide-
level setting for each answer. Find more 
information about modifying settings in 
TurningPoint Settings on page 98.
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Answers marked Correct have an effective point value of 
100. Answers marked Incorrect or No Value have an 
effect point value of 0.

Step by Step Instructions To set a point value for an answer…

1 Right-click on the number of 
the answer for which you 
would like to set a point 
value.

The answer is highlighted and a contextual menu 
opens. At the bottom of this menu, note the group of 
items including Set Point Value.

2 Select Set Point Value from 
the contextual menu.

A dialogue box asking you to enter a point value 
opens.

3 Enter a point value in the 
space provided and select 
the OK button.

TurningPoint sets the point value for the selected 
answer.

Next Steps You can set the point value for another answer by 
repeating these steps on another answer.

You can change the point value you set by repeating 
these steps on the same answer and entering the new 
point value instead.

You can award points for answers proportionally to how 
quickly participants respond using speed scoring. Find 
more information in Use Speed Scoring on page 71.

You may now wish to add a Correct Answer indicator 
(find more information in Add a Correct Answer 
Indicator on page 84) or set the chart colors to reflect 

Note You can also set the point value in the 
Settings menu after selecting the Slides icon. 
Under Misc, enter the desired point values 
beside Correct Point Value and Incorrect 
Point Value. Find more information about 
modifying settings in TurningPoint Settings 
on page 98.
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the correct and incorrect answers (find more information 
in Change Chart Colors on page 61).

You can clear the point value for a particular answer or 
for all answers on the slide by following the instructions 
in Clear Answer Values on page 70.

Clear Answer Values

If you have erroneously set an answer value or you wish 
to reset all answer values, you can clear the value from 
one or all answers.

Step by Step Instructions To clear the values for an answer…

1 Right-click on the number of 
the answer for which you 
would like to clear the value, 
or any answer if you would 
like to clear all values.

The answer is highlighted and a contextual menu 
opens. At the bottom of this menu, note the group of 
items Clear Answer Value and Clear All Answer 
Values.

2 Select one of the following 
from the contextual menu:
• Clear Answer Value, to 

clear the value for the 
selected answer only.

The answer value for the selected answer is set to 
No Value.

• Clear All Answer Values, 
to clear all answer values 
for the slide.

The answer values for all answers on the slide are 
set to No Value.

Next Steps Find information for setting Correct or Incorrect values in 
Identify a Correct Answer on page 67.

Note To clear an answer value, you can also set 
No Value in the Answer Value setting, a 
slide-level setting for each answer. Find more 
information about modifying settings in 
TurningPoint Settings on page 98.
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Find information for setting point values in Set Point 
Values on page 68.

Use Speed Scoring

Speed scoring awards points proportionally based on 
how quickly a participant responds. Any slide with correct 
or point-value answers marked can be used for speed 
scoring.

If you use speed scoring, a participant receives all the 
points for a answer when responding correctly before the 
countdown begins. When the countdown begins, the 
points a participant is awarded are scaled proportionally 
by the amount of time remaining. For example, in a 10-
second countdown, a correct response with 5 seconds 
remaining is awarded half (5/10) the points.

An incorrect response always receives 0 points.

Before You Begin To use speed scoring, you should set points for one or 
more answers on the slide. Find information on setting 
points in Set Point Values on page 68.

You must use a Countdown indicator to use speed 
scoring. Find more information in Add a Countdown 
Indicator on page 77.

Step by Step Instructions To use speed scoring…

1 Open the Settings window by 
selecting the Settings button 
in the TurningPoint toolbar. 
(Hint: It’s the one that looks 
like a pair of eyeglasses.)

The Settings window opens. (Find a picture and more 
information on using the Settings window in 
TurningPoint Settings on page 98.)
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2 If it is not already selected, 
select the slide on which you 
would like to enable speed 
scoring in the Selected Slide 
drop-down menu.

3 Locate the Speed Scoring 
setting in the Misc group and 
select it.

A downward arrow will appear next to the value for the 
Speed Scoring setting, indicating that you can select 
a value for the setting from a drop-down menu.

4 Select True from the menu to 
enable speed scoring.

5 Select the Done button in the 
Settings window to save your 
changes.

Use Keywords for Fill in the Blank Slides

Fill in the Blank slides, by their nature, do not have 
enumerated answers. You can, however, specify that 
responses to a Fill in the Blank slide be counted as 
correct if it contains a certain word or words—a 
“keyword.”

Step by Step Instructions To use keywords…

1 Open the Settings window by 
selecting the Settings button 
in the TurningPoint toolbar. 
(Hint: It’s the one that looks 
like a pair of eyeglasses.)

The Settings window opens. (Find a picture and more 
information on using the Settings window in 
TurningPoint Settings on page 98.)
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2 If it is not already selected, 
select the slide on which you 
would like to assign keywords 
in the Selected Slide drop-
down menu.

3 Locate the Keywords setting 
in the Misc group and select 
it.

4 Type the word(s) to include 
as keywords in the space 
provided.

You can separate multiple keywords with commas. 
Responses containing any of the keywords will be 
counted as correct.

5 Select the Done button in the 
Settings window to save your 
changes.

Add Objects
TurningPoint offers several special objects you can add 
to your slides:

• An Answer Now indicator, which gives the audience a 
visual cue that the slide is a TurningPoint slide to 
which they have the opportunity to respond. 

Find more information in Add an Answer Now 
Indicator on page 75.

Note The Keywords setting will only be displayed if 
you select a Fill in the Blank or Essay slide. 
Although you can assign keywords for Essay 
slides, keywords are only considered for Fill 
in the Blank slides for reporting and grading 
purposes.
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• A Countdown indicator, which gives the audience a 
visual cue that polling is about to close.

Find more information in Add a Countdown Indicator 
on page 77.

• A Response Counter, which allows you to keep track 
of how many participants have responded.

Find more information in Add a Response Counter on 
page 80.

• A Response Table, which allows you to keep track of 
which individual participants have responded.

Find more information in Add a Response Table on 
page 82.

• A Correct Answer indicator, which allows you to reveal 
the correct answer after polling has closed.

Find more information in Add a Correct Answer 
Indicator on page 84.

• Text Messaging, which allows you to send messages 
to vPad users to reinforce the content and their 
participation.

Find more information in Add Text Messaging on 
page 86.

• Statistics indicators, which allow you to reveal 
statistics about the responses after polling is closed.

Find more information in Add Statistics Indicators on 
page 87.

TurningPoint visually identifies when an animated 
indicator has been used. When PowerPoint is in Normal 
view mode, a pane containing both Outline and Slides 
tabs is visible. If the Slides tab is selected, a Play 
Animations button is displayed adjacent to the thumbnail 
of the slide continuing the indicator. Clicking on the Play 
Animations button causes the indicator to perform its 
animation on the slide.
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Add an Answer Now Indicator

An Answer Now indicator is a TurningPoint object you 
can add to your slide. An Answer Now indicator gives the 
audience a visual cue that the slide is a TurningPoint 
slide to which they have the opportunity to respond. An 
Answer Now indicator appears during a presentation 
when polling opens and disappears when polling is 
closed. 

Answer Now indicators are available in 12 styles.

Answer Now indicators

Note You can specify that an Answer Now 
indicator should appear automatically on 
each TurningPoint slide that you create using 
the Answer Now setting, a presentation-level 
setting. Find more information about 
modifying settings in TurningPoint Settings 
on page 98.

*

 Bevel  Left Explosion

 Right Explosion  Scroll
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The Answer Now indicator can be moved and resized 
like an ordinary PowerPoint object. You can change the 
text “Answer Now” by selecting the text to edit it.

Step by Step Instructions To add an Answer Now indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add 
an Answer Now indicator.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Answer Now to display 
the submenu of Answer Now 
indicators.

Find a picture of the types of Answer Now indicators 
on page 75.

4 Select the type of Answer 
Now indicator you would like 
to appear on the slide.

When you select the Answer Now indicator, 
TurningPoint places it on your slide.

Next Steps You can move, resize, or change the text of the Answer 
Now indicator to better fit your slide. You can also delete 

 Bolt  Prompt

 Moon  Sun

 Banner  Marquis

 Smiley  Twilight

Note You can change the default text of Answer 
Now indicators when they are added to a 
page from “Answer Now” to any text of your 
choosing using the Answer Now Text setting, 
a presentation-level setting. Find more 
information about modifying settings in 
TurningPoint Settings on page 98.
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the Answer Now indicator if you no longer want it to 
appear on the slide.

To replace an existing Answer Now indicator with a 
different type, simply repeat these steps. The current 
Answer Now indicator will be replaced with the new one 
you select.

Add a Countdown Indicator

A Countdown indicator is a TurningPoint object you can 
add to your slide. A Countdown indicator gives the 
audience a visual cue that polling for a question is about 
to close. The Countdown indicator shows the number of 
seconds remaining and counts down to zero. A 
countdown can have a maximum length of 999 seconds. 
The indicator appears during a presentation when you 
advance the slide during polling. When the countdown 
expires, the Countdown indicator disappears and polling 
is automatically closed.

You can also use Countdown indicators in competition to 
award points based on how quickly a participant 
responds. Find more information in Use Speed Scoring 
on page 71.

Note You can specify that a Countdown indicator 
should appear automatically on each 
TurningPoint slide that you create using the 
Countdown setting, a presentation-level 
setting. Find more information about 
modifying settings in TurningPoint Settings 
on page 98.
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Countdown indicators are available in 11 styles.

Countdown indicators

 Ball  Letter

 Clock  Hourglass

 Timer  Candle

 Sunset  No Vote

 Logo  Second Hand

 Gemstone

*
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The Countdown indicator can be moved and resized like 
an ordinary PowerPoint object. 

Step by Step Instructions To add a Countdown indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add 
an Countdown indicator.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Countdown to display 
the submenu of Countdown 
indicators.

Find a picture of the types of Countdown indicators on 
page 78.

4 Select the type of Countdown 
indicator you would like to 
appear on the slide.

When you select the Countdown indicator, 
TurningPoint places it on your slide.

Next Steps You can move or resize the Countdown indicator to better 
fit your slide. You can also delete the Countdown 
indicator if you no longer want it to appear on the slide.

To replace an existing Countdown indicator with a 
different type, simply repeat these steps. The current 

Note You can change the length of the countdown 
in seconds for a particular slide or for all 
slides using the Countdown Seconds setting, 
a setting available on both the presentation 
level and the slide level. Find more 
information about modifying settings in 
TurningPoint Settings on page 98.
You can also change the length of the 
countdown by double-clicking the number on 
the Countdown indicator on the slide. A 
dialog box appears prompting you to ‘enter a 
value 1-999 for the Countdown time limit.’
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Countdown indicator will be replaced with the new one 
you select.

Add a Response Counter

A Response Counter is a TurningPoint object you can 
add to your slides. A Response Counter keeps track of 
how many participants have submitted a response out of 
the total number of participants. A Response Counter 
appears during a presentation when polling opens and 
disappears when polling is closed.

Note You can specify that a Response Counter 
should appear automatically on each 
TurningPoint slide that you create using the 
Response Counter setting, a presentation-
level setting. Find more information about 
modifying settings in TurningPoint Settings 
on page 98.
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Response Counters are available in six styles:

Response Counters

The Response Counter can be moved and resized like 
an ordinary PowerPoint object. 

 Flag Pole  Meter

 Bubble  Gauge

 Liquid  Tube

Note You can change whether the Response 
Counter displays the number or percentage 
of participants who have responded (or both) 
the using the Response Counter Format 
setting, a presentation-level setting. Find 
more information about modifying settings in 
TurningPoint Settings on page 98.

*
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Step by Step Instructions To add a Response Counter…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Response Counter.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Response Counter to 
display the submenu of 
Response Counters.

Find a picture of the types of Response Counters on 
page 81.

4 Select the type of Response 
Counter you would like to 
appear on the slide.

When you select the Response Counter, TurningPoint 
places it on your slide.

Next Steps You can move or resize the Response Counter to better 
fit your slide. You can also delete the Response Counter 
if you no longer want it to appear on the slide.

To replace an existing Response Counter with a different 
type, simply repeat these steps. The current Response 
Counter will be replaced with the new one you select.

Add a Response Table

A Response Table is a TurningPoint object you can add 
to your slides. A Response Table keeps track of which 
participants have submitted a response. A Response 
Table appears during a presentation when polling opens 
and disappears when polling is closed. The Response 
Table shows each participant’s number, and the 
background color of the number changes when a 
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response from the participant has been successfully 
received.

As an alternative to a Response Table, TurningPoint now 
also offers the Response Grid, which is overlaid on your 
slide during a presentation and can be shown and hidden 
at your command. The Response Grid shows more 
information than a Response Table and does not take up 
space on your slide, but you must manually choose to 
display and hide it during your presentation. Find more 
information in Run a Session on page 161.

The Response Table is available in two types, fixed and 
rotating. A fixed table shows all the participants. A 
rotating table displays up to 40 participants at a time, and 
rotates through the list every few seconds. It shows 
participants 1–40, then 41–80, and so on. When it 
reaches the last participant, the next rotation starts again 
with 1. A rotating table takes up less space on your slide 
if you have more than 40 participants.

The Response Table can be moved and the font can be 
changed like an ordinary PowerPoint object. 

Note You can specify that a Response Table 
should appear automatically on each 
TurningPoint slide that you create using the 
Response Table setting, a presentation-level 
setting. Find more information about 
modifying settings in TurningPoint Settings 
on page 98.

Note You can specify the rotation interval in 
seconds for a rotating Response Table using 
the Rotation Interval setting, a presentation-
level setting. Find more information about 
modifying settings in TurningPoint Settings 
on page 98.
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Step by Step Instructions To add a Response Table…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Response Table.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Response Table to 
display the submenu of 
Response Tables.

4 Select the type of Response 
Table you would like to 
appear on the slide (fixed or 
rotating).

See above for information on the differences between 
fixed and rotating Response Tables.

When you select the Response Table, TurningPoint 
places it on your slide.

Next Steps You can move the Response Table and change the font it 
uses to better fit your slide. You can also delete the 
Response Table if you no longer want it to appear on the 
slide.

To replace an existing Response Table with a different 
type, simply repeat these steps. The current Response 
Table will be replaced with the new one you select.

Add a Correct Answer Indicator

A Correct Answer indicator is a TurningPoint object that 
can be added to your slide. A Correct Answer indicator 
gives a visual cue to the audience to indicate the correct 
answer(s) after polling for a question is finished. A 
Correct Answer indicator appears during a presentation 
when you advance the slide after displaying the chart.

A Correct Answer indicator appears for each answer 
marked as Correct or for which a point value is specified. 
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Find more information in Correct Answers and Points 
on page 66.

Correct Answer indicators are available in six styles.

Correct Answer indicators

Before You Begin You must mark at least one answer as Correct or assign 
a point value to add a Correct Answer indicator to a slide. 
Find more information in Correct Answers and Points 
on page 66.

Step by Step Instructions To add a Correct Answer indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Correct Answer indicator.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

 Rectangle  Checkmark

 Smiley Face  Star

 Arrow  Blinking Rectangle

*
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3 Select Correct Answer 
Indicator to display the 
submenu of Correct Answer 
Indicators.

Find a picture of the types of Correct Answer 
indicators on page 85.

4 Select the type of Correct 
Answer indicator you would 
like to appear on the slide.

When you select the Correct Answer indicator, 
TurningPoint places it on your slide.

Next Steps You can delete the Correct Answer indicator if you no 
longer want it to appear on the slide.

To replace an existing Correct Answer indicator with a 
different type, simply repeat these steps. The current 
Correct Answer indicator will be replaced with the new 
one you select.

Add Text Messaging

A Text Message is a TurningPoint object that can be 
added to your slide that conveys a message to vPad 
users. A Text Message appears as a small object on your 
slide, but when it is shown, it automatically sends a 
message that can be viewed on vPad.

You can add more than one text message to a slide. For 
example, you might add a “Respond Now” message to 
send when polling opens and a “Time Is Up” message to 
send when polling closes. 

Tip Since Text Messages are objects on your slide, 
you can use PowerPoint’s animation features 
to time when they should be displayed. Find 
more information in PowerPoint’s online help.
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Step by Step Instructions To add a Text Message…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Text Message.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Text Message. A dialog box appears asking you to enter the text of 
the message.

4 Type your message in the 
dialog box and select the OK 
button.

TurningPoint places the Text Message Object on your 
slide.

Next Steps You may now alter the timing of the message using 
PowerPoint’s animation features. By default, the 
message is sent as soon as the slide is shown.

You can delete the Text Message object from the slide if 
you no longer want it to be sent. To add an additional 
Text Message, simply repeat these steps.

Add Statistics Indicators

Statistics indicators show a calculation after polling is 
closed based on the responses received. You can show 
the mean (average), median, standard deviation, and 
variance of the responses. The value of the statistic is 
revealed when the chart is displayed.

Statistics are calculated based on the numerical value of 
the response (the number of the answer on the slide). 
Since the statistics are based on the number of the 
answer, they are most useful for questions with an 
ordered scale of answers (such as a Likert scale).
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Step by Step Instructions To add a Statistic indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Statistic indicator.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Stats to display the 
submenu of Statistic 
indicators.

4 Select the type of Statistic 
indicator you would like to 
appear on the slide.

When you select the Statistic indicator, TurningPoint 
places it on your slide.

Next Steps You can move or resize the Statistic indicator to make it 
better fit your slide. You can delete the Statistic indicator 
if you no longer want it to appear on the slide.

You can add additional Statistic indicators to the same 
slide (up to all four types). Simply repeat these steps and 
select the additional Statistic indicator you would like to 
place on the slide.

Import Third-Party Slides
TurningPoint can automatically create TurningPoint 
slides from Microsoft Word files or from XML files 
exported from ExamView.

Using this feature of TurningPoint provides a quick way 
to create a number of slides, and it is also beneficial if 
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you already have question and answer data in another 
form that you would like to transform into TurningPoint 
slides.

A simple slide presentation can be created by importing a 
Microsoft Word document using the TurningPoint Parser. 
Use the Heading 1 style for each question and the 
Heading 2 style for each answer in the Word document.

Alternatively, you can import question and answer data in 
the XML format exported from ExamView.

You can also achieve more complicated effects with the 
Word and XML files, such as marking correct answers or 
point values, specifying pictures for the answers on a 
picture slide, and other features. You can find examples 
and more detailed information on the types of files 
accepted by the TurningPoint Parser in Appendix B: 
TurningPoint Parser Documents.

Import Slides with the TurningPoint Parser

The TurningPoint Parser is located in the Tools menu 
and allows you to automatically create slides from 
Microsoft Word or XML files. 

Step by Step Instructions To import slides with the TurningPoint Parser…

1 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

2 (Optional) Select Update 
Parser Slides.

The slides you import will be created with default 
characteristics that may not match your settings. You 
can use the Update Parser Slides command to update 
the imported slides to match your settings.

3 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.
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4 Select TurningPoint Parser. An open file window appears asking you to select the 
file to import.

5 Navigate to the file you would 
like to import (.doc or .xml) 
and select it.

6 Select the Open button to 
continue.

A dialog appears asking whether you would like to add 
the slides to the end of the current presentation or 
create a new presentation.

7 Select the Yes button to add 
the slides to the current 
presentation, or select the No 
button to create a new 
presentation.

TurningPoint builds the slides from the file. If there are 
many slides, this may take some time.

Next Steps The slides imported by the TurningPoint Parser are 
normal TurningPoint slides, so you can take advantage 
of any of the TurningPoint customizations you would like 
to make on them.

Import Slides from ExamView

TurningPoint can insert files from ExamView and create 
slides based on them. TurningPoint retains the features 
used in the ExamView files, including the correct 
answers and any pictures and non-interactive slides.

Step by Step Instructions To import slides from ExamView…

1 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Import from 
ExamView.

An ‘Open an ExamView Test/Bank/XML File’ window 
opens allowing you to select the file to import.
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3 Navigate to the file you would 
like to import (.tst, .bnk, or 
.xml) and select it.

4 Select the Open button to 
continue.

A dialog box opens allowing you to choose to add the 
slides to the end of the current presentation or create 
a new presentation.

5 Select the Yes button to add 
the slides to the current 
presentation, or select the No 
button to create a new 
presentation.

TurningPoint builds the slides from the file. If the file 
contains many slides, this may take some time.

Ranking Wizard
You can quickly and easily create slides that support 
decision-making, prioritization, or other kinds of ranking 
using TurningPoint’s Ranking Wizard. The Ranking 
Wizard automatically creates slides for comparisons of 
items on one to three criteria, then summarizes the 
results of the comparisons in a chart.

For example, suppose you wanted to prioritize several 
projects you are considering. You might compare them 
on the basis of cost, impact, and urgency to rank them.

You can choose to rank each item on a numerical scale 
for each criterion. For example, one slide would ask you 
to rank Project A on urgency from least (1) to most (10). 
You can use a scale beginning with 1 and ending with 
any number up to 10.
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Alternatively, you can choose to compare items on the 
criteria by pairs. For example, one slide would ask you 
whether Project A or Project B is more urgent.

You can include as many items as you wish, and you can 
compare them on up to three criteria. The results are 
displayed in a chart which ranks the items. The chart 
looks similar to this:

Ranking Wizard chart

In this example, Project D looks like a clear winner, since 
it has the lowest cost, most urgency, and a relatively high 
impact.

The Ranking Wizard gathers information from you about 
the items, the criteria, and how you would like to make 
the comparisons. Then it automatically constructs a 
series of slides with the questions and answers 
necessary to construct a final comparison chart.

*



TurningPoint User Guide 93

Ranking Wizard

Create Slides with the Ranking Wizard

The Ranking Wizard is located in the Tools menu on the 
TurningPoint toolbar. It guides you through the process 
of creating a ranking.

Step by Step Instructions To create slides with the Ranking Wizard…

1 Navigate to the slide you 
would like the ranking slides 
to be inserted after.

When you complete the Ranking Wizard, the ranking 
slides will be added to the presentation after the 
currently visible slide.

2 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

3 Select Ranking Wizard. The Ranking Wizard window opens.

Ranking Wizard: Add Items

4 Type a name for an item to be 
ranked in the box provided 
and select the Add button.

The item will be added to the list.
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Repeat this step until you have added all the items you 
would like to rank.

5 When you have added all the 
items to rank, select the Next 
button.

The next set of options allowing you to specify the 
criteria is displayed in the Ranking Wizard.

Ranking Wizard: Enter Criteria

6 Enter a name for the X 
criterion and, optionally, the Y 
criterion, in the boxes 
provided.

You must enter at least one criterion (X) for the 
ranking. If you are comparing only a single criterion, 
leave the Y criterion blank.

The X and Y criteria appear on the horizontal and 
vertical axes of the chart, respectively.

Note You can save a list of items if you will reuse 
them with the Ranking Wizard. Lists are 
stored as simple text (.txt) files. 
Use the Save button (shaped like a disk) to 
save a text file with the list of items. Use the 
Load button (shaped like a folder) to load a 
text file with a list of items.
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7 If you wish to include a third 
criterion in the ranking, check 
the box for the Z criterion and 
enter a name for the Z 
criterion in the box provided.

The Z criterion, if used, is represented in the chart by 
the size of the “bubble” for each item.

8 Choose a method for ranking 
the items:
• Select Standard X/XY/XYZ 

to rank the items on a 
numerical scale for the 
criteria.

You will specify the numerical scale to use later in 
the Ranking wizard if you choose a standard 
comparison.

• Select Paired Comparison 
to compare the items by 
pairs on the criteria.

If you choose paired comparisons, you may allow a 
response of No Preference by checking the box for 
that option.

9 If you chose a standard 
comparison, select whether 
you would like the slides to be 
grouped by criterion or by list 
item.

Grouping slides by criterion will present the slides for 
each item about criterion X, then slides for each item 
about criterion Y, and so on.

Grouping slides by item will present the slides for each 
criterion about item A, then the slides for each criterion 
about item B, and so on.

10 Check the box if you would 
like to Auto-Advance the 
slides created by the Ranking 
Wizard.

Using Auto-Advance automatically advances the slide 
after all participants have responded to a question.

11 Check the box if you would 
like to display the charts for 
the slides created by the 
Ranking Wizard.

Commonly, you are not interested in seeing the 
results for individual slides in the ranking questions. 
You can uncheck this option and use it in combination 
with Auto-Advance to make your way quickly through 
the ranking questions to display the ranking chart.
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12 If you are using a Z criterion, 
check the boxes if you would 
like to use the following 
options:
• Show Bubble Names 

shows the name of each 
item on the bubble that 
represents it in the ranking 
chart.

The chart also includes a key that color-codes the 
bubbles with the items.

• Show Bubble Sizes shows 
the numerical size of each 
item’s bubble on the 
ranking chart.

13 When you have specified all 
the options you would like to 
use, select the Next button.

If you chose a standard comparison, the next set of 
options allowing you to specify the ranking scale is 
displayed in the Ranking Wizard window. (If you 
chose a paired comparison, a summary is displayed 
and you can skip to step 17.)

Ranking Wizard: Customize Scale
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14 Uncheck the boxes next to 
the numbers if you wish to 
limit the scale to less than 1–
10.

Unchecking a number also unchecks all the larger 
numbers.

For example, if you would like to use a scale of 1–4, 
uncheck the box next to 5.

15 If you would like to add labels 
to the numbers, select a 
number and type the label 
text.

You might like to add labels to the lowest and highest 
numbers of the scale (such as “Worst” and “Best”).

16 When you are finished 
modifying the ranking scale, 
select the Next button.

A summary of all the options you chose is displayed in 
the Ranking Wizard window:

Ranking Wizard: Review Selections

17 Review the information in the 
summary to ensure that it is 
correct.

If any of the information is incorrect, you can select the 
incorrect information to be taken to the set of options 
in the Ranking Wizard where you specified the 
information. Change the information to be correct and 
then continue with the remaining steps. (Alternatively, 
use the Back button to go back to the incorrectly set 
option.)
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18 Select Finish to create the 
ranking slides.

TurningPoint inserts the ranking questions and the 
ranking chart in your presentation. (This may take 
some time if you have a large number of items.)

Next Steps When you run the presentation containing the ranking 
slides, the results will be compiled to generate the 
ranking chart, which is displayed in a slide following the 
ranking questions.

Because the Ranking Wizard uses the results from the 
created slides to construct the final chart, you should not 
alter the slides created by the Ranking Wizard.

TurningPoint Settings
TurningPoint offers many settings you can use to 
customize the way your slides look and behave. You may 
notice that sections throughout this user guide mention 
settings that can have an effect on the tasks you perform 
with TurningPoint.

The TurningPoint settings can be viewed and modified by 
selecting the Settings button from the TurningPoint 
toolbar. (The Settings button looks like a pair of 
eyeglasses.)



TurningPoint User Guide 99

TurningPoint Settings

You can adjust the settings in the Settings window:

Settings window

Across the top of the Settings window are four icons: 
Information, Presentation, Slides, and Global Changes. 
Selecting one of these icons changes the contents 
displayed in the rest of the Settings window. 

Below these four icons, the Selected Slide and Answers 
drop-down menus allow you to select specific slides or 
answers to modify the settings for.

Below these drop-down menus are the settings 
themselves. You can view them displayed in groups of 
related settings or alphabetically by selecting the buttons 
above the settings. The name of each setting is in the left 
column and its value is in the right column. Some 
settings may allow you to type a value, while others will 
offer a drop-down menu to select from several choices.
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At the bottom of the settings window is a region that 
displays a description of a setting when you select it. You 
can use these descriptions to learn about the settings.

The Done button saves the changes you made to the 
settings and closes the Settings window.

The following sections contain information about the 
settings available by selecting one of the four icons at the 
top of the Settings window:

Information Information about the version of TurningPoint you are 
using and your license code. You cannot edit this 
information.

Presentation Presentation-level settings for the creation of slides, the 
way presentations display, and other TurningPoint 
options. If you change a presentation-level setting, the 
change applies to all slides you create in the future.

Slides Slide-level settings affect particular slides and their 
answers. The slide-level settings apply to the slide 
selected in the Selected Slide drop-down menu (and the 
particular answer, if applicable).

Global Changes Some presentation-level settings are available in Global 
Changes. If you change a setting in Global Changes, the 
change is applied to the presentation-level settings (and 
therefore to all slides you create in the future) as well as 
to ALL TurningPoint slides in the currently open 
presentation.

Your settings for TurningPoint are stored in your personal 
settings folder on your computer. You can share the 
same computer with multiple TurningPoint users, all of 
whom have different settings.
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Save the Presentation Slides

Your TurningPoint slides are saved as part of your 
regular PowerPoint (.ppt) presentation file. You can 
share this file with other TurningPoint users. 

Step by Step Instructions To save your presentation…

1 Select File > Save As… from 
the PowerPoint menu.

The Save As window opens.

2 Select a location to save the 
file and type a filename for 
the file in the space provided.

You should keep the .ppt extension in the filename to 
ensure that PowerPoint opens the presentation file.

3 Select the Save button to 
save your file.

TurningPoint saves all of the presentation level 
settings that you defined in the Settings menu to the 
presentation itself. When you open the presentation 
on a different computer, the saved presentation 
settings are used instead of the computer’s default 
settings. This function preserves your custom settings 

Note You can safely open the presentation on 
computers without TurningPoint installed, 
but you cannot use the TurningPoint 
features. You should not edit the 
TurningPoint slides on a computer without 
TurningPoint installed.



102 Turning Technologies

Chapter 3: How to Create Slides

so that you do not have to reapply them every time you 
open a presentation on a new computer.

Where Do I Go From Here?
This chapter has demonstrated how to create and 
customize TurningPoint slides for your presentation.

The next step in successfully using TurningPoint for an 
interactive presentation is to set up the hardware devices 
for participants to respond. Chapter 4: How to Set Up 
Response Devices demonstrates this process. You only 
need to set up hardware devices once on the computer 
you will use them with, unless you add or change the 
hardware devices.

If you have already set up hardware devices, the next 
step is to create a Participant List to keep track of the 
participants for your presentation. Chapter 5: How to 
Track Participants and Teams demonstrates this 
process.

If you already have a Participant List for the audience 
you will be presenting to, you are ready to conduct your 
presentation! Chapter 6: How to Run a Presentation 
Session demonstrates this process.

Note You can restore the computer’s settings 
when using any presentation. In the Settings 
menu, select the Presentation icon. A blue 
icon with a white arrow displays in the bar 
above the settings options. Select this blue 
icon and a dialog box appears with this 
statement: ‘This will restore the presentation 
settings back to the default installation 
state.’ Select OK to restore the default 
settings.
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Response 
Devices

Your audience responds to your interactive presentation 
using a response device. You can license response 
devices from Turning Technologies for use with 
TurningPoint. These response devices include:

• Responsive Innovations’ ResponseCard IR—a 
compact response device that uses infrared 
technology to send audience responses.

• Responsive Innovations’ ResponseCard RF—a 
compact response device that uses radio frequency 
technology to send audience responses.
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• Responsive Innovations’ ResponseCard XL—an 
Infrared (IR) system that allows for self-paced testing 
by letting students enter responses to many different 
questions on the card’s LCD then transmitting all the 
answers at once.

• Turning Technologies’ vPad group response software 
application—a virtual keypad, installed on a personal 
computer or PDA, that takes advantage of a 
classroom network to send responses or control 
presentations.

TurningPoint also supports a variety of audience 
response keypads and wireless voting systems 
manufactured by leading industry suppliers. Contact 
Turning Technologies for more information about 
supported platforms.
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Recall the five steps to presentation success:

Five Steps to Success

This chapter covers the second step, setting up response 
devices such as the Responsive Innovations’ 
ResponseCards and the vPad software. It demonstrates 

*
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how to run the Response Device Wizard to ensure 
TurningPoint is able to receive a response from the 
installed device.

Install Devices
You enable communication between TurningPoint and 
the response devices using the Response Device 
Wizard. If you are using a Keyspan adapter, you must 
install the adapter before running this wizard.

Response device technologies communicate using a 
receiver. The receiver must be connected to the 
computer that will be used to run the TurningPoint 
interactive presentation. This section includes 
instructions to install the device receivers.

The vPad response software application has two 
versions. Audience participants use it to provide 
responses to the interactive presentation. Presenters use 
it to control the presentation. This section also includes 
instructions to install the vPad software. 

Install Response Device Receiver(s)

The ResponseCards communicate with TurningPoint 
through a receiver. The receiver accepts the signal 
produced by the individual response cards and passes 
the response along to TurningPoint.

Responsive Innovations manufactures response cards 
that emit either infrared (IR) or radio frequency (RF) 
signals. TurningPoint recognizes both signal types.
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Before You Begin The receiver must be installed on the machine that will 
be used to run the presentation prior to running the 
Response Device Wizard to test response card 
communication with TurningPoint.

Step by Step Instructions To install the response card receiver…

1 Connect the receiver cable to 
the appropriate computer 
port.

Receivers connect to the COM port (via the 9-pin RS-
232 connector) or the USB port on the computer. 

If you install a serial receiver using the Keyspan USB 
port adapter, you will be prompted to install the 
hardware device.

2 If required, insert the 
hardware installation CD into 
your computer’s CD-ROM 
drive.

Each ResponseCard/receiver package includes a CD 
containing the device drivers for the hardware. This 
CD is stored in the front of the TurningPoint binder 
along with the receiver.

Follow the Found New Hardware Wizard to install the 
device driver.

3 Place the receiver in an 
unobstructed area at the front 
of the room.

The receiver needs to be positioned so that it can 
receive the signal from the response devices. You 
may want to elevate the receiver so that it can be seen 
by everyone in the room.
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Next Steps Run the Response Device Wizard to test the 
communication between the TurningPoint software and 
the response devices.

Install the vPad Response Software

The vPad group response software acts as a virtual 
response device. Audience members use the software 
from desktop or laptop computers or PDAs that are 
connected to the presentation computer using a direct or 
wireless network.

vPads exhibit the same response behavior as 
ResponseCards. If you are running a vPad and connect 
during a presentation, you can close and reopen the 
vPad and still have the same response device number.

Before You Begin TurningPoint and the vPad software must be installed on 
computers that use the same network.

Note The effective range of an IR device receiver is 
about 75 feet (25 meters). You will need to 
install one receiver for every 80 participants. 
The effective range of an RF device receiver is 
about 200 feet (60 meters). A single receiver is 
sufficient for up to 1000 keypads, and a direct 
line of sight between the receiver and the 
keypad is not necessary.
Use more than one receiver during your 
presentation if your room size or participant 
size exceeds these maximum specifications. 
Contact Turning Technologies for suggested 
receiver layout plans.
Use these instructions to connect a response 
device receiver for any response device 
technology supported by TurningPoint.



TurningPoint User Guide 109

Install Devices

Step by Step Instructions To install and set up the vPad software on a PC…

1 Insert the vPad installation 
CD into your computer’s CD-
ROM drive.

2 Run the vPad setup program. Follow the instructions in the vPad setup wizard to 
install vPad on your desktop or laptop computer. The 
installation creates a vPad desktop icon and an entry 
in your computer’s Start > Programs menu.

vPad Response Device

3 Double click on the vPad 
desktop icon to start the vPad 
software.

The Turning vPad window opens.

You need to configure vPad to enable it to 
communicate on the network.

4 On the Turning vPad window, 
select File > Select Host 
Computer.

The Select a Host Computer window opens.

5 Select the Add button. The Turning vPad dialog box opens and displays the 
friendly name setup prompt. 
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vPad: Enter Friendly Computer Name

6 In the Turning vPad window, 
enter the computer’s friendly 
name or IP address and 
select OK.

The Turning vPad dialog box displays the port number 
setup prompt.

vPad: Enter Port Number

7 In the Turning vPad window, 
enter the port number to be 
used for communication 
between the vPad and 
TurningPoint and select OK.

Turning vPad uses port 1001 by default. Enter a 
different number, if defined otherwise on the host 
computer.

The newly added host computer appears in the Select 
a Host Computer window.

8 In the Select a Host 
Computer window, select 
OK.

Turning vPad displays a dialog box asking to connect 
to the selected host.

9 In the TurningPoint 
connection dialog box, select 
OK.

The Turning vPad window displays a message: 
Connected to mylaptop at 2:30:21 PM. 
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Your computer’s friendly name (entered in step 6) and 
the time when you connected (as a result of 
completing this step) are displayed in place of the 
words above.

10 Repeat steps 1-10 for each 
computer to be used as a 
response device.

Next Steps Run the Response Device Wizard to test the 
communication between the devices and the 
TurningPoint software.

Run the Response Device Wizard
Each audience participant uses a device to respond to 
the questions asked during the presentation. 
TurningPoint supports a variety of response devices 
including infrared and radio frequency keypads as well 
as networked PDAs, laptops, and desktops.

TurningPoint needs to know what types of response 
devices will be used before you run the presentation. Use 
the Response Device Wizard to set up and test the 
response devices.

You will run this wizard every time you make a change to 
the device setup. Changes include adding new response 
devices, changing the number of response devices to be 
used during a presentation session, and retesting the 
communication between TurningPoint and the response 
devices.
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Set Up and Test the Device Connection

Use the Response Device Wizard to set up the number 
of response devices to be used with your TurningPoint 
presentation and to test the communication between the 
response device and TurningPoint.

Before You Begin You must have TurningPoint installed on the computer to 
be used for the presentations, the hardware device 
receivers connected, vPad installed (if using the virtual 
response device software), and the response devices 
available for testing. 

Step by Step Instructions To set up the response devices…

1 From the TurningPoint 
toolbar, select the Display 
Response Device Wizard 
button. (Hint: it’s the one that 
looks like a lightning bolt.)

The TurningPoint Response Device Wizard window 
opens. All devices that you are able to use with 
TurningPoint are shown.

Response Device Wizard: Select Devices
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2 Select the box next to the 
device to select one or more 
device types to be set up.

You can choose to view the device list by name or by 
picture.

a To view the devices by 
device name, select the 
Small Icons option at the 
bottom right of the entry 
list. 

Large Icons is the default setting.

b To view the devices by 
picture, select the Large 
Icons option.

TurningPoint displays facsimile images of each 
supported device.

3 Select the Next button. If you are using a serial-based device, TurningPoint 
searches your computer to locate the ports where it 
finds connections for the device receivers and 
displays the list of ports. If you are using only vPad 
devices, skip to step 5. If you are using only USB 
devices, skip to step 9.

4 Select the checkbox next to 
the ports where the response 
devices are connected.

TurningPoint selects your computer’s COM port by 
default.

5 If you are using the vPad 
software, set up the vPad 
port.

a If your computer does not 
use port 1001, select the 
Change button.

b In the TurningPoint 
window, enter a port 
number between 1 and 
65535.

Note TurningPoint uses port 1001 as the default 
connection port for the vPad software.
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c Select the OK button.
d In the Response Device 

Wizard window, verify the 
Current vPad Port value 
matches what you entered 
in step b.

e If the value is not correct, 
repeat step a–step c.

6 Select the Next button. TurningPoint begins searching for the response 
devices. 

Response Device Wizard: Search for Devices
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7 If you are using a serial 
device, press a key on one 
response device to send a 
signal TurningPoint from the 
device.

This step is unnecessary for USB devices. You can 
skip this step for vPad devices by selecting the Skip 
Verification button.

a If TurningPoint doesn’t find 
the response device on the 
first attempt, select the Not 
Found button and try 
again.

b Repeat this step for each 
device type being used.

TurningPoint displays the Hardware Found 
message when it accepts the value sent by the 
response device and displays a Done searching… 
message when the device is found successfully.

8 Select the Next button. TurningPoint displays the Keypad Ranges screen 
which shows the number of response devices 
licensed for use with the software. 

9 Enter the first device number 
to be used in the Starting 
keypad number region.

You assign each response device a number. You may 
start with whatever number you choose.

Note If you have a license for an evaluation version 
of TurningPoint, you can use five response 
devices to test your presentation. 
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10 Enter the last device number 
to be used in the Ending 
keypad number region.

The difference between the Starting and Ending 
keypad numbers should not exceed the number of 
purchased licenses.

Note TurningPoint limits the number of response 
devices able to be used with an interactive 
presentation based upon the range of values 
entered in the Starting and Ending keypad 
number regions.
If the difference of the values is less than the 
number of purchased licenses, the lesser 
number will be used. For example, if you enter 
1 as the Starting keypad number and 10 as the 
Ending keypad number, only 10 devices can be 
used during the presentation, even if 
TurningPoint is licensed for 50 devices.
You cannot exceed the number of licensed 
devices. For example, if the starting number is 
1 and you enter 60 in this region, but 
TurningPoint is licensed for 50 devices, only 50 
devices can be used during the presentation.
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11 Select the Next button. TurningPoint displays the Polling screen. Use this 
screen to verify that TurningPoint can receive 
responses from the devices.

Response Device Wizard: Polling Test

12 Select the Start Test button. TurningPoint is now ready to accept responses from 
the response devices.

13 Press a key on each 
response device to be used.

TurningPoint displays an entry for each response 
device, in the order in which they were tested, and the 
key number pressed on each response device.

14 Select the End Test button. This action ends the Polling test.

15 Select the Finish button. The response device setup is now complete. 

Next Steps Run the Response Device Wizard again when you need 
to make changes to the number or type of devices being 
used with your presentations.



118 Turning Technologies

Chapter 4: How to Set Up Response Devices

Update the Number of Devices Used

Run the Response Device Wizard whenever you need to 
add a new device type or change the number of devices 
being used.

Step by Step Instructions To increase or decrease the accepted responses…

1 From the TurningPoint 
toolbar, select the Display 
Response Device Wizard 
button. (Hint: it’s the one that 
looks like a lightning bolt.)

TurningPoint displays the Response Device Wizard 
Configuration Summary window.

Response Device Wizard: Configuration Summary

2 Select the Change Range(s) 
button.

TurningPoint displays the Please set keypad ranges 
page. This page shows the number of licensed 
devices, the device types currently set up for use, and 
the current device range settings.

3 Enter the first device number 
to be used in the Starting 
keypad number region.

You assign each response device a number. You may 
start with whatever number you choose.
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4 Enter the last device number 
to be used in the Ending 
keypad number region.

The difference between the Starting and Ending 
keypad numbers should not exceed the number of 
purchased licenses.

5 Select the Next button. TurningPoint displays the Polling screen. If desired, 
you can use this screen to test the communication 
between TurningPoint and the response devices. 

6 Select the Finish button. The response device setup is now complete.

Check Device Communication

You should test the communication between a device 
and TurningPoint if an audience member’s response is 

Note TurningPoint limits the number of response 
devices able to be used with an interactive 
presentation based upon the range of values 
entered in the Starting and Ending keypad 
number regions.
If the difference of the values is less than the 
number of purchased licenses, the lesser 
number will be used. For example, if you enter 
1 as the Starting keypad number and 10 as the 
Ending keypad number, only 10 devices can be 
used during the presentation, even if 
TurningPoint is licensed for 50 devices.
You cannot exceed the number of licensed 
devices. For example, if the starting number is 
1 and you enter 60 in this region, but 
TurningPoint is licensed for 50 devices, only 50 
devices can be used during the presentation.

Note TurningPoint does not require a polling test be 
performed when changing the device ranges. 
Find polling instructions in the Check Device 
Connections section.
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not being accepted during a live presentation or if a new 
response device is being used.

Before You Begin Ensure the device receiver is properly installed and the 
device to be tested is available.

Step by Step Instructions To test for device communication…

1 From the TurningPoint 
toolbar, select the Display 
Response Device Wizard 
button. (Hint: it’s the one that 
looks like a lightning bolt.)

TurningPoint displays the Response Device Wizard 
Configuration Summary window.

Response Device Wizard: Configuration Summary

2 Select the Run Polling Test 
button.

TurningPoint displays the Start polling test screen.

3 Select the Start Test button. TurningPoint is now ready to accept responses from 
the response devices.

4 Press a key on each 
response device to be used.

TurningPoint displays an entry for each response 
device, in the order in which they were tested, and the 
key number pressed on each response device.

5 Select the End Test button. This action ends the Polling test.
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6 Select the Finish button. The response device setup is now complete. 

Add New Device Types

Use the Response Device Wizard for each additional 
device type to be used with your interactive presentation.

Before You Begin Ensure the device receiver is properly installed and the 
device to be tested is available.

Step by Step Instructions

1 From the TurningPoint 
toolbar, select the Display 
Response Device Wizard 
button. (Hint: it’s the one that 
looks like a lightning bolt.)

TurningPoint displays the Response Device Wizard 
Configuration Summary window.

Response Device Wizard: Configuration Summary

2 Select the Restart Wizard 
button.

TurningPoint displays the device selection screen.



122 Turning Technologies

Chapter 4: How to Set Up Response Devices

3 Follow the instructions to 
setup a response device 
beginning with step 2 in Set 
Up and Test the Device 
Connection on page 112.

Where Do I Go From Here?
If you are setting up your devices for the first time, the 
next step is to create your Participant List. A Participant 
List allows you to track the responses provided by your 
audience for each slide you present. Find instructions to 
create a Participant List in Chapter 5: How to Track 
Participants and Teams.

If you have installed new response device hardware, and 
you have already set up your Participant List, you can 
create a new interactive presentation or run an existing 
presentation using the new device. Find instructions to 
create slides in Chapter 3: How to Create Slides. Find 
instructions to run a presentation in Chapter 6: How to 
Run a Presentation Session.

Note Optionally, select the Cancel button to exit from 
the Response Device Wizard without 
completing the setup.
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How to Track 
Participants and 
Teams

Participant Lists identify the members of your audience—
your students, your trainees, your survey respondents—
who will use a response device to respond to questions 
during your presentation. The participant name and other 
required information are stored along with information 
about their assigned device, which is identified by 
number (for example, 1, 2, 3, and so on) and by device 
ID, a unique identifier for a response device. The device 
ID is printed on the device tag, which is located on the 
back of the device (unless you are using vPad response 
software).
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Creating an interactive presentation with TurningPoint 
can be accomplished in five easy steps. This chapter 
discusses how to create and edit a Participant List. 

Five Steps to Success

*
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Run the Participant List Wizard
Create a Participant List using the Participant List 
Wizard. You can choose from using standard list 
templates or create one of your own to store as much 
information about your audience as is desired. 

The Participant List Wizard guides you through the 
creation of a Participant List to be used with your 
interactive presentation. You control the number of 
responses TurningPoint will accept, which equates to the 
number of audience members. A Participant List 
captures the audience names, their device numbers and 
serial numbers, and other relevant information. 

You may create multiple Participant Lists to be used with 
the same interactive presentation. One Participant List 
contains information about one audience group. This 
allows you to capture responses from multiple audiences 
to your slides.

Create a Participant List

This section introduces the Participant List Wizard and 
describes how to build a new Participant List.

Before You Begin The number of names entered in the Participant List 
must not exceed the number of devices licensed for use 
or the number of devices that you identified for use in the 
Response Device Wizard.
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Step by Step Instructions To create a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Participant List Wizard.

The TurningPoint Participant List Wizard window 
opens.

Participant List Wizard

2 Type the name of the 
Participant List you want to 
create.

TurningPoint provides a name using the current 
system date and time. You can type a more 
meaningful name or use the default.

3 Select the response device to 
be used to create the 
Participant List.
• To use the identified 

device, select the Use the 
current device 
configuration option.

TurningPoint gathers the communication port and 
device range information that was provided while 
running the Response Device Wizard and displays 
it in the lower region of the window.
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• To enter specific locations 
and participant ranges, 
select the Manually specify 
locations and participant 
ranges option. 

TurningPoint allows you to modify specifications for 
response device ports in the list. The menu choices 
in this region include:

• Remove a Location—clears the selected location 
from the list.

• Modify Range > Change Values—for an existing 
location, displays a window allowing you to enter 
new starting and ending device numbers.

• Modify Range > Auto-detect—for an existing 
location, displays a window allowing you to enter 
the number of participants to be defined in the 
list. TurningPoint uses the presentation 
computer’s configuration to determine the 
number of responses allowed.

• Add a Location > vPad Port—opens a window 
allowing you to enter the port number to be used 
for the vPad software response device (a value 
between 1 and 65355). 

• Add a Location > Comport—opens a window 
allowing you to enter the comport number (a 
value between 1 and 32). 

• Add a Location > Auto-detect—opens a window 
allowing you to enter the number of participants 
to be defined in the list. When the interactive 
presentation is used, TurningPoint uses the 
presentation computer’s device configuration file 
to determine the port(s) to be used.

Note Right-click in the region displaying the Location 
or Participant Range values to access the 
options for changing these values. The menu 
displays only when the Manually specify 
locations and participant ranges button is 
selected. 
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• Clear All Locations—removes all response 
device configurations from the list. This selection 
is not available if no locations are defined.

4 Select the Next button. TurningPoint presents the option to use the pre-
defined Participant List templates or to create a 
custom template. Custom templates created in the 
past will appear in the My Custom Templates region 
when the Custom Template button is selected.

Participant List Templates

5 Select a template for the new 
Participant List.

Participant List template choices include:

• Education—contains entries typical for student 
information, such as name and student ID.

• Corporate—contains entries for the information 
most often used in corporate feedback meetings 
including name, company name, telephone 
numbers, etc.

• Available Fields—contains all pre-defined entries 
suggested for use with TurningPoint.
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• Custom—allows you to create a personalized 
Participant List or to select a previously created 
custom template from the list. 

6 Select the Next button to 
continue.

If you opted to create a new template, TurningPoint 
asks you to name the template. Enter a name and 
select the OK button.

TurningPoint displays the Participant List information 
entries (called fields). All entries that make up the 
template appear in the Selected Fields region on the 
right. Use this page to add, delete, or reorder the 
entries that make up the template.

Participant List: Add or Remove Fields

Tip Each of the templates can be customized. It 
may be faster to add and remove entries from 
a pre-defined template than to select Custom 
template and choose every entry.
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7 Optionally, customize the list 
of Selected Fields. Select the 
Edit button to activate the 
fields lists. 

Right (>) and left (<) arrow buttons replace the Edit 
button. If you selected Custom Template, the right (>) 
and left (<) arrows appear by default instead of the 
Edit button.

• To remove an entry from 
the template, select it 
under the Selected Fields 
region and click the left 
arrow button. 

When selecting entries from the fields lists, type 
Shift + click to select multiple contiguous entries, or 
Control + click to select multiple entries. 

• To add an entry to the 
template, select the 
desired entry from the 
Available Fields region, 
and click the left arrow 
button.

8 Select the Next button to 
continue.

TurningPoint displays the Groups entry box. Use this 
screen to add Groups to your Participant List. Groups 
provide categorization for greater reporting 
opportunities, such as demographic reports or team 
competitions.
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Participant List Wizard: Add Groups

9 Optionally, type in a group 
name and select the Add 
button.

TurningPoint displays all groups in the Included 
Groups list. Repeat this step to add additional groups.
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10 Select the Next button. TurningPoint displays the Participant List summary 
page. 

Participant List Wizard: Summary

11 Optionally, edit the 
Participant File composition.

The settings that are able to be changed include the 
Participant List file name, number of participants, 
number of fields, and number of groups. Select the 
link to be returned to the screen and make edits.

12 Select the Finish button to 
create the Participant List 
and save it to a file.

13 Optionally, save the template 
for future use. 

If you have modified a pre-defined template, 
TurningPoint asks whether to save the settings as a 
custom template. If you select the Yes button to name 
and save the template, the custom template will be 
available under My Custom Templates the next time 
you create a Participant List.
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14 Add names and other 
participant information to the 
new Participant List. 

TurningPoint opens the Participant Information 
window where you can type, paste, or import data. 

Participant Information

15 Select File > Save to save the 
data in the Participant List 
before closing the Participant 
Information window.

The new Participant List appears on the TurningPoint 
toolbar in the Select a Participant List drop-down 
menu (next to the Participants menu).

Set Up Team Competitions
TurningPoint can enhance group interaction to create a 
more memorable and educational presentation. Team 
competitions are a fun way to incite this interaction. Set 
up team competitions through the Participant List Wizard. 
You can create a Participant List that enables you to 
assign participants to teams who will compete for the 
highest score during your presentation. 
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For participants or teams to accumulate scores, you will 
have to assign point values to correct answers. You can 
even assign points based on how quickly participants 
respond using speed scoring. Find more information in 
Correct Answers and Points on page 66.

TurningPoint offers several slides to keep track of 
participant and team point totals and which participants 
responds most quickly. Find more information in 
Summary Slides for Competitions on page 45.

Add Teams to a Participant List

Follow these steps to create a Participant List that can 
enable team competitions.

Before You Begin These steps create a new Participant List that assigns 
participants to teams before the presentation. If you 
would like to pick teams on the fly during the 
presentation, you need to insert a Team Assignment 
slide. Find information about this special slide in Chapter 
3: How to Create Slides. 

Step by Step Instructions To set up team competitions…

1 Follow step 1 through step 8 
in Create a Participant List 
on page 125. 

In the Participant List Wizard window, TurningPoint 
displays the Groups entry box. Use this page to add 
groups to your Participant List. 

2 Type a group name in the 
Create a new group field, and 
select the Add button. Repeat 
for all desired team names.

TurningPoint displays all groups in the Included 
Groups list. These groups can represent any type of 
grouping you wish to assign participants to, such as 
teams, class level, or any other demographic 
information.
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3 Select the groups in the 
column to the right that you 
want to designate as teams 
who will compete against 
each other.

Check marks appear next to the groups designated to 
compete as teams.

Participant List Wizard: Add Groups

4 Select the Next button to 
continue.

TurningPoint displays the Participant List summary 
screen.

5 Select the Finish button to 
create the Participant List 
and save it to a file.

Next Steps Find more information about setting correct answers, 
point values, and speed scoring in Correct Answers and 
Points on page 66.

Find more information about slides for keeping track of 
participants’ and teams’ points in Summary Slides for 
Competitions on page 45.
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Edit the Participant Lists
After you have imported a Participant List or created one 
with the Participant List Wizard, you can make changes 
to a Participant List or delete it altogether.

Modify a Participant List

Follow these steps if you would like to make changes to 
an existing Participant List. Although the presenter’s 
computer assigns response device numbers to each 
participant, you can manually assign a participant to a 
specific device number by modifying the list.

Before You Begin A Participant List should have a .tpp extension 
(TurningPoint participants format). You must import the 
Participant List or create a list using the Participant List 
Wizard before editing it with TurningPoint. 

When modifying a Participant List, you may add new 
participants only if the total number of participants stays 
within the participant range that you designated when 
creating the Participant List. Keeping under this 
maximum allows there to be enough response devices 
for each participant on the list. If the number of 
participants exceeds the range, then you must create a 
new Participant List to account for the increase in the 
number of response devices you need.

Step by Step Instructions To modify a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Edit a Participant List.

TurningPoint displays a window of Participant Lists 
saved in My Documents > TurningPoint > 
Participants.
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2 Select the desired Participant 
List, and then select the 
Open button.

TurningPoint displays the Participant List data in the 
Participant Information window. The grey fields 
represent data that cannot be edited, such as the 
column titles and device numbers.

Participant Information window

3 Optionally, edit the existing 
data in the white fields by 
selecting the entries and 
typing new information.

You cannot modify the device number column. To 
assign a specific device number to an individual, enter 
the participant’s information next to the device 
number. 
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4 Optionally, add a new 
participant by right-clicking in 
the Participant Information 
window and selecting Add 
Participant to Location.

If the total number of participants remains under the 
maximum as mentioned previously, then TurningPoint 
creates a new empty row.

Participant Information window: Add New

5 Select File > Save. TurningPoint displays a confirmation message telling 
you that your changes have been saved. 

6 Select the Done button to 
close the Participant 
Information window.

Delete a Participant List

This section describes how to remove a Participant List 
from TurningPoint.

Before You Begin Deleting a Participant List sends the file to the 
computer’s Recycle Bin. Save a backup copy in another 
location if you would like to be able to access the file 
later.
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Step by Step Instructions To delete a Participant List… 

1 From the TurningPoint 
toolbar, select Participants > 
Delete a Participant List.

TurningPoint displays a window that lists all 
Participant Lists that have been created or imported.

2 Select the file name of the 
Participant List you wish to 
remove. 

3 Click the Delete button. TurningPoint removes the file from the list. 

Import and Export Participant Data
You can use Enterprise Manager from Turning 
Technologies with TurningPoint. Enterprise Manager is 
an essential tool for large organizations that put the 
TurningPoint 2006 group response system to work in a 
classroom setting. Using a web-based interface, users 
interact with Enterprise Manager to identify classes that 
use TurningPoint 2006 as part of the curriculum, assign 
faculty and students to those classes, and input device 
IDs for the students’ response devices. Enterprise 
Manager captures this information and manages the 
licenses for response device usage.

As a versatile educational tool, TurningPoint is also 
compatible with course management systems by WebCT 

Tip To retrieve a Participant List after deleting it, 
open the computer’s Recycle Bin and find the 
file. Drag and drop the file from the Recycle Bin 
to a new location. It will not be available to 
TurningPoint unless you import the file. 
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and Blackboard. If you teach at a school or other 
educational institution that uses WebCT or Blackboard 
you can use TurningPoint to transfer classroom 
information between your computer and a server. Varying 
degrees of integration are available for different versions 
of these course management systems.

This section discusses how to connect to Enterprise 
Manager or to a school’s course management system to 
import a Participant List and to export results from a 
session:

• Import a Participant List from Enterprise Manager 
on page 140

• Import a Participant List from a Course 
Management System on page 143

• Export Results Data to a WebCT Server (Campus 
Edition 4.1) on page 148

• Export Results Data to a WebCT Server (Campus 
Edition 6.0 or Vista 3, 4) on page 151

Import a Participant List from Enterprise Manager

Class rosters stored in Enterprise Manager are ready for 
use with TurningPoint 2006. A faculty member using a 
computer on the organization’s network can open 
TurningPoint 2006 and use the Enterprise Manager 
Wizard to import a class roster and use it as a Participant 
List.

On TurningPoint Enterprise Manager, the system is 
designed to work with KeyPads and does not require the 
special setup of WebCT and Blackboard. 

To access TurningPoint Enterprise Manager, you need 
the following information from the technical support staff 
at the school:
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• server name of the Enterprise Manager server 

• your username

• your password

Before You Begin Open TurningPoint 2006 on the computer hosting the 
presentation.

Step by Step Instructions To load a Participant List into TurningPoint 2006…

1 From the TurningPoint 
toolbar, select Tools. 

A menu opens and displays a list of TurningPoint 
tools. The Enterprise Manager option displays at the 
bottom of the list.

2 Select Enterprise Manager > 
Enterprise Manager Log-in.

The Enterprise Manager Log-in window opens.

Enterprise Manager Log-In Window

3 Enter the Server URL, User 
Name, and Password.

The Server URL is the web address where faculty 
members access Enterprise Manager. Faculty 
members enter the user name and password used to 
log into Enterprise Manager.

4 Select the Next button. The Class Select window opens. The drop-down 
menu displays the list of classes assigned to the 
faculty member. A checkbox displays next to Import 
Participant List.



142 Turning Technologies

Chapter 5: How to Track Participants and Teams

Class Select Window

5 Select the class from the 
drop-down menu.

6 Select the Import Participant 
List checkbox.

A checkmark appears in the box when selected.

7 Select the Finish button. Confirmation text displays in orange in the Class 
Select window when the file has been successfully 
imported. The Class Select window closes.

A Save As window opens for saving the Participant 
List on the host computer. In the location field, the file 
is set to be saved in the Participants folder under My 
Documents > TurningPoint. In the File Name field, the 
class name displays with the date and time of the 
import. You may edit the name to be more meaningful. 

Note The Participant List must be saved in the 
Participants folder under My Document > 
TurningPoint on the host computer for 
TurningPoint to find the list.
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8 In the Save As window, 
select the Save button.

A confirmation message displays.

Confirmation Message

9 Select the OK button. The newly imported Participant List displays in the 
Participant List drop-down menu in the TurningPoint 
Toolbar. 

Next Steps Before giving the presentation, select the Participant List 
from the Participant List drop-down menu.

Import a Participant List from a Course Management 
System

TurningPoint can work with WebCT and Blackboard to 
import a Participant List from a server. The following 
steps describe how to connect to WebCT and 
Blackboard from TurningPoint. Before trying to import 
data into TurningPoint, ensure you are set up properly on 
the system’s server. Contact the technical support at the 
school if you need assistance with setup.

Before You Begin On WebCT, the following steps need to occur with 
WebCT before using the WebCT Wizard:

• The system administrator at the institution adds a 
column called “KeyPadID” in WebCT. The instructions 
on how to add a column are found in the System 
Administrator’s Guide: WebCT Campus Edition.

• The instructor creates a class list and includes the 
KeyPad ID field.
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• The students log into WebCT and enter their KeyPad 
ID number twice, the second time to confirm, and then 
enter their contact information. Students receive a 
message that the add was successful and that their 
currently registered device ID is xxxy, etc.

• The instructor can then gather all response device IDs 
from registered students.

To use the WebCT Wizard, you need to obtain the 
following information from the technical support staff at 
the school:

• server name of the WebCT server 

• port number of the WebCT server 

• your username

• your password

On Blackboard, the following steps need to occur with 
Blackboard before using the Blackboard Wizard: 

• The instructor creates a class list and identifies an 
existing column to store the KeyPad ID data. 
(Blackboard does not allow adding a column.)

• The students log into Blackboard and enter their 
KeyPad ID number in the column specified by the 
instructor. Students must reenter their KeyPad ID 
when new classes are added.

• Instructors and students can also download 
information for multiple classes into a zip file and 
choose a location in which to save the file.

To use the Blackboard Wizard, you need to obtain the 
following information from the technical support staff at 
the school:

• server name of the Blackboard server 

• your username

• your password
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Step by Step Instructions To import a Participant List…

1 From the TurningPoint 
toolbar, select Tools. In the 
menu, select WebCT Wizard 
(CE 4.1 or CE 6.0/Vista 3, 4) 
or Blackboard Wizard 
Manager, depending on your 
system.

TurningPoint displays a window to ask you which task 
you would like to perform.

2 Select Import Participant List. WebCT Wizard: Select Task

3 Select the Next button. TurningPoint provides a window for your login 
information. Contact the technical support at the 
school to obtain this information if you do not have it.

Note The illustrations shown in this section are of the 
WebCT CE 4.1 interface, but the interfaces for 
WebCT CE 6.0/Vista 3, 4 and Blackboard are 
similar. 
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4 Enter your login information. WebCT Wizard: Login

TurningPoint saves the Server Name (IP) and the Port 
Number. You must enter your username and 
password for WebCT. The system prompts you for the 
Institution’s name and then displays all courses 
associated with your user name and password.

5 Select the Next button. The next steps differ slightly depending on the type of 
system you have. In WebCt CE 4.1, you indicate the 
course pertaining to the Participant List you want by 
following the instructions in the window. In WebCT CE 
6.0/Vista 3, 4, you select the institution you belong to 
and then the course you wish to import from. In 
Blackboard, you provide the name of the field in the 
Participant List file that holds the KeyPad ID data.
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6 Provide the information 
requested in the window, 
including selecting the course 
containing the data you want 
to import. In Blackboard, 
select the name of the field 
you designated to hold the 
KeyPad ID.

WebCT Wizard: Class Select

Blackboard Wizard: Class Select

Note In Blackboard, a class list is limited to the 
existing columns. When you set up a class 
list, you cannot add a column for KeyPad ID 
numbers. You must use a column that 
already exists but is unused, such as 
Company or Work Fax. Inform students of 
the name of the column you designate for 
KeyPad ID numbers so they enter their data 
correctly.
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7 Select the Finish button. TurningPoint displays a window describing the 
location where the data will be imported to the 
computer and the file name you wish to import. The 
default location is My Documents\TurningPoint\ 
Participants. TurningPoint adds the current date and 
time to the file name.

8 Select the Save button. TurningPoint displays a confirmation message that 
your file has been imported. Optionally, you may edit 
the location or file name, and then select the Save 
button.

9 Select the OK button. The file name displays in the Select a Participant List 
drop-down menu if it is saved in the My Documents\ 
TurningPoint\Participants folder. 

TurningPoint Toolbar: New Participant List

Export Results Data to a WebCT Server (Campus Edition 
4.1)

TurningPoint allows class instructors to quickly export 
results data from participants to an available WebCT 
server. With this function, instructors who test students 
through TurningPoint can easily save participants’ test 
scores for grading purposes. 

Note A Participant List must be saved in My 
Documents\TurningPoint\Participants on the 
computer that runs the presentation session. 
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TurningPoint also lets instructors send grade reports to 
their students via WebCT email. Instructors enter their 
WebCT IDs and select the checkbox to email reports to 
students. Instructors can then view the sent mail and the 
new results that have been posted to the gradebook.

Before You Begin A gradebook, or similar file, should reside on the WebCT 
Server. TurningPoint exports and saves the results data 
to this file. You must know the Column Name in this 
gradebook where the results data should be saved. The 
Column Name may have any title, but you must know the 
exact title and provide it to the WebCT Wizard.

Step by Step Instructions To export results data to a WebCT 4.1 Server…

1 From the TurningPoint 
toolbar, select Tools > 
WebCT Wizard > Campus 
Edition 4.1. 

TurningPoint displays a window asking which task you 
would like to perform with the WebCT Wizard.

2 Select the button next to 
Export Grade Data.

WebCT Wizard: Select Task

3 Select the Next button. TurningPoint displays the WebCT Log-In window.
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4 Enter your login information. WebCT Wizard: Login

TurningPoint saves the Server Name (IP) and the Port 
Number. You must enter your username and 
password. The system prompts you for the 
Institution’s name and then displays all courses 
associated with your user name and password.

5 Select the Next button. TurningPoint displays a window asking you to select 
the class for which you have new data.

6 Select the class to which you 
want to export data. The 
class should match the 
Participant List you used.

WebCT Wizard: Select Class
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7 Enter the Column Name. The Column Name is the title of the column in the 
class gradebook to be used to store the scores for this 
particular activity or test. 

8 Enter the Maximum Value for 
Column.

The Maximum Value for Column is the total possible 
score a participant could achieve for this particular 
activity or test or simply the maximum number of 
characters accepted. 

9 Select the Finish button. TurningPoint displays a confirmation message and 
then closes the WebCT Wizard window. The results 
data should now appear in the column you designated 
in the file on the WebCT server.

Export Results Data to a WebCT Server (Campus Edition 6.0 
or Vista 3, 4)

If you are using WebCT CE 6.0/Vista 3, 4, follow the 
steps below to export results data. The steps outlined in 
this section are similar to the steps outlined in Export 
Results Data to a WebCT Server (Campus Edition 4.1) 
on page 148. Instructors can perform the same functions; 
they can export results data from participants to an 
available WebCT server and send grade reports to their 
students via WebCT email. 

However, with WebCT CE 6.0/Vista 3, 4, instructors may 
select specific sessions to upload and then enter the 
name of the assignment and the maximum point value 
for responses.

Before You Begin A gradebook, or similar file, should reside on the WebCT 
Server. TurningPoint exports and saves the results data 
to this file.
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Step by Step Instructions To export data to a WebCT 6.0/Vista 3, 4 Server…

1 From the TurningPoint 
toolbar, select Tools > 
WebCT Wizard > Campus 
Edition 6.0/Vista 3, 4. 

TurningPoint displays a window asking which task you 
would like to perform with the WebCT Wizard.

2 Select the button next to 
Export Student Data to the 
WebCT Gradebook/Email 
Student Reports.

WebCT Wizard: Select Task

3 Select the Next button. TurningPoint displays the WebCT Log-In window.

4 Enter your login information. WebCT Wizard: Login

TurningPoint saves the Server Name (IP) and the Port 
Number. You must enter your username and 
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password. The system prompts you for the 
Institution’s name and then displays all courses 
associated with your user name and password.

5 Select the Next button. TurningPoint displays a window asking you to select 
the institution you belong to.

6 Select your institution. WebCT Wizard: Select Institution

7 Select the Next button. TurningPoint displays a window asking you to select 
the course to export data to.

8 Select the course you wish to 
export data to.

WebCT Wizard: Select Course

9 Select the Next button. TurningPoint displays a window asking you to select 
the session you wish to upload. 
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10 Select the Session you wish 
to upload.

WebCT Wizard: Select Session

11 Select the Next button. TurningPoint displays an Export Preview/Options 
window asking you to enter the name of the 
assignment for the session and a maximum point 
value. 

12 Enter the name of the 
assignment and a maximum 
point value for responses.

WebCT Wizard: Export Preview/Options

You can also select the checkbox to email 
individualized reports to students through WebCT.
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13 Select the Finish button. TurningPoint displays a confirmation message that 
the export was successfully completed.

14 Select the OK button. WebCT Wizard: Export Complete

You can now login to WebCT and view the results data 
in your Gradebook.

Where Do I Go From Here?
This chapter has demonstrated how to create and 
customize Participant Lists for your presentation.

If you have not set up the hardware devices for 
participants to respond, Chapter 4: How to Set Up 
Response Devices demonstrates this process. You only 
need to set up hardware devices once on the computer 
you will use them with, unless you add or change the 
hardware devices.

If you have already set up hardware devices and have a 
participant list for the audience you will be presenting to, 
you are ready to conduct your presentation! Chapter 6: 
How to Run a Presentation Session demonstrates this 
process.
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Presentation 
Session

After you have created the slides and objects discussed 
in Chapter 3: How to Create Slides, you are ready to run 
an interactive presentation. The process of running a 
presentation requires a few preliminary steps and offers 
some options and tools that this chapter demonstrates 
for you.

Each time you run a presentation, TurningPoint creates a 
unique session. A session is made up of data pertaining 
to the response devices, the participants in the audience, 
and the responses of the participants. This data typically 
saves to the computer that is running the presentation. 
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To run a presentation:

• Establish the settings for gathering and storing 
responses on the computer that runs the presentation. 
The settings are made up of the results data, which 
may need to be reset, the response devices, and the 
Participant List. Optionally, the settings could include 
preferences for the Response Grid, especially if 
infrared keypads are used.

• Run a session. A presentation session feels similar to 
running a typical PowerPoint slide show, but as you 
present, the ShowBar is available at the top of the 
screen during interactive slides. The ShowBar allows 
you to open and close polling, view polling status, and 
view the response data in a variety of ways. 

• Save a session. You can save the results of your 
interactive presentation and generate reports through 
TurningPoint to evaluate the audience’s responses. 
You will want to save the responses provided by your 
audience for each presentation session. 

You can perform test runs or present the completed 
presentation to your audience. Behind the scenes, 
TurningPoint gathers, tallies, and stores the responses 
from your audience. You can choose to share the results 
of the session with the audience or keep them 
confidential.

This chapter describes the following activities to help 
your presentation run smoothly:

• Run an interactive presentation using the Slide Show 
functionality. Find instructions for running a 
presentation in Run a Session on page 161.

• Control the presentation using the ShowBar. Find 
instructions for using the ShowBar in Run the Slide 
Show on page 165 and View Polling Status on 
page 169.
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• Monitor the audience participation. Find instructions 
for monitoring in View Polling Status on page 169 
and Use the Participant Monitor on page 172.

• Save session files for later use. Find instructions for 
saving sessions in Save Results from a Session on 
page 179.
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As depicted in the following diagram, running a 
presentation session is the fourth step when using 
TurningPoint.

Five Steps to Success

*
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Run a Session
You run an interactive presentation session using 
PowerPoint’s Slide Show functionality. 

You control the presentation session by opening and 
closing polling. Polling is the mechanism by which 
TurningPoint accepts and tallies the responses provided 
by the audience using response devices.

Finally, you save the results of the session in a session 
file. The results consist of the responses provided by 
each participant who is in the audience.

Establish the Presentation Settings

The presentation settings consist of the results data and 
Participant List to be used, which are important items to 
check before running the presentation.

Prior to starting a presentation session, you must 
perform the following steps: 

• Clear any previous session results.

• Identify the Participant List to be used.

This section explains how to perform these steps. It also 
demonstrates how to create the settings for the 
Response Grid, an option especially helpful to sessions 
with infrared keypads that gives participants confirmation 
that their responses were received.

Before You Begin A previous chapter discusses the response devices you 
set up before you begin, unless you are in evaluation 
mode, where you only want to author and test a 
presentation. Find information on getting the response 
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devices ready in Chapter 4: How to Set Up Response 
Devices.

If you are using ResponseCard devices or the vPad 
response device software, you must run the Response 
Device Wizard to test TurningPoint’s ability to 
successfully receive the response. Find information on 
the Response Device Wizard in Chapter 4: How to Set 
Up Response Devices. 

If you want to track responses, you must have also 
created a Participant List using the Participant List 
Wizard. Without a Participant List, the session collects 
anonymous responses. Find information on participant 
lists in Chapter 5: How to Track Participants and 
Teams.

Step by Step Instructions To create the settings for the presentation session…

1 From the PowerPoint menu, 
select File > Open.

A window opens and displays the available files.

2 Select the TurningPoint 
presentation to be used, and 
select the Open button.

The file’s contents are visible in the PowerPoint 
window. You can use the TurningPoint toolbar to clear 
any previous results data and identify the use of 
response devices and a Participant List.

3 From the TurningPoint 
toolbar, select Reset > 
Session.

Prior to starting the presentation session, you must 
clear all prior audience responses that are stored in 
memory. 

If you select Reset > All Slides, new data is appended 
to the end of the session without resetting the entire 
session. If you select Reset > Current Slide, you 
remove values for the current slide without removing 
the data from the session.

TurningPoint displays a window instructing you to wait 
until all responses have been cleared before 
continuing with your slide show.
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4 Optionally, from the 
TurningPoint toolbar, select 
the Response Device menu 
and select an option for 
testing the presentation.

Response Devices is the default setting. TurningPoint 
allows you to select how reponses will be provided 
during the presentation. Your choices are:

• Response Devices—a response device will be 
used during the presentation. The response 
devices must have been set up using the Response 
Device Wizard.

• Keyboard Keys 0–9—you will provide input to the 
presentation using the keyboard, keypad, or 
number keys.

• Simulated Data—TurningPoint provides random 
responses to the presentation.

5 From the TurningPoint 
toolbar, select the Select a 
Participant List drop-down 
menu (to the right of the 
Participants drop-down 
menu) and select the 
Participant List to be used.

The default setting is None or Auto. If Auto is selected, 
response device IDs and participants’ choices are 
collected without a participant list. If None is selected, 
only participants’ choices are collected. 

Note Always use the Response Devices default 
setting for an actual presentation. Select 
Keyboard Keys 0-9 or Simulated Data when 
testing a presentation.

Note You can change the default participant list 
setting to to Auto or None using the Default 
Participant setting, a presentation-level 
setting. Find more information on modifying 
settings in TurningPoint Settings on 
page 98.
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6 From the TurningPoint 
toolbar, select the Settings 
icon (Hint: it looks like a pair 
of eyeglasses). In the 
window, select the 
Presentation icon.

The TurningPoint Settings window opens.

Use these settings to establish the settings for the 
entire presentation. You can establish the settings for 
just one slide by selecting the Slide icon. (Find more 
information about modifying settings in TurningPoint 
Settings on page 98.) 

If infrared keypads are used, it is recommended that 
you use a Response Grid, which gives participants 
confirmation that their responses are received. The 
Response Grid is unnecessary with radio frequency 
and vPad devices because confirmation displays right 
on the device. The following settings affect the 
presentation and style of the Response Grid that can 
be shown during an interactive slide show. 

These settings affect what is displayed in each box of 
the Response Grid. The values are True or False.

• Display Device IDs—select True to include the 
deviceID field in the Response Grid.

• Display Participant Names—select True to display 
the participant’s name in the Response Grid.

• Display Device Numbers—select True to display 
the response ID number.

These settings affect how the Response Grid is 
displayed.

Note A Response Grid is specifically 
recommended to use with infrared keypads 
to give participants confirmation that their 
responses are received. Other options for 
tracking responses, such as a Response 
Counter or Response Table, are located in 
the Insert Objects menu. Find information on 
these objects in Add Objects on page 73.
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• Grid Opacity—enter a percentage to identify how 
opaque the Response Grid should be when 
opened.

• Grid Position—choose a selection from the menu to 
identify where the Response Grid should be 
positioned on the screen. The selections include 
Top, Bottom, Left, Right, Center, TopLeft, 
TopRight, BottomLeft, and BottomRight.

• Grid Rotation Interval—enter the number of 
seconds per interval the Response Grid takes to 
rotate through responses, for when there are too 
many participants to fit in one grid.

• Grid Size—identifies how wide and tall the 
Response Grid should be when displayed on the 
Response Grid. The height and width are 
measured in pixels. The default setting is 800 x 600 
(or full screen).

Next Steps After establishing the settings, you are now ready to run 
the presentation.

Run the Slide Show

Use PowerPoint’s Slide Show functionality to run your 
interactive presentation. TurningPoint accepts responses 
provided by your audience, presents the results of the 
responses, and stores the responses in memory. You 
either save the responses to a file or clear the memory.

Before You Begin To run the slide show, you must first perform the steps 
listed under Establish Presentation Settings to create the 
settings for your presentation session.
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Step by Step Instructions To run the interactive presentation…

1 From the PowerPoint menu, 
select Slide Show > View 
Show, or press the F5 key.

The first slide of the presentation is shown. 
TurningPoint displays the ShowBar in the top right 
corner of the screen. The ShowBar is a toolbar that 
provides activation buttons for polling, monitoring, and 
viewing responses during the slide show.

ShowBar

Right-click on the ShowBar and move your cursor 
across the ShowBar to display each command’s 
name. To activate the command, you can select the 
ShowBar icon or use the respective Fn key on your 
keyboard. Use the commands on the ShowBar as 
follows:

F9-Show/Hide 
ShowBar

Closes the ShowBar for the 
duration of the current 
presentation session.

F2-Toggle 
Results

Changes the values displayed on 
each chart. The values can be 
represented as either numbers or 
percents.

F3-Data Slicing Shows the responses on the chart 
for the portion of the audience 
who chose a certain response on 
another question.

F6-Show the 
Original Chart

Use this command after using the 
Toggle Results or Data Slicing 
commands to return the chart to 
its appearance when it was first 
created.
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2 Click the mouse to control the 
progress of the slide show. In 
general, for each slide:

The control of each slide will vary slightly depending 
on the objects you choose to insert when you create 

F4-Repoll 
Question

Clears the responses and accepts 
new responses from the audience 
for the currently displayed 
question. Both the original 
responses and the new responses 
are stored in the session file.

F7-Show the 
Response Grid

Opens a Response Grid on the 
screen allowing you to see which 
participants have responded to 
the question.
The size, location, visual display 
and contents of the grid are 
controlled using the controls in the 
Presentation Settings. Find more 
information about settings in 
Establish the Presentation 
Settings on page 161.

F8-Show Non-
Response Grid

Opens a Response Grid on the 
screen. As each participant 
responds, their response box is 
removed from the grid.

F10-Go to Next 
Slide

Advances the slide show to the 
next slide.

F12-Display 
Participant 
Monitor

Opens the Participant Monitor. 
Find more information in the Using 
the Participant Monitor section.

F5-Insert Slide Opens a drop-down menu 
allowing you to select the slide 
type to be inserted into the 
presentation.

Display 
interactive 
results

Expands the ShowBar to display 
the responses, user responses, 
and polling status. 
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the slides. Find information on slide objects and their 
behavior in Add Objects on page 73.

a Open polling. Polling will 
automatically open when 
you display a slide.

TurningPoint receives responses when polling is 
open.

b Click a second time to 
close polling and display 
the results.

No responses are accepted when polling is closed.

c Click again to advance to 
the next slide.

3 Click at the end of the slides 
to exit from the Slide Show 
(or optionally, press the Esc 
key).

If you exit the program, TurningPoint prompts you to 
name and save the session results to a file. The 
default location is My Documents > TurningPoint > 
Sessions. TurningPoint adds the date and time to the 
file name.

For every session, TurningPoint automatically creates 
a backup copy and stores it at My Documents > 
TurningPoint > Sessions > Backup.

You can set TurningPoint to automatically delete old 
backup sessions using the Backup Maintenance 
setting, a presentation-level setting. In the Backup 
Maintenance field, enter the number of days you want 
to keep files. TurningPoint will eliminate backup 
sessions created before that time. Find more 

Note To advance slides, you may use any method 
PowerPoint allows, such as clicking the mouse 
or pressing the space bar, arrow keys, or Enter 
key.
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information on modifying settings in TurningPoint 
Settings on page 98

View Polling Status

TurningPoint provides three mechanisms to see how 
many participants have responded to the question when 
polling is open. You can expand the ShowBar to see how 
many responses are received. You can display a 
Response Grid. Or, you can open the Participant Monitor 
to see the full details of the audience response.

This section describes using the expanded ShowBar and 
the Response Grid to view participant results. Find more 
information about the Participant Monitor in Use the 
Participant Monitor on page 172.

Step by Step Instructions To view the polling results…

1 On the ShowBar, select 
Display Interactive Results. 

The ShowBar expands to display three additional 
regions that show the polling status. After everyone 

Tip Store your session file in the Sessions folder 
suggested by TurningPoint to allow the session 
file to be used again by TurningPoint to restart 
sessions or generate reports. Find information 
about reports in Types of Reports on 
page 186.
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submits a response, the number in the Responses 
column equals the total number of participants.

ShowBar Expansion

This step may meet all your needs for viewing polling 
status. You also have the option to use the Response 
Grid explained in step 2, especially if you use infrared 
keypads.

i-Display 
interactive 
results

Expands the ShowBar to display the 
responses, user questions, and polling 
regions. The ShowBar also becomes 
fully visible on the slide.

Responses Identifies the number of responses 
received from the audience. This area is 
not visible when the slide show starts.

User 
Feedback

With vPad devices, shows the typed 
questions. With ResponseCards, shows 
the presses of the question mark key.

Polling Identifies whether polling is open or 
closed. The background of this region is 
green when polling is open and red 
when closed. This area is not visible 
when the slide show starts.
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2 Optionally, display a 
Response Grid during the 
session. From the ShowBar, 
select the Show Response 
Grid button.

The Response Grid is a grid that is overlaid on a slide 
during the presentation and indicates which 
individuals enter responses. Similarly, the Non-
Response Grid indicates which participants have yet 
to respond. Specifically helpful to participants using 
infrared devices, these grids give the participants 
confirmation that their responses were received. 
Radio frequency and vPad devices display 
confirmation right on the device.

The Response Grid can be shown or hidden at will by 
selecting the Show Response Grid button. An 
interactive slide displays a Response Grid when the 
question is first presented and automatically removes 
the grid from the slide that shows the tabulated 
results. 

3 After polling closes, click the 
mouse to advance to the next 
slide.

Viewing the polling status becomes disabled in the 
ShowBar until you activate another poll. If you want to 
always display the ShowBar expansion, set the 
Expand Showbar setting to True. Expand Showbar is 
a presentation-level setting. Find more information 

Note A Response Counter or Response Table are 
two other options for viewing polling status that 
can be added when you create the slides, 
before you run the presentation.
The Response Counter shows how many 
participants have responded, while the 
Response Table, which can be fixed or rotating, 
shows who has responded. A fixed table 
displays all the participants, ideal for groups 
with 40 or fewer participants. The rotating table 
is best for very large groups and displays 
participants in sets of 40.
Find information about inserting objects in 
slides in Add Objects on page 73.
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about modifying settings in TurningPoint Settings on 
page 98.

Use the Participant Monitor

The Participant Monitor shows which participants have 
responded to a question and displays details about the 
responses, such as the percentage of correct reponses, 
how long participants took to respond, and which 
answers they picked. Use of the Participant Monitor is 
optional, but it is helpful if you would like to keep track of 
how people are responding during your presentation.

You can access the Participant Monitor from either the 
ShowBar, while the slide show is running, or from the 
TurningPoint toolbar under the Participants drop-down 
menu, after you end the slide show. 

Step by Step Instructions To monitor participants…

1 While running the slide show, 
from the Showbar select the 
Display Participant Monitor 
button.

Alternatively, you can display the Participant monitor 
after running a slide show by selecting Participants > 
Display Participant Monitor from the TurningPoint 
toolbar.

Note If you want to limit the Participant Monitor to 
your eyes only, then you can set up a second 
monitor for displaying it. Find information about 
setting up a second monitor in Windows Help. 
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TurningPoint opens the Participant Monitor window. 
The window displays details about each participant’s 
response and the percentage of correct answers. 

 Regions of the Participant Monitor

 Question region Lists each question and totals the correct 
responses and point values per question. Select a 
question to view details pertaining to it in the 
Individual region.

 Participant region Gives details about the response results for each 
participant for the question selected in the 
Question region.

 Individual region Lists the specific responses chosen by the 
participant selected in the Participant region
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2 You can hide one or more of 
the three regions by selecting 
the close button (X) in the 
upper right corner. To view a 
region you have hidden, 
select it from the View menu 
in the Participant Monitor 
window. 

When viewing the Participant Monitor while running 
the slide show, advancing to the next slide will hide the 
Participant Monitor window. To view the window 
again, press the F12 key. (Alternatively, you can also 
press the Alt + Tab keys, or simply end the slide 
show.)

Add Slides During a Presentation Session

TurningPoint gives you the flexibility of adding an 
interactive slide while running the presentation. Inserting 
a new slide is an option available at your fingertips 
through the ShowBar. 
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Step by Step Instructions To add a slide…

1 Insert a new slide in one of 
the following ways:
• To insert a custom slide, 

select the Insert Slide 
button on the ShowBar.

The Custom Question window opens to display the 
fields for typing the question and answer choices to 
be used on the interactive slide.

 Insert Slide: Custom Question

• To insert a general 
template slide, select the 
arrow next to the Insert 
Slide button on the 
Showbar.

A drop-down menu opens from the ShowBar 
allowing you to select the slide type to be inserted 
into the presentation.
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2 If you chose to create a 
custom slide, type the 
question in the top region of 
the window. Type the answer 
choices in the lower region, 
separating each answer with 
a line break.

Insert Slide: Customized

3 Select the Insert button. A new interactive slide appears, after the slide you 
had been viewing, displaying the new question. 

View Results by Question (Data Slicing)

After receiving response data, TurningPoint can cross-
reference the responses of one question to another set 
of responses. This function, called data slicing, is 
particularly useful for analyzing demographic information. 
For example, you can find out whether a certain age 
group in the audience prefers a certain type of music. By 
asking participants to identify their age group in one 
question, and later asking them to pick their favorite type 
of music, you use data slicing to find out how many 

Note If you would like to reuse the presentation with 
the newly added slide, save the file. From the 
PowerPoint menu, select File > Save As. If you 
forget, TurningPoint asks you before closing.
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young adults in the crowd prefer jazz, how many seniors 
prefer classical music, and so on.

Before You Begin To measure demographic information, insert a question 
slide early in the presentation that asks the audience to 
identify themselves in a demographic category, such as 
an age group or gender.

Step by Step Instructions To use data slicing…

1 Run the presentation. (From 
the PowerPoint menu, select 
View > Slide Show.)

2 Use the arrow keys to go to 
the primary question slide 
whose date you want to slice.

For the example, to find out whether a certain age 
group in the audience prefers a certain type of music, 
you would go to the question slide that asks 
participants to select a favorite type of music. 

3 From the ShowBar, select the 
Data Slicing button.

The Data Slicing window opens and displays a list of 
all question from the interactive slides followed by 
their answers. 

4 Select the answer whose 
data you wish to reference in 
the primary question slide. 

The default selection is the first answer in the first 
question slide. For the example, to find out how many 

Note To use demographic information in reports, 
identify a slide with a demographic question in 
the TurningPoint settings at the slide level. Set 
the Demographic setting to True. Find more 
information in TurningPoint Settings on 
page 98 and Types of Reports on page 186.
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young adults prefer each type of music, you would 
select the 18–35 age range.

Data Slicing

5 Select the Select button. TurningPoint retabulates the data to show the new 
distribution. Instead of viewing the results for the 
entire audience, you see the distribution for only the 
participants in the audience who submitted the 
selected answer. 

After you have displayed a data slice, you can select 
a number on the keyboard corresponding to an 
answer to see the slice associated with that answer. 
You can also cycle through groups that have 
responded by pressing the G key. When finished 
viewing the data slices, press the F6 key to return to 
the original chart.

6 To return the chart to its 
original data, press the F6 
key.
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Manage a Session
With TurningPoint, you can stop and save a session, and 
pick up where you left off at a later time. You can also 
use a TurningPoint setting to create back-up files of your 
session. Knowing how to save, resume, and delete a 
session gives you greater flexibility during your 
presentation.

Save Results from a Session

TurningPoint can quickly save a session so it is available 
for retrieving the results or resuming the session later.

Before You Begin Identify a reliable location on the computer or on a data 
storage device where you would like to save the 
presentation. 

Step by Step Instructions To save a session…

1 From the Slide Show view, 
right-click the screen. Select 
End Show.

TurningPoint concludes the presentation.

2 From the TurningPoint 
toolbar, select the Save 
Session button. (Hint: the 
icon is a disk.)

TurningPoint displays the Save Session window that 
shows the file name, file type, and where the file will 
be saved. The default location is My Documents > 
TurningPoint > Sessions. TurningPoint adds the date 
and time to the file name.

Customize the Save in and the File Name fields to edit 
the location and file name, if you wish to change the 
default settings.
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3 Select the Save button. TurningPoint saves the file in the designated location.

Continue a Previously Saved Session

Pick up where you left off by resuming a saved session.

Before You Begin If the session file is save on an external storage device, 
insert the device into the computer. 

Locate the session you wish to open. On the computer 
that is running the presentation, the default location for 
saved sessions is My Documents\TurningPoint\ 
Sessions. 

Step by Step Instructions To continue a previously saved session…

1 From the TurningPoint 
toolbar, select the Continue 
Prior Session button. (Hint: 
the icon is an open folder.)

TurningPoint displays the Continue Prior Session 
window that shows the file name, file type, and where 
the file is located. The default location is 
My Documents\TurningPoint\Sessions.

Note TurningPoint can save an automatic backup file 
of your session. To enable Real-time Backup, 
navigate to the Settings menu and select 
Presentation in the top row. Then, under 
Backup Settings, set Real-time Backup to True 
and designate a location where the backup file 
should be stored. After you designate the 
location, it will be listed in the Settings menu 
beside Real-time Backup Path...

Note If you did not manually save your last session, 
TurningPoint automatically creates a backup 
copy and stores it at My Documents\ 
TurningPoint\Sessions\Backup.



TurningPoint User Guide 181

Manage a Session

2 Navigate to the file you wish 
to open and select the Open 
button. 

TurningPoint opens the previously saved file.

Next Steps From the PowerPoint menu, select Slide Show > View. 
Use the arrow keys to find the slide you want to be your 
starting point. Continue presenting the session.

Delete Results from a Session

You can use the same presentation to create a new set of 
responses. The Reset menu on the TurningPoint toolbar 
gives you the option of deleting the results in order to 
redo a session or present a new session. You also have 
the option to redo only one question slide in a session. 
You cannot undo the Reset function, so be certain that 
you wish to delete the results.

Before You Begin If you want to view the results at a later time, save the 
presentation before proceeding with the following steps. 

Step by Step Instructions To delete the results from a session or a single slide…

1 Open the presentation. To 
delete the results of one 
question only, the slide with 
this question should be in 
view.

2 From the TurningPoint 
toolbar, select the Reset 
menu.

The Reset menu opens offering the options to reset 
either the entire session or simply the current slide. 

Note Be certain that you wish to delete the results! 
You cannot undo the Reset function for either 
the Session or Current Slide option. 
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3 When you are ready to delete 
the results, select either 
Session or Current Slide. 

Selecting Session resets the entire session. Selecting 
Current Slide resets the currently viewed slide only.

TurningPoint clears the results and sets the values to 
zero.

Where Do I Go From Here?
This chapter has demonstrated how to establish the 
settings, run a presentation session, and save the 
results. After you present a session, you are ready to 
report on the results. 

To understand the details of a running a report, read 
through Types of Reports on page 186. Along with 
discussing how to view reports and manage session 
data, Chapter 7: How to Use Tools also covers 
advanced tools such as adding standards, comparative 
links, and conditional branching to slides.

If you do not want to run a report, you can save your 
session and quit TurningPoint. The final chapters will 
assist you with frequently asked questions.
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TurningPoint offers several tools that allow you to use 
powerful advanced features:

• Create reports of presentation and response data

• Manage session files and extract and export 
information

• Create and assign standards for evaluating 
participants

• Create comparative links for comparing the responses 
from several slides in a single chart in your 
presentation

• Use conditional branching to control the order of slides 
in your presentation based on responses
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The TurningPoint Report Wizard allows you to view, 
export, and print a wide variety of reports based on the 
responses you received during a presentation session. 
The reports are Word or Excel files with information 
about the questions and answers, participants, and 
responses gathered in your presentation. The Report 
Wizard displays a hierarchical menu of reports organized 
by category, such as Results by Question Reports and 
Demographic Reports. If you double-click on one of 
these categories, the Report Wizard screen displays 
subheadings of specific report titles, including Graphical 
Results by Question and Demographic Comparison, and 
also shows samples of each selected report.

Twenty-three reports are available for reporting on the 
entire audience, by individual participants, by groups, by 
standards, and on the basis of demographics. If you have 
specified correct answers or point values, you can 
“grade” participants and groups, verify that standards are 
met, and provide valuable feedback to participants. (Find 
more information on setting correct answers and points 
in Correct Answers and Points on page 66. Find more 
information about creating reports in Types of Reports 
on page 186).

You can also use the Report Wizard to export or extract a 
variety of additional information from session files. Your 
TurningPoint session files contain a great deal of 
information: questions and answers, response data, 
Participant List information, and even the PowerPoint 
slides with all their contents and formatting. You can 
manage and manipulate this information in several ways:

• Export the data in formats you can use in other 
applications

• Merge multiple sessions together
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• Extract the Participant List, PowerPoint presentation, 
or response data

• Make modifications to data, such as excluding a 
question or making a question demographic

• Share session files by email

Find more information in Session Files on page 199. 

The Standards tool enables you to use reports to 
evaluate the performance of participants based on 
standards. You can set up a list of standards, associate 
those standards with questions, and then evaluate the 
performance of the audience as a whole, by groups, or 
by individuals on each standard. Find more information in 
Standards on page 221. 

The Comparative Links and Conditional Branching tools 
allow you to add advanced functionality to your 
presentation. 

The Comparative Links tool is used to compare the 
results from several slides in a single chart in your 
presentation. For example, you might ask several similar 
questions in succession, and then wish to compare the 
responses from each question on a single slide. By 
creating comparative links between the slides, a single 
slide’s chart can show the results from up to three 
additional questions. Find more information in 
Comparative Links on page 226. 

The Conditional Branching tool allows you to control the 
order of slides based on the responses to a question. For 
example, you could have the audience vote on which 
topics to cover in your presentation, or you could 
continue with a different topic when the audience 
demonstrates a sufficient understanding of the current 
one by answering a question correctly. Find more 
information in Conditional Branching on page 229.
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The Tools menu also includes several tools that are 
described in other chapters:

• The TurningPoint Parser, which allows you to 
automatically create presentations from XML or Word 
documents. Find more information in Import Third-
Party Slides on page 88.

• The Ranking Wizard, which allows you to create slides 
to rank items on several criteria. Find more 
information in Ranking Wizard on page 91.

• The WebCT Wizard, which allows you to import 
Participant List information from WebCT. Find more 
information in Import and Export Participant Data on 
page 139.

Types of Reports
The reports you can create from your TurningPoint 
session data are described in the following sections:

• The Results by Question reports (2 reports), which 
show a summary of responses for each question, on 
page 188.

• Demographic reports (2 reports), which show a 
summary of responses for each question broken down 
by demographic groups, on page 188.

• The Participant Results reports (3 reports), which 
show each participant’s responses, on page 190.

• The Results by Participant reports (3 reports), which 
show a summary of responses for each question for 
each individual participant, on page 190.
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• The Participant List reports (2 reports), which show 
the participant data from the Participant List, on 
page 190.

• Standards reports (3 reports), which show response 
information based on standards identified for each 
question, on page 191.

• Other reports (8 reports), which include the following:

• Attendance reports track participants’ attendance 
for each session, on page 192.

• Individual scoring reports show correct answers 
and scoring percentages for each participant, as 
well as class averages, on page 192.

• Ranking and Moment to Moment reports give the 
results of ranking or moment to moment slides, on 
page 193.

• Outline reports give an outline of slide questions 
and answers, on page 193.

• Participant Questions and Comments reports show 
questions and comments sent by vPad participants 
during the presentation, on page 193.

• Response Data Export reports give the raw 
response data, on page 194.

• Results by Group reports show a summary of 
correct responses for each question by 
demographic groups, on page 194.

Find instructions for generating these reports in View a 
Report on page 194.
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Results by Question Reports
The Results by Question and Graphical Results by 
Question reports show a summary of responses for each 
question. Each of these reports creates an Excel file.

The reports include the following information for each 
question:

• the answers

• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

Additionally, the Graphical Results by Question report 
shows a pie chart of the responses for each answer.

Demographic Reports
The Demographic Comparison and Graphical 
Comparison reports show a summary of responses for 
each question broken down by demographic groups. 
Each of these reports creates an Excel file.

The Demographic Comparison includes the following 
information for each question:

• the answers

• the number of responses for each answer from each 
group

• the total number of responses from each group

The Graphical Comparison includes the following 
information for each question:

• the answers

• an indication of the correct answer(s)
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• the percentage of responses for each answer from 
each group

• a vertical bar chart of the responses for each answer 
from each group

When generating the Graphical Comparison report, you 
have the option of creating page breaks between each 
question.

Participant Results Reports
The Participant Results, Graded Participant Results 
(correct/incorrect), and Graded Participant Results (point 
values) reports show each participant’s responses in an 
Excel file.

Each report includes the following information for each 
participant:

• device number and location

• first and last name (if specified in the Participant List)

• the numerical value of the participant’s response to 
each question

Additionally, the graded reports show the following:

• an indication of whether the response is correct or 
incorrect

• total percent correct (for the correct/incorrect version 
of the report) or total number of points (for the point 
values version of the report)
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Results by Participant Reports
The Results by Participant report shows a summary of 
responses for each question for each individual 
participant. This report creates an Excel file.

The report includes the following information for each 
participant for each question:

• the question

• the numerical value of the participant’s response

• an indication of whether the response is correct or 
incorrect

• the correct answer

When generating these reports, you have the option of 
creating page breaks between each participant’s section.

Also included in the ‘Results by Participant’ category are 
the following two reports: 

The Answer Detail report includes a complete list of 
answers for each question. This list enables you to match 
the numerical value of the participant’s response 
(number 1 or 2, etc.) to the actual answer (e.g. yes or 
no). This report also shows whether responses are 
correct or incorrect by marking them with a ‘c’ or an ‘i.’

The Response Detail report includes the question along 
with the participant’s response. This report displays 
correct answers in green and incorrect answers in red 
and calculates the percentage of correct answers and 
the total points accumulated by each participant.

Participant List Reports
The Participant List reports show the participant data 
from the Participant List in either a Word file or an Excel 
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file. The report shows device number and location and 
any of the fields defined in the Participant List (name, 
contact information, demographic groups or teams, etc.).

Additionally, the Attendance Report, found under the 
Other Reports category, provides basic participant 
information, including name and device number, and 
shows which students have attended class for the day. 
Find more information about the Attendance Report on 
page 192.

Standards Reports
The Overall Standards, Individual Standards, and Group 
Standards reports show response information based on 
standards identified for each question. These reports 
create Excel files.

The Overall Standard report is very similar to the Results 
by Question report but includes additional information 
relating to standards. It includes the following information 
for each standard:

• the overall percentage of correct responses for all 
questions that are associated with the standard

• the questions associated with the standard

• the answers for each question

• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

The Individual Standards report includes the following 
information for each individual participant for each 
standard:

• the participant’s percentage of correct responses for 
all questions that are associated with the standard
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• the questions associated with the standard

• the answers for each question

• an indication of the correct answer(s)

• an indication of the participant’s response and 
whether it was correct

When generating the Individual Standards report, you 
have the option of creating page breaks between each 
participant’s section.

The Group Standards report displays the percentage of 
correct responses from each group for each standard.

Attendance Reports
The Attendance Report, found under the Other Reports 
category, provides basic participant information, 
including name and device ID, and shows which students 
have attended class for the day. 

Individual Scoring Reports
The Individual Scoring Report, found under the Other 
Reports category, provides scoring information for each 
participant, including numeric responses labeled correct 
or incorrect and percent scores. This report also shows 
whether the participant’s score puts him/her above or 
below the class average. 
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Ranking and Moment to Moment 
Reports
The Ranking and Moment to Moment reports, found 
under the Other Reports category, show a summary of 
ranking or moment to moment slides, respectively. Each 
of these reports creates an Excel file.

The Ranking report includes the following information:

• a list of the ranking criteria

• a list of the ranked items and the rank assigned for 
each criterion

• the chart showing the ranking

The Moment to Moment report includes the chart 
showing the moment to moment rating results.

Outline Report
The Outline report gives an outline of slide questions and 
answers in a Word file. The outline include an indication 
of the correct answer(s). This report is found under the 
Other Reports category.

Participant Questions and 
Comments Report
The Participant Questions and Comments report, found 
in the Other Reports category, shows any comments or 
questions sent by vPad participants during the 
presentation. This report creates an Excel file.
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Response Data Export Report
The Response Data Export report, found in the Other 
Reports category, gives the raw response data in an 
Excel file. It creates a table of values in Excel giving the 
numerical response values for each device number.

Results by Group Report
The Results by Group report, found in the Other Reports 
category, shows a summary of correct responses for 
each question by demographic groups. This report 
creates an Excel file.

The report includes the following information for each 
question:

• the answers

• an indication of the correct answer(s)

• the percentage of correct responses from each 
demographic group

View a Report

You can create reports using the Report Wizard, 
available in the Tools menu in the TurningPoint toolbar.

Before You Begin Create a session file by running a presentation session 
and saving the file. Find more information in Chapter 6: 
How to Run a Presentation Session.

Step by Step Instructions To view a report…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.
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2 Select Turning Reports from 
the Tools menu.

The Report Wizard window opens, displaying a list of 
options for using the data in session files.

3 Select Generate Reports 
from the list of options.

4 Select the Next button to 
continue.

The Report Wizard window displays a list of the 
session files in your Sessions folder.

Report Wizard: Select Session

You can toggle which files are displayed in the list by 
selecting My Session Files or My Backup Session 
Files. Find more information about where your session 
files are stored in Save Results from a Session on 
page 179.

You can also import a session using the Import 
Session button above the list of files (shaped like a 
folder). This allows you to use a session file you have 
copied from elsewhere.
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5 Choose a session file in one 
of the following ways:
• Select the Use Current 

Session check box to use 
the session currently open 
in PowerPoint.

This option is available only if you have a 
TurningPoint presentation open and response data 
has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions 
folder in the list of files, select My Session Files.

• Select a session file from 
your backup session files.

To display the backup session files in the list of 
files, select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog 
to locate and select the session file.
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6 Select the Next button once 
you have selected a session 
file.

The Report Wizard window displays a list of the 
categories of reports you can generate from your 
session file.

Report Wizard: Generate Reports

Each category of report is listed by name. You can 
double-click the category or click on the plus sign 
beside the category to view a list of reports in each 
category. The icon beside the report name indicates 
whether it generates an Excel file or a Word file. Some 
reports are available in both forms.

When you select a report, you can see a sample 
preview of the report on the right-hand side of the 
Reports Wizard window.



198 Turning Technologies

Chapter 7: How to Use Tools

7 Select the type of report(s) 
you would like to generate by 
selecting the check box next 
to the report name.

Find more information in Types of Reports on 
page 186.

You can select multiple report by selecting multiple 
check boxes. You can also select an entire category 
of reports by selecting the check box for the category.

Depending on the type of report you select, the 
Include Page Breaks check box may be displayed 
below the report preview.

8 Specify whether to include 
page breaks in the report by 
checking the Insert Page 
Breaks check box (if 
available).

If you check the box, TurningPoint will create page 
breaks at convenient places in the report for ease of 
printing.

9 Select the Generate Report 
button.

TurningPoint creates the report and opens it in 
Microsoft Excel or Word.

This may take some time, especially if there are a 
large number of questions or participants in the 
session.

You can generate as many reports as you like. When 
one report is finished being created, select another 
type of report from the list and select the Generate 
Report button again.

10 When you are finished 
creating reports, select the 
Finish button to close the 
Report Wizard.

Next Steps You can use Excel or Word to edit, save, or print the 
reports.
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Session Files
When you complete a session, you save the data in a 
TurningPoint session file (extension .tpz). Find more 
information on how to save a session in Save Results 
from a Session on page 179.

The session file contains all the information about your 
presentation, including the questions and answers, the 
response data, and the Participant List. This information 
is used to generate reports (find more information in 
Types of Reports on page 186). You can also do the 
following:

• Export session data to a text file. Find more 
information in Export Session Data on page 200.

• Merge two session files. Find more information in 
Merge Session Files on page 210.

• Extract the Participant List. Find more information in 
Extract Participant List on page 212.

• Extract the PowerPoint presentation. Find more 
information in Extract PowerPoint Presentation on 
page 213.

• Extract the session data as an XML file. Find more 
information in Extract Session Data as XML on 
page 215.

• Email the session using Outlook. Find more 
information in Email Session using Outlook on 
page 216.

• Make edits to the session data. Find more information 
in Edit Session Data on page 219.
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Export Session Data

You can export the data from a session file into a text file. 
You can use the text file to import the data into a variety 
of other applications.

You can choose to export the data from the session file in 
one of two ways:

• Export some or all of the session data to a text file 
where you determine the contents and format.

• Export the session data using a predefined scheme 
for certain gradebook applications.

Step by Step Instructions To export session data into a text file…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Turning Reports from 
the Tools menu.

The Report Wizard window opens, displaying a list of 
options for using the data in session files.

3 Select Export Session Data 
from the list of options.

4 Select the Next button to 
continue.

The Report Wizard window displays a list of the 
session files in your Sessions folder.

You can toggle which files are displayed in the list by 
selecting My Session Files or My Backup Session 
Files. Find more information about where your session 
files are stored in Save Results from a Session on 
page 179.

You can also import a session using the Import 
Session button above the list of files (shaped like a 
folder). This allows you to use a session file you have 
copied from elsewhere.
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5 Choose a session file in one 
of the following ways:
• Select the Use Current 

Session check box to use 
the session currently open 
in PowerPoint.

This option is available only if you have a 
TurningPoint presentation open and response data 
has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions 
folder in the list of files, select My Session Files.

• Select a session file from 
your backup session files.

To display the backup session files in the list of 
files, select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog 
to locate and select the session file.

6 Select the Next button once 
you have selected a session 
file.

The Report Wizard window displays lists of the data 
and formats you can use to export the session file.

Report Wizard: Select Export Scheme or Data Groups
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7 Choose one of these two 
ways to export the data:
• Check some or all of the 

boxes in the Data Group 
list to manually specify the 
contents and format of the 
exported text file.

The following data is available for export:

• The text of questions and answers.

• Participant information, such as names and 
groups, defined in the Participant List.

• Participant’s responses to the questions.

• Participant’s scores.
• Check the Use Export 

Schemes box to select a 
pre-defined export scheme 
for a gradebook 
application from the Export 
Schemes list.

Export schemes for several gradebook applications 
are available, including Angel, Easy Grade Pro, 
Gradebook for Windows, Gradekeeper for 
Windows, GradeQuick, MicroGrade, and Teacher’s 
Marksheet.

Export schemes are saved as .tpx files in the Export 
Schemes folder, which is located in your 
TurningPoint folder. You can use an export scheme 
you have copied from elsewhere by selecting the 
Load an Export Scheme button (shaped like a 
folder).

Using an export scheme automatically specifies the 
settings available to you in the next steps to match 
the format required by the application you are 
exporting to. You may still choose to modify some 
settings, to specify a grading scale, for example.
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8 Select the Next button to 
continue.

The Report Wizard window displays a tabbed view for 
you to specify the data to be used.

Report Wizard: Include or Exclude Data—
Questions & Answers tab

There are four tabs, one for each of the main groups 
of data you specified whether to include in the 
exported file. In each area you chose to include, you 
should review and modify the settings on the 
corresponding tab. The next few steps explain the 
settings on each tab.

9 If you chose to include the 
question and answer data, 
specify which particular 
questions to include by 
checking the boxes on the 
Questions & Answers tab.

By default, all questions are checked and will be 
included.
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10 Select the Responses tab. The Report Wizard Window displays the Responses 
tab.

Report Wizard: Include or Exclude Data—
Responses tab

11 If you chose to include the 
responses, choose whether 
to group responses by 
question or by participant by 
selecting Show Responses 
Horizontally or Show 
Responses Vertically on the 
Responses tab.

Show Responses Horizontally will group the response 
data by question in the exported file. Show Responses 
Vertically will group the response data by participant 
in the exported file.
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12 Select the Participant Info 
tab.

The Report Wizard Window displays the Participant 
Info tab.

Report Wizard: Include or Exclude Data—
Participant Info tab

13 If you chose to include the 
participant information, 
choose which fields from the 
Participant List to include by 
checking the boxes on the 
Participant Info tab.

To view the information from the Participant List, press 
the F5 key or right-click in the window and select 
Refresh Participant List Data. This allows you to see 
the Participant List to help you decide which fields you 
would like to include in the exported data.

You can include the following participant information: 

• Location

• Device #

• Last and first names

• Device ID

• Student ID
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14 Select the Scores tab. The Report Wizard Window displays the Scores tab.

Report Wizard: Include or Exclude Data—
Scores tab

15 If you chose to include the 
scores, specify the following 
settings:
• Select whether to calculate 

scores based on 
Correct/Incorrect values or 
based on point values.

If you base scores on Correct/Incorrect values, the 
percentage score is calculated by dividing the 
participant’s number of correct answers by the 
number of total answers. If you base scores on 
point values, the percentage score is calculated by 
dividing the participant’s number of correct answers 
by the point value you specify in the box provided.

• Select to show scores as 
percentages, as letter 
grades, as point values, or 
any combination by 
checking the boxes.

You may include any or all of these ways of 
representing the scores in the exported file.

• Specify the grading scale 
by selecting ranges for the 
letter grades from the 
drop-down menus.

The default ranges show a typical grading scale. 
You can alter the grading scale by selecting a new 
range. To change values upward (grade on a 
stricter scale), start from A and work your way down 
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the list to specify the ranges. To change values 
downward (grade on an easier scale), start from D 
and work your way up the list.

• Designate questions as 
bonus questions (not to be 
included in the score 
totals) by checking the 
boxes.

Questions you designate as bonus questions are 
not included in the total number of questions for 
calculating scores, but are included in a 
participant’s number correct.

16 When you have finished 
modifying the settings on the 
applicable tabs, select the 
Next button.

The Report Wizard window displays a set of settings 
for specifying the format of the exported file.

Report Wizard: Select Format

There is an example entry at the bottom of the window 
showing a sample based on the settings specified. 
Observe this example as you change the format 
settings in the next few steps to ensure it matches 
your expectations.
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17 Specify the order of the fields 
in the exported file by moving 
the fields up and down the list 
by selecting the Move Up and 
Move Down buttons.

Additionally, you can join two fields together or include 
blank fields in the exported file. Use the Insert A Blank 
Field and Insert a Join Field buttons below the list of 
fields to insert a join field or a blank field. You can 
move join fields and blank fields up and down the list 
just like the other fields.

A join field joins the previous field and the following 
field into a single field. You might wish to do this with 
the First Name and Last Name fields, for example.

A blank field simply puts a blank separator between 
fields. Depending on how you will use the exported 
file, you may need to separate some data with blank 
fields.

18 Specify whether to create a 
delimited or fixed-width file.

A delimited file includes a “delimiter” between each of 
the fields. You can select a comma, semicolon, tab, 
space, or other delimiter.

A fixed-width file uses fields of a specified width 
(number of characters). You can choose a width for 
the fields.

The format you choose depends on how you will use 
the exported file.

19 Specify whether to use 
double quotes, single quotes, 
or no quotes to enclose the 
text in fields.

Note You should use either double or single 
quotes for the text qualifier if you are 
exporting a fixed-width file or using spaces 
as delimiters in a delimited file. Without 
quotes, the field boundaries in the exported 
file will be impossible to interpret correctly.
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20 When you have finished 
modifying the settings for the 
format of the file, select the 
Next button.

The Report Wizard window displays the data in the 
format to be exported.

Report Wizard: Verification

Below the data are two buttons. The first, shaped like 
a document and a disk, saves the export file. The 
second, shaped like a disk, saves the format as an 
export scheme you can reuse for other session files.

21 To save your export data, 
select the Save button 
(shaped like a document with 
a disk).

A dialog opens for you to specify a location and 
filename for the exported file.

22 Specify a name and location 
for the exported file.

23 Select the Save button. The file is saved and the dialog closes.

Optionally, you can also select the Save Export 
Scheme button (shaped like a disk) to create an 
export scheme you can reuse to save the data from 
other session files in the same format. Specify a 
location and filename for the export scheme in the 
same way.
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24 Select the Finish button to 
exit the Report Wizard.

If you forgot to save before selecting Finish, a 
message window opens containing ‘Are you sure you 
want to exit without saving an export?’ Select Yes to 
exit without saving the session file; select No to save 
before exiting.

Merge Session Files

You can merge multiple session files together to create a 
single session file, from which you can generate reports 
and extract data.

This is especially useful if you have session files from 
multiple presentations given to the same participants. 
You can aggregate the data from all the presentations 
into a single file with all the responses from each 
participant.

Conversely, if you gave the same presentation to several 
groups of participants, you could aggregate the 
responses from all participants into a single session file.

Before You Begin All the session files you wish to merge must be in a 
single location (usually your Sessions folder). If the 
session files are in different locations, move them all to 
your Sessions folder before you begin.

Step by Step Instructions To merge session files…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Turning Reports from 
the Tools menu.

The Report Wizard window opens, displaying a list of 
options for using the data in session files.
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3 Select Merge Session Files 
from the list of options.

4 Select the Next button to 
continue.

The Report Wizard window displays a list of the 
session files in your Sessions folder.

You can toggle which files are displayed in the list by 
selecting My Session Files or My Backup Session 
Files. Find more information about where your session 
files are stored in Save Results from a Session on 
page 179.

5 Select one of the session files 
to be merged in the list.

6 Select additional files to be 
merged in the list by holding 
down the Control key and 
clicking on the files.

Repeat this step until all the files you would like to 
merge are selected.

7 Optionally, check the box to 
include the PowerPoint 
presentations in the merged 
session file.

If you include the presentations in the merged session 
file, the slides from the presentations of each of the 
merged files are put together into a single 
presentation saved in the merged session file. This 
may greatly increase the size of the merged session 
file.

8 Select the Merge button 
below the list of files.

A dialog opens for you to specify a location and 
filename for the merged session file.

9 Specify a name and location 
for the exported file.

10 Select the Save button. The file is saved and the dialog closes.

11 Select the Finish button to 
exit the Report Wizard.

Note You should use the file extension .tpz for 
session files.
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Next Steps You can now generate reports or extract other data from 
the merged session file, just as if it were an original 
session file.

Extract Participant List

You can extract the Participant List from a session file. 
This is especially useful if you have a session file but 
have lost the Participant List file or if you set up the list on 
a different computer.

Step by Step Instructions To extract a Participant List…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Turning Reports from 
the Tools menu.

The Report Wizard window opens, displaying a list of 
options for using the data in session files.

3 Select Extract Participant List 
from the list of options.

4 Select the Next button to 
continue.

The Report Wizard window displays a list of the 
session files in your Sessions folder.

You can toggle which files are displayed in the list by 
selecting My Session Files or My Backup Session 
Files. Find more information about where your session 
files are stored in Save Results from a Session on 
page 179.

You can also import a session using the Import 
Session button above the list of files (shaped like a 
folder). This allows you to use a session file you have 
copied from elsewhere.
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5 Choose a session file in one 
of the following ways:
• Select a session file from 

the list of files in your 
Sessions folder.

• Select a session file from 
your backup session files.

To display the backup session files in the list of 
files, select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog 
to locate and select the session file.

6 Select the Extract Participant 
List button below the list of 
files.

A dialog opens for you to specify a location and 
filename for the Participant List file.

7 Specify a name and location 
for the exported file. 

8 Select the Save button. The file is saved and the dialog closes.

9 Select the Finish button to 
exit the Report Wizard.

Next Steps You can now edit the Participant List or use it in a 
presentation. Find more information in Chapter 5: How 
to Track Participants and Teams.

Extract PowerPoint Presentation

You can extract the PowerPoint presentation from a 
session file. This is especially useful if you have a 
session file but have lost the corresponding PowerPoint 
presentation or if you created the presentation on a 
different computer.

Note You should use the file extension .tpp for 
Participant List files.
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Step by Step Instructions To extract a PowerPoint presentation…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Turning Reports from 
the Tools menu.

The Report Wizard window opens, displaying a list of 
options for using the data in session files.

3 Select Extract PowerPoint 
Presentations from the list of 
options.

4 Select the Next button to 
continue.

The Report Wizard window displays a list of the 
session files in your Sessions folder.

You can toggle which files are displayed in the list by 
selecting My Session Files or My Backup Session 
Files. Find more information about where your session 
files are stored in Save Results from a Session on 
page 179.

You can also import a session using the Import 
Session button above the list of files (shaped like a 
folder). This allows you to use a session file you have 
copied from elsewhere.

5 Choose a session file in one 
of the following ways:
• Select a session file from 

the list of files in your 
Sessions folder.

• Select a session file from 
your backup session files.

To display the backup session files in the list of 
files, select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog 
to locate and select the session file.

6 Select the Extract 
PowerPoint Presentation 
button below the list of files.

A dialog opens for you to specify a location and 
filename for the PowerPoint presentation.
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7 Specify a name and location 
for the exported file. 

8 Select the Save button. The file is saved and the dialog closes.

9 Select the Finish button to 
exit the Report Wizard.

Extract Session Data as XML

You can extract the session data into an XML file. The 
XML file is a text markup format that you can use to 
exchange and manipulate the data.

Step by Step Instructions To extract the session data XML file…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Turning Reports from 
the Tools menu.

The Report Wizard window opens, displaying a list of 
options for using the data in session files.

3 Select Extract Session XML 
file from the list of options.

4 Select the Next button to 
continue.

The Report Wizard window displays a list of the 
session files in your Sessions folder.

You can toggle which files are displayed in the list by 
selecting My Session Files or My Backup Session 
Files. Find more information about where your session 
files are stored in Save Results from a Session on 
page 179.

You can also import a session using the Import 
Session button above the list of files (shaped like a 
folder). This allows you to use a session file you have 
copied from elsewhere.

Note You should use the file extension .ppt for 
PowerPoint presentations.
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5 Choose a session file in one 
of the following ways:
• Select a session file from 

the list of files in your 
Sessions folder.

• Select a session file from 
your backup session files.

To display the backup session files in the list of 
files, select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog 
to locate and select the session file.

6 Select the Extract Session 
XML File button below the list 
of files.

A dialog opens for you to specify a location and 
filename for the XML file.

7 Specify a name and location 
for the exported file. 

8 Select the Save button. The file is saved and the dialog closes.

9 Select the Finish button to 
exit the Report Wizard.

Email Session using Outlook

You can use the Report Wizard to quickly and easily 
send one or more session files by email using Microsoft 
Outlook.

Before You Begin To use this feature, you must have Microsoft Outlook 
installed and set up on your computer.

Step by Step Instructions To email a session file using Outlook…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Turning Reports from 
the Tools menu.

The Report Wizard window opens, displaying a list of 
options for using the data in session files.
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3 Select Send Sessions Using 
Outlooks from the list of 
options.

4 Select the Next button to 
continue.

The Report Wizard window displays a list of the 
session files in your Sessions folder.

You can toggle which files are displayed in the list by 
selecting My Session Files or My Backup Session 
Files. Find more information about where your session 
files are stored in Save Results from a Session on 
page 179.

You can also import a session using the Import 
Session button above the list of files (shaped like a 
folder). This allows you to use a session file you have 
copied from elsewhere.

5 Choose a session file in one 
of the following ways:
• Select a session file from 

the list of files in your 
Sessions folder.

You may select multiple files by holding down the 
Control key and clicking on the file.

• Select a session file from 
your backup session files.

To display the backup session files in the list of 
files, select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog 
to locate and select the session file.
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6 When you have selected all 
the files you would like to 
send, select the Next button 
to continue.

The Report Wizard window displays the next page, 
allowing you to specify the recipient(s) and send the 
email.

Report Wizard: Send Session using Outlook

7 Enter the email address you 
want to send the session 
file(s) to in the box provided.

You may enter more than one email address. 
Separate multiple email addresses by semicolons.

8 Specify whether you would 
like to add a message to the 
email by checking the box.

If you choose not to add a message, the body of the 
email will be left blank.

9 Select the Send File(s) 
button.

If you chose not to add a message, the email is sent 
and a dialog is displayed indicating that the email was 
successfully sent.

If you chose to add a message, a new email message 
is opened in Outlook, addressed to the recipients you 
specified and with the session file(s) attached. Type a 
message in the body of the email and send it as you 
normally would.

10 Select the Finish button to 
exit the Report Wizard.
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Edit Session Data

You can edit session data after the session is saved. You 
can choose to exclude a question, make a question 
demographic, or change answer values.

Step by Step Instructions To edit session data…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Turning Reports from 
the Tools menu.

The Report Wizard window opens, displaying a list of 
options for using the data in session files.

3 Select Edit Session from the 
list of options.

4 Select the Next button to 
continue.

The Report Wizard window displays a list of the 
session files in your Sessions folder.

You can toggle which files are displayed in the list by 
selecting My Session Files or My Backup Session 
Files. Find more information about where your session 
files are stored in Save Results from a Session on 
page 179.

You can also import a session using the Import 
Session button above the list of files (shaped like a 
folder). This allows you to use a session file you have 
copied from elsewhere.

5 Choose a session file in one 
of the following ways:
• Select a session file from 

the list of files in your 
Sessions folder.

• Select a session file from 
your backup session files.

To display the backup session files in the list of 
files, select My Backup Session Files.



220 Turning Technologies

Chapter 7: How to Use Tools

• Import a session file from 
another location.

Use the Import Session button to open a file dialog 
to locate and select the session file.

6 Select the Next button to 
continue.

The Report Wizard window displays options for editing 
the session file.

Report Wizard: Edit Session

The window shows a list of all questions in the 
session. Below the list of question is a list of answers, 
which shows the answers for the question selected in 
the list above.

7 Uncheck the box next to any 
question in the list that you 
would like to exclude from the 
session.

Excluding a question will omit all data about that 
question from the session file.

8 If you would like to designate 
a question as demographic, 
right-click on the question 
and select the option to make 
the question demographic 
from the contextual menu 
that appears.

Demographic questions can be used in reports. Find 
more information in Types of Reports on page 186.
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9 If you would like to change an 
answer value, right-click on 
the answer in the answer list 
and select an option from the 
contextual menu that 
appears.

You can mark the answer Correct or Incorrect, assign 
a point value, or clear the answer value (set to No 
Value). Find more information in Correct Answers 
and Points on page 66.

10 When you are finished 
making changes to the 
session data, select the Save 
Session button below the list 
of answers.

A dialog opens for you to specify a location and 
filename for the session file.

11 Specify a name and location 
for the exported file. 

12 Select the Save button. The file is saved and the dialog closes.

13 Select the Finish button to 
exit the Report Wizard.

Standards
TurningPoint’s standards tools allow you to create lists of 
standards on which participants can be evaluated. For 
training, teaching, or testing, standards help you 
organize the material in your presentation into subject 
areas, competencies, or other standards which the 
participants should meet. You can then view participants’ 
results by standards using TurningPoint reports. Find 
more information in Types of Reports on page 186.

Note You should use the file extension .tpz for 
session files.
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Create a Standards List

Before you can assign standards to slides in a 
presentation, you need to create a list of the standards 
you will be using.

Step by Step Instructions To create a Standards List…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Standards from the 
Tools menu.

The Standards window opens.

Standards window

The Current Standards List drop-down menu displays 
the selected Standards list. If you select the menu, it 
displays all the Standards Lists in your Standards 
folder for you to choose from. The New button allows 
you to create a new Standards List in your Standards 
folder. The Load button allows you to import a 
Standards List to your Standards folder from 
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elsewhere. The Delete button allows you to delete a 
Standards List from your Standards folder.

3 Select the New button. TurningPoint prompts you to enter a new name for the 
Standards List.

4 Enter a name in the box 
provided and select the OK 
button.

TurningPoint creates the Standards List in your 
Standards folder, selects it in the Current Standards 
List drop-down menu, and displays the new Standards 
List in the left-hand pane of the Standards Window.

The new Standards List has a top-level category with 
the same name as the list.

5 To add a category or a 
standard, complete the 
following steps.
a Select the parent category 

in which to include the 
category or standard you 
wish you add.

Categories arrange standards into a hierarchy.

b Select the Add Category or 
Add Standard button.

TurningPoint prompts you to enter a title for the 
category or standard.

c Enter a title in the box 
provided and select the 
OK button.

TurningPoint adds the category or standard to the 
parent category you selected.

d Repeat steps a–c until you 
have added all the 
categories and standards 
you need.

You can delete a category or standard from the list 
using the Remove button. You can change the title 
of a category or standard using the Edit Field 
button.

6 When you are finished 
creating your Standards List, 
select the Done button.

TurningPoint indicates that you have made changes 
to the Standards List and asks if you would like to save 
your changes.

7 Select the Yes button. The changes are saved to your Standards List file and 
the Standards window closes.
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Next Steps To associate standards with slides, follow the instructions 
in the next section, Assign Standards to Slides.

Assign Standards to Slides

Assigning standards to slides allows you to use 
TurningPoint reports to assess participants’ performance 
on slides relating to the standards.

Before You Begin You should create or obtain Standards Lists to be 
assigned to the slides. Find more information in Create a 
Standards List on page 222.

Step by Step Instructions To assign standards to slides…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Standards from the 
Tools menu.

The Standards window opens.

Standards window
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3 Select a slide to assign a 
standard to using the Current 
Selection drop-down menu.

Alternatively, you can select Presentation in this menu 
to assign the standard to the entire presentation.

4 Select a Standards List in 
one of the following ways:
a Select a Standards List 

from the Standards folder 
using the Current 
Standards List drop-down 
menu.

The categories and standards are displayed in the 
left-hand pane of the Standards window.

b Select a Standards List 
from elsewhere using the 
Load button.

The Standards List file is copied to your Standards 
folder and the categories and standards are 
displayed in the left-hand pane of the Standards 
window.

5 Select a standard from the 
list.

6 Select the right arrow button 
(>) to assign the standard to 
the slide.

The standard is displayed in the list of standards 
applying to the current selection in the right-hand pane 
of the Standards window.

You can remove a standard using the left arrow button 
(<).

7 Repeat these steps 
beginning with step 3 to add 
standards to additional 
slides.

You can assign multiple standards to each slide. You 
can also use multiple Standards Lists.

If you would like to start over, you can select the Clear 
All button to clear all standards from all slides in the 
presentation.
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8 When you are finished 
assigning standards to your 
slides, select the Done 
button.

Next Steps Several reports allow you to assess participants’ 
performance on the standards you assigned. Find more 
information in Types of Reports on page 186.

Comparative Links
You can use comparative links to compare the responses 
from several slides on a single slide’s chart.

This is a sample chart comparing the responses from 
three slides.

Chart with Comparative Links

The bars are grouped by answer. Each answer’s bars 
include the results for the current slide at the left (or top, 
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depending on the chart type), then the results for each 
linked slide in the order that the links are assigned.

A slide can contain up to three comparative links, so you 
can compare up to four questions. Generally, each 
question you compare should have the same number of 
answers, since the first answer in the answer region is 
compared to the first answers on the linked slides, the 
second answer to the second answers on the linked 
slides, and so on.

Set Up Comparative Links

Set up comparative links using the Comparative Links 
window, available from the Tools menu in the 
TurningPoint toolbar.

Before You Begin Before you set up a comparative link, first create the 
slides you would like to be compared. A slide can contain 
one to three comparative links, so you can compare up to 
four questions.

Generally, the slides being compared should each have 
the same number of answers. 

For the slide on which the comparison will be displayed, 
use a vertical, horizontal, offset, or donut chart. 
Comparisons cannot be displayed using 3D pie or 
distributed pie charts. 

The slide on which the comparison will be displayed 
should come after the slides it is being compared to, so 
that the results of those slides are available for display.

Step by Step Instructions To create a comparative link…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.
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2 Select Comparative Links 
from the Tools menu.

The Comparative Links window opens.

Comparative Links window

3 Select the slide to include the 
comparison in the Selected 
Slide drop-down menu.

4 Select a slide to compare 
with in the Link to Slide drop-
down menu.

5 Select the Create Link button 
to create the comparative 
link.

The link is displayed in the list of comparative links.

6 Select the Done button. The Comparative Links window closes. TurningPoint 
adds the comparative link to the slide. (The 
comparison will not be visible until you run the 
presentation session and collect data.)

Next Steps When you run your presentation session, the charts in 
slides containing comparative links will automatically 
show comparisons of the data for the linked slides.
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You can add additional comparative links by repeating 
these steps. You can add up to three links to a slide.

You can delete comparative links by selecting the link in 
the Comparative Links window and selecting the Break 
Link(s) button.

Conditional Branching
Conditional branching allows you to control the order of 
slides in your presentation based on the responses 
received from the audience. 

For example, at the beginning of your presentation you 
might ask the participants to vote whether you’ll cover 
topic A or topic B. Depending on the results of the vote, 
the presentation will skip ahead to the slides for topic A 
or topic B. 

Or, you might ask a question covering a specific subject 
area to assess whether the participants understand the 
subject. If most of the participants respond correctly, you 
can skip ahead to the next section of material.

Set Up Conditional Branching

You set up conditional branching by defining a condition, 
which, if satisfied, advances to the slide you specify. 
Each condition consists of a comparison. The number or 
percentage of responses for a particular answer (or all 
correct answers) is compared with a specific value, or 
with the majority of responses for that slide.
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Set up conditional branching using the Conditional 
Branching window, available from the Tools menu in the 
TurningPoint toolbar.

Before You Begin Before setting up conditional branching, you should 
create the slides for the branches of your presentation 
and plan their order.

Step by Step Instructions To set up conditional branching…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

2 Select Conditional Branching 
from the Tools menu.

The Conditional Branching window opens.

Conditional Branching window

3 Select the slide where the 
branch will begin in the 
Selected Slide drop-down 
menu.

You will specify where to branch (which slide to show 
next) based on the outcome of the selected slide’s 
polling.
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4 Define the condition using the 
drop-down menus, as 
described in the following 
steps.

Find some examples of conditions in the examples 
following these instructions on page 234.

a In the Logical Operator 
drop-down menu, select 
None for the first condition 
you specify.

If you are creating multiple conditions for a slide, 
you can select AND or OR as Logical Operators. 
Select AND to link a conditional branching item to 
the previous item to specify that both conditions 
should be met. Select OR to link a conditional 
branching item to the previous item to specify that 
either condition can be met.

b In the Branch Item drop-
down menu, select the 
answer you would like to 
use for the comparison.

The number or percentage of responses for the 
selected answer will be used in the comparison. 
You can choose any of the answers on the slide, or 
Total Correct. If you select Total Correct, the 
condition uses the total number or percentage of 
correct responses for the selected slide. If you 
select an individual answer, the condition uses the 
number of responses for that selected answer 
choice.

Note Always select None as the Logical Operator 
for your first conditional branching item. Also, 
when you are creating multiple conditions, 
select None if new conditions should not be 
linked to the previous condition.

Note You can link more than two conditional 
branching items for one slide. 



232 Turning Technologies

Chapter 7: How to Use Tools

c In the Comparison 
Operator drop-down 
menu, choose a 
mathematical operator to 
use in the comparison.

The Comparison Operator is used to determine if 
the condition for the branch item has been met. You 
can choose from: 

• greater than (>)

• less than (<)

• equal to (=)

• not equal to (<>)

• greater than or equal to (>=)

• less than or equal to (<=)
d In the Condition drop-

down menu, choose 
whether you want to 
specify a number or 
percentage of 
respondents, or compare 
to the majority response.

You will enter a value for the number or percentage 
to be compared to in the next step.

If you choose Majority, the number of responses for 
the answer you selected in Branch Item will be 
compared to the answer that received the most 
responses on the slide. If you choose Majority, you 
may only choose equal to (=) or not equal to (<>) for 
the Comparison Operator.

e If you choose Responses 
or Percentage in the 
Condition drop-down 
menu, enter a value in the 
box provided.

If you choose Responses, enter a number of 
responses (from 0 to the total number of 
participants). If you choose percentage, enter a 
percentage of responses (from 0 to 100).

5 In the Branch to Slide drop-
down menu, select a slide to 
branch to if the condition is 
fulfilled.

You can branch to any slide in your presentation.

6 Select the Add button to add 
the condition to the slide.

The condition appears in the list of conditions in the 
Conditional Branching window.

Note You must select None in the Branch to Slide 
drop-down menu if you are linking the next 
condition(s) to the current one. Then, after 
the last condition is selected, you specify the 
slide to branch to. Find more information 
about this process in Step 7 below. 
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7 Repeat steps 4 through 6 to 
add multiple conditions to a 
slide.

You can add several conditions to one slide. For 
instance, you can add several linked conditions using 
AND/OR as Logical Operators, or you can add several 
independent conditions by always selecting None as 
the Logical Operator. Alternatively, you can add linked 
conditions and separate, independent conditions. See 
examples of how to add multiple conditions to a slide 
on page 234.

• To link several conditions 
for a slide, add another 
condition starting with 
AND/OR as the Logical 
Operator.

Begin in step 4 and specify either AND or OR as the 
Logical Operator to combine the conditions. You 
may link several conditions if you include a Logical 
Operator for each successive condition and specify 
a slide to branch to in the final condition.

Conditions are evaluated in order using the Logical 
Operators. 

• To add several 
independent conditions to 
one slide, add another 
condition with None as the 
Logical Operator and a 
Branch to Slide.

Begin in step 4 and specify None as the Logical 
Operator. You may include several independent 
conditions for a slide. This feature lets you branch 
to several different places in your presentation.

Note Remember to select None in the Branch to 
Slide drop-down menu if you are linking 
conditions. Select a slide to branch to only 
after you’ve added the final condition for that 
set of linked conditions.

Note Conditions are evaluated in the order that 
they are met. If a slide contains multiple 
conditions and each of them are met, the first 
condition in the list will be the one that is 
followed.
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• To add both linked 
conditions and 
independent conditions to 
a slide, complete the steps 
outlined above for each 
separate process.

8 Select the Done button in the 
Conditional Branching 
window when you are 
finished adding all conditions 
to the slide.

For Example The examples below show you how to add a variety of 
multiple conditions, both linked and independent, to a 
slide.

Example 1 illustrates multiple conditions linked together. 
All three conditions must be met for TurningPoint to 
branch to the designated slide listed in the third 
condition.



TurningPoint User Guide 235

Conditional Branching

Example 1

During the presentation, if no participants select Hamilton 
AND if no participants select Franklin AND if less than 
half select Washington, then the presentation continues 
with slide 8.

Note Remember to select None for Branch to Slide 
if you are linking conditions, as shown in 
Example 1. Only select a slide to branch to 
after you’ve added the final condition for that 
set of linked conditions.
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Example 2 illustrates two independent conditions added 
to the same slide.

Example 2

During the presentation, if all participants answer 
correctly, the presentation continues with slide 8. 
Alternatively, if the majority of participants select 
Jefferson, the presentation continues with slide 3.
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Example 3 illustrates both linked and independent 
conditions added to a single slide.

Example 3

During the presentation, if all participants answer 
correctly, the presentation continues with slide 8. 
Alternatively, if the majority of participants select 
Jefferson, the presentation continues with slide 3. 
Alternatively, if one or more participants select Hamilton 
OR if one or more participants select Franklin, the 
presentation continues with slide 8.

Next Steps When you run your presentation session, the slides set 
up for conditional branching advance to the slide you 
specified if the condition is met.

You can remove a condition by selecting it in the list in 
the Conditional Branching window and selecting the 
Remove button.
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Frequently 
Asked 
Questions

This appendix offers you a quick reference to common 
questions that customers have about using the 
TurningPoint software. If you do not find an answer to 
your question here, visit the Turning Technologies Web 
site at http://www.turningtechnologies.com or call a 
Turning Representative toll-free at 1-866-746-3015.

Why can’t I install or activate TurningPoint?
You must be the local administrator to install 
TurningPoint for the first time. Login to the computer with 
the administrative username and password. 
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If you have a dongle, it should not be plugged in during 
installation or activation. Remove it while installing and 
activating TurningPoint. Find information about installing 
TurningPoint in Chapter 1: About TurningPoint.

Where is my product serial number (activation 
code)?

The product serial number, also called the activation 
code, is located on a label inside the ResponseCard Kit. 

What does the dongle look like?
Depending on the ports on the computer, the dongle has 
an end that plugs into either a USB port or Parallel port, 
as depicted in the image below. 

Types of Dongles

How do I set TurningPoint to demonstration 
mode?

When set in demonstration mode, TurningPoint allows 
you to author presentations or review results only. 
Demonstration mode is not designed for polling, with the 
exception of allowing you to test up to five response 
devices. 

Set TurningPoint to demonstration mode during 
activation by completing the following steps. First, if you 
have a dongle, unplug it. Then begin the activation 
process. When you activate the software, on the page 
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that asks you to select the method of activation, select 
the checkbox labeled “I want to run this in demonstration 
mode.” Then, complete the activation process.

Which response devices are compatible with 
TurningPoint?

Turning Technologies partners with Responsive 
Innovations to provide audience response devices that 
are specifically designed to support the functionality of 
TurningPoint. The ResponseCard IR, ResponseCard XL, 
and ResponseCard RF from Responsive Innovations are 
products that are optimally suited for use with 
TurningPoint. Users also have the option of using 
TurningPoint’s vPad, an application for using a virtual 
keypad. Other keypads supported by TurningPoint are 
the Fleetwood Family of Reply Radio Frequency 
Keypads, PRS Infrared Keypads, Hitt and CPS Infrared 
Keypads.

Find information about compatible response devices at 
the Web site for Turning Technologies at 
http://www.turningtechnologies.com/.

How do I set up the response devices?
The Response Device Wizard guides you through the 
setup of the response devices to be used and to test the 
communication between the response devices and 
TurningPoint. From the TurningPoint toolbar, select the 
Display Response Device Wizard button, which looks like 
a lightening bolt. Find information about the Response 
Device Wizard in Chapter 4: How to Set Up Response 
Devices.

Where should I put the receiver?
Because the IR device uses infrared technology and line-
of-sight communication, place it in a central location in 
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the front of the room where it is high enough for everyone 
to see. The effective range of an IR device receiver is 
about 75 feet (25 meters). You will need to install one 
receiver for every 80 participants. The effective range of 
an RF device receiver is about 200 feet (60 meters). A 
single receiver is sufficient for up to 1000 keypads, and a 
direct line of sight between the receiver and the keypad 
is not necessary. When the receiver is connected, the 
participant has to simply press the number or letter on 
the keypad to send a response. Find information about 
setting up the receiver in Chapter 4: How to Set Up 
Response Devices.

Why can’t the Response Device Wizard find 
the receiver on the correct COM port?

If you are using a Keyspan adapter (USB to serial), then 
you must install the Keyspan software. To download the 
software, first disconnect the Keyspan adapter from the 
computer. Then, go to the Keyspan Web site at 
http://www.keyspan.com/ and follow the instructions to 
download. If your Keyspan adapter was connected 
during installation, then you must remove the software, 
disconnect the adapter, and install it again.

Check to make sure the hardware is connected by 
unplugging the receiver and plugging it back in. Run the 
Response Device Wizard again.

If you are using a PDA or other device, make sure it is 
not using the COM port. 

Find information about the Response Device Wizard in 
Chapter 4: How to Set Up Response Devices.

Why is a keypad not working?
The correct keypads may not be matched with the 
receiver. Run the Response Device Wizard again to 
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correct the settings. Find information about the 
Response Device Wizard in Chapter 4: How to Set Up 
Response Devices.

The keypad’s batteries may be too low or dead. Press a 
button on the keypad. The light on the keypad blinks or 
does not light up if the batteries need to be replaced. 

The keypad may not be correctly programmed. Refer to 
the Programming ResponseCards insert in the 
TurningPoint kit.

How do I track responses from participants?
Create a Participant List in TurningPoint and then use the 
Participant Monitor to view the responses from each 
participant. You can either create a Participant List using 
the Participant List Wizard or by importing an existing 
file. Find information about participant lists in Chapter 5: 
How to Track Participants and Teams. Find information 
about the Participant Monitor in Chapter 6: How to Run 
a Presentation Session.

When running the presentation, why don’t the 
graphs appear unless I advance to the next 
slide and then go back?

The animations in the charts vary between Office 2000 
and Office 2003. It is likely that Microsoft Office has been 
upgraded since TurningPoint was installed. Uninstall 
TurningPoint, and then reinstall it. 

How do I clear data from a session or a slide?
From the TurningPoint toolbar, select the Reset menu, 
and then select Session or Current Slide from menu. 
Find information about working with sessions in Chapter 
6: How to Run a Presentation Session.
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How do I save a session?
From the TurningPoint toolbar, select the Save Session 
button, which looks like a disk. A window opens allowing 
you to select a file name and location. Save the file in the 
Sessions folder, located at My Documents > 
TurningPoint > Sessions. Find information about saving a 
session in Chapter 6: How to Run a Presentation 
Session.

How do I make a report with the data from my 
session?

TurningPoint enables you to create several types of 
reports. Find information about your options and 
instructions for creating reports in Chapter 7: How to 
Use Tools.
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TurningPoint 
Parser 
Documents

The TurningPoint Parser can import two kinds of 
documents:

• an XML document

• a Microsoft Word document (.doc)

To be imported by the TurningPoint Parser, these 
documents must be formatted in the proper way. The 
following sections describe the proper formats for 
documents imported by the Parser.

Find more information about using the TurningPoint 
Parser in Import Third-Party Slides on page 88.
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XML Documents
The following is a basic shell of the XML document type 
accepted by the TurningPoint Parser:

<slides count=”” id=””>
<slide id=”” type=”” multiresponse=””>
<question alias=”” filename=””

imageposition=”” />
<topic id=”” />
<answers>
<answer alias=”” value=”” filename=”” />

</answers>
</slide>

</slides>

Each element is described below, along with an example 
and an explanation of the attributes.

slides The slides element is the top-level element in the XML 
document and contains all the information TurningPoint 
requires to create the interactive presentation. The 
slides element contains a number of slide elements.

Note Remember that the following characters are 
reserved in XML: < > & ‘ “
Use the XML entities for these characters 
(&lt; &gt; &amp; &apos; &quot; 
respectively).
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<slides count=”1” id=”86FF9DB9”>

slide Each slide element contains the question and answer 
information for a single slide.

<slide id=”E15F45B” type=”D” multiresponse=”1”>

question The question element contains the question 
information (as attributes) and the question text (as 
content).

Attribute Description

count The total number of slide elements in 
the presentation.

id An optional attribute that contains a 
unique identifier for the group of 
slides.

Attribute Description

id An optional attribute that contains a 
unique identifier for the slide.

type Defines what type of slide to create 
using a single-letter code. The 
following types are accepted:
• Q = standard question slide
• P = picture slide
• D = demographic slide
• S = speed scoring slide
• F = fill in the blank slide (vPad only)
• E = essay slide (vPad only)
• M = moment to moment slide 

multiresponse An optional attribute that contains the 
number of responses allowed per 
keypad for the slide. Accepted values 
are 1–10.
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<question alias=”Gender?” filename=”” 
imageposition=””>

What is your gender?
</question>

topic The topic element contains the question topic.

<topic id=””></topic>

answers The answers element contains a number of answer 
elements.

<answers>

answer Each answer element contains answer information (as 
attributes) and the answer text (as content) for a single 
answer.

<answer alias=”” value=”” filename=””>

Attribute Description

alias An optional attribute that contains an 
alias for the question.

filename An optional attribute that contains a 
filename for a picture that can be 
included with the question.

imageposition An optional attribute that sets the 
question picture position. The 
following are acceptable values:
• L = Left
• R = Right
• F = Full

Attribute Description

id An optional attribute that contains a 
unique identifier for the topic.
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Female
</answer>

Word Documents
To create a Word document to be imported by the 
TurningPoint Parser, you must create an outline using 
the heading styles built into Word. You can apply the 
heading styles using the drop-down menu in the 
Formatting toolbar, or in the Styles and Formatting pane 
available through the Format menu.

Each question must use the “Heading 1” style. The 
question is followed by several answers on separate 
lines using the “Heading 2” style.

Attribute Description

alias An optional attribute that contains an 
alias for the question.

value An optional attribute that contains a 
value for the answer. Valid answer 
values are “Correct”, “Incorrect”, or a 
point value 1–10000. 

filename An optional attribute that contains a 
filename for a picture that can be 
used in place of the answer text on 
the slide. This attribute is used only if 
the slide type attribute is set to “P”.
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In addition to the question and answer text, you can use 
optional TurningPoint tags to control other settings. Each 
TurningPoint tag must use the “Heading 3” style. Tags 
occur at the start of the outline (for tags that apply to the 
entire presentation) or on the lines immediately following 
a question or answer (for tags that apply only to a 
specific question or anwer). A tag is formatted in the 
following way:

<tag>value

All tags are optional. If omitted, the slide will default to a 
standard question slide.

The tags are described in the following table.

Tag Location Description and Allowed Values

<c> Start of outline. The number of slides in the 
presentation.

<d> Start of outline or following a 
question.

Contains the Session ID (if at the 
start of the outline) or topic ID (if 
following a question).

<a> Following a question or an answer. Contains an alias for a question or 
answer.

<t> Following a question. Defines what type of slide to create 
using a single-letter code. The 
following types are accepted:
• Q = standard question slide
• P = picture slide
• D = demographic slide
• S = speed scoring slide
• F = fill in the blank slide (vPad 

only)
• E = essay slide (vPad only)
• M = moment to moment slide 
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<f> Following a question or an answer. The filename of a picture file. If the 
tag follows a question, the picture will 
be added next to the question text on 
the slide. If the slide type is “P” and 
the tag follows an answer, the picture 
will replace the answer text on the 
slide.

<n> Following a question. Contains the question picture 
position. The following are acceptable 
values:
• L = Left
• R = Right
• F = Full

<m> Following a question. Contains the number of responses 
allowed per keypad for the slide. 
Accepted values are 1–10.

<p> Following a question. Contains the question topic. 

<v> Following an answer. Contains a value for the answer. Valid 
answer values are “Correct”, 
“Incorrect”, or a point value 1–10000. 

Tag Location Description and Allowed Values
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answer

An answer is one of a list of choices on a TurningPoint 
slide. The answers are enumerated and participants’ 
responses correspond to the number of the answer.

Answer Now indicator
An Answer Now indicator is an object on a TurningPoint 
slide that gives the audience a visual indication that 
polling is open and they should respond to the question.

answer region
The answer region is the area on a TurningPoint slide 
that contains the list of answers.

answer value
For purposes of scoring and competition, you can assign 
answer values to answers on a TurningPoint slide. The 
possible values are “Correct”, “Incorrect”, a point value 
1–10,000, or “No Value.”

chart
A chart is a visual representation of the results of polling 
on a TurningPoint slide.

comparative link
A comparative link is used to link a slide to the results 
from 1–3 additional slides to show all the results on a 
single chart.
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conditional branching
Conditional branching determines the order of slides 
based on participant responses.

Correct Answer indicator
A Correct Answer indicator is an object on a TurningPoint 
slide that gives a visual indication of the correct 
answer(s) after polling has closed.

Countdown indicator
A Countdown indicator is an object on a TurningPoint 
slide that gives the audience a visual indication that 
polling is about to close and that they should respond 
soon.

criteria
In a ranking, the criteria are the qualities on which the 
items to be ranked are compared. There are 1–3 criteria 
for the ranking, corresponding to the X, Y, and Z axes of 
the ranking chart.

data slicing
Data slicing is data analysis that entails cross-
referencing the results from question to the results of a 
another question.

device ID
The device ID is a number that uniquely identifies a 
response device For hardware devices, it may be printed 
on the tag on the back of the device.
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dongle
A dongle is a piece of hardware that attaches to a port on 
your computer that confirms that the TurningPoint 
software is appropriately licensed.

Essay slide
An Essay slide asks an open-ended question. The 
participants respond with text. Only vPad participants are 
able to respond to an Essay slide.

Fill in the Blank slide
A Fill in the Blank slide asks a question or makes a 
statement with a missing word. Types of responses are 
determined by the type of device a participant is using. 
For instance, vPad users can respond with a word or 
phrase, but ResponseCard users can respond only with 
numeric values. 

infrared (IR)
Infrared light is invisible to the human eye and can be 
used to transmit information. Some of the response 
devices that work with TurningPoint use infrared 
technology. IR devices require a direct line of sight to the 
receiver. The IR response devices allow only one-way 
communications.

interactive results
Interactive results are the data from the audience’s 
responses that are displayed in real-time while polling is 
open. 

Keyspan adapter
A Keyspan adapter is an adapter that converts the 
signals from a serial (RS-232) device to a USB device. 
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You may need to use a Keyspan adapter with your 
computer if the plug on your receiver does not match the 
port on your computer.

Moment to Moment slide
A Moment to Moment slide is a special TurningPoint slide 
for getting feedback from the participants on a continual 
basis. The participants respond on a scale from -2 to +2 
at regular intervals and the responses are displayed in a 
a chart.

Participant List
A Participant List is the file used in a session to track 
responses by individuals in the audience. Users can 
customize the type of data fields to include in the list but 
every list will include fields for the number and location of 
the response devices.

parser
A parser examines a file and breaks it into logical units to 
use and recombine. The TurningPoint Parser can take 
several kinds of files and create TurningPoint 
presentations from them.

participants
The people in the audience of a presentation who use 
the response devices to respond to questions.

Participant List Wizard
The Participant List Wizard is a tool that guides you 
through the creation of a Participant List to be used with 
your presentation session.
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Participant Monitor
The Participant Monitor displays the status and 
information pertaining to the participants’ responses to all 
of the questions, including the total percentage of correct 
responses, how long each participants took to respond, 
and which answers they picked. 

picture slide
A picture slide is a TurningPoint slide in which the 
answer text is replaced with pictures.

polling
Polling is the mechanism by which Turning Point accepts 
and tallies the responses provided by the audience using 
Response Devices.

presentation session
See session.

radio frequency (RF)
Radio frequency devices use radio waves to transmit 
information. Some of the response devices that work with 
TurningPoint use radio frequency technology. RF devices 
do not require a direct line of sight. The RF response 
devices use two-way communications, so the response 
device can confirm that a response was received by the 
receiver.

ranking
A ranking is an exercise in which items are compared on 
1–3 criteria and ranked. You can set up a ranking in 
TurningPoint using the Ranking Wizard.
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receiver
A receiver is a device that attaches to your computer to 
receive IR or RF signals from response devices.

reset
To return the response tallies from the audience to zero.

report
Reports present and analyze the data from a session in a 
variety of useful ways. You can create reports from a 
session using the Report Wizard.

response
A response is the signal received from a participant 
during polling. The response usually corresponds with 
one of a list of answers on the slide.

ResponseCard
A ResponseCard is a type of hardware response device 
that use infrared (IR) or radio frequency (RF) signals to 
communicate a participant’s response.

Response Counter
A Response Counter is an object on a TurningPoint slide 
that gives a visual indication of how many of the 
participants have responded to the question.

Response Grid
A Response Grid is available from the ShowBar and is 
used to show which participants have responded to a 
question.
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Response Table
A Response Table is an object on a TurningPoint slide 
that shows which participants have responded to a 
question.

ShowBar
The ShowBar is a toolbar that provides activation buttons 
for polling, monitoring, and viewing responses during the 
slide show.

session
A session is a run-through of an interactive presentation 
where an audience has submitted responses to some or 
all of the questions.

session file
A session file is created to store the results and other 
data when you run a session. Session files are usually 
stored in My Documents\TurningPoint\Sessions and 
have extension .tpz.

slide show
A slide show is a presentation created in PowerPoint, 
which may or may not include TurningPoint slides.

speed scoring
Speed scoring scales the number of points a participant 
receives for responding to a question correctly by how 
quickly the participant responded.

standard
A standard is any framework for evaluation of 
participants. You can assign standards to slides in a 
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TurningPoint presentation to compare participants’ 
performance to a standard.

Statistic indicator
A Statistic indicator is an object on a TurningPoint slide 
that shows the mean (average), median, standard 
deviation, or variance of responses after polling has 
closed.

Text Messaging
Text Messaging is a feature for sending messages to 
participants using vPad during a presentation.

TurningPoint slide
TurningPoint slides are slides in a PowerPoint 
presentation with the ability to dynamically display 
information based on the responses of an audience.

TurningPoint toolbar
A series of menus and buttons displayed below to the 
PowerPoint toolbars that contains the tools for using the 
TurningPoint software.

vPad
A vPad is a software version of a response device that is 
set up for use using the Response Device Wizard. It can 
be installed on a networked desktop or laptop computer 
or a PDA.

WebCT
WebCT is a software product that is popularly used by 
educational institutions to facilitate e-learning systems.
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WebCT Wizard
The WebCT Wizard is a tool that guides you through the 
process of connecting to an institution’s WebCT server.

XML
XML is a markup language for text files, similar to HTML, 
that is used by TurningPoint for storing session data and 
as an import format for the TurningPoint parser.
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